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PeerSync Help

Welcome to Peer Software's powerful file mirroring, backup and distribution solution,
PeerSync v9.0. With this product you will be able to conveniently synchronize folders for
back-up purposes or portability requirements. Never again will you overwrite newer data by
attempting to manually update anindividual file or the contents of a folder.

History

PeerSync has been available for download/purchase since early 1995. Since then hundreds
of downloads have been logged from various international forums where PeerSync was
made available and thousands of copies have been sold. PeerSync is an MS Windows-
based product. Originally written in Visual Basic, the current productis written in Delphi Object
Pascal. PeerSync originated as a solution to a problem frequently encountered by our own
developers, that of keeping files in sync between multiple hard drives. Developers working
on-site at customers' locations or at home during crunch schedules would then have to
synchronize their data back to the office server. This was most often done manually, with
each individual file being dragged to the appropriate serverfolder. Invariably, data would be
lost when one or several of the server files contained new information which was
subsequently overwritten. In addition to loss of work and resulting frustration, the process was
also time consuming. Anywhere from 20 minutes to 2 hours would be spent during each
synchronization. After reviewing several commercially available products, it became
apparent that an effective and user-friendly solution to this common problem did not exist,
hence the development of PeerSync.

Description

Configured through the Profiler, an intuitve and easy-to-use application, PeerSync
automatically synchronizes multiple directories and sub-directories from user-defined
Source to Target Folders. While removing the frustration and loss of time associated with
manual synchronization, PeerSync prevents loss of data by checking file dates and times to
ensure that newer information is not overwritten. Synchronization can occur between any
mapped or UNC connected drives located on local computers or computer networks. While
processing and performing any number of simultaneous tasks, PeerSync retains and
expands upon the selectivity and precision of manual synchronization by offering a suite of
automated file inclusion and exclusion features. Files can be included within synchronization
according to standard DOS-type wild cards and excluded using sub-string comparisons or
file attribute settings. Files can be also be excluded according to their date and size. In
addition, PeerSync can be configured to update or add files which are out-dated or non-
existent in the current Target Folder. Precision and scope are further enhanced through
PeerSync Jobs and Command Line Modes. A virtually unlimited number of folder
combinations (Jobs) can be created and stored in Profiles which can be run manually or
automatically using command line arguments. While synchronizing large numbers of folder
combinations at once, each combination can have a unique set of exceptions. In this way
PeerSync combines the benefits of precise folder matching with that of an automated
environment. Real-Time Source Folder monitoring and repetitive operations on the host PC
are also available with PeerSync's options. PeerSync can also be used for network file
management purposes. Reports run during synchronization can display added, updated,
and opened files as well as directories created, and can display unmatched files found in
Targetdirectories.

Embedded Open File Manager (EOFM)

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved
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PeerSync's Embedded Open File Manager (EOFM) option was created and bundled into
PeerSync through a third party partner named EVault. EVault has announced that EOFM is
now "End-of-Life" and no further development or support will be provided. Thus, Peer
Software will no longer be including EOFM as part of PeerSync beginning in PeerSync
version 9.0. In addition, we are no longer able to provide technical supporton EOFM effective
immediately.

For Peer Software customers currently using EOFM and who are on a valid maintenance
supportcontract, we offera FREE upgrade from EOFM to the Volume Shadow Copy Service
(VSS) option. We urge all customers to take advantage of this FREE upgrade offer. Peer
Software is continuing developmentand supportfor VSS.

PeerLock Configuration Support

Starting with PeerSync v7.4, customers who are running PeerlLock 2.0.1 or higher on the same
machine as PeerSync are able to configure PeerLock directly from the PeerSync Profiler.
Configuration options include the ability to link specific PeerSync Profile Jobs to PeerlLock,
ability to access/view/editthe PeerLock Global Settings from the PeerSync Profiler, ability to
install/uninstall the PeerLock Service, as well as launch and view PeerlLock directly from the
PeerSync Profiler.

Version 7.4 and higher of PeerSync also supports real-time or scheduled bi-directional
replication using our TCP replication mode. In this version, PeerSync now supports bi-
directional replication with target directories that reside outside the LAN, WAN, or VPN.

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all
responsibility for any data loss or damage.
Copyright © 1993-2012 Peer Software Inc. All Rights Reserved Privacy Policy

PeerSync is a registered trademarks of Peer Software, Inc.
Reproduction in whole or in part without permission is strictly prohibited.

The PeerSync Help Manual was built on Wednesday, August 08, 2012
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Product Information

License

License

YOU SHOULD READ CAREFULLY THE FOLLOWING TERMS AND
CONDITIONS BEFORE INSTALLING, USING OR DISTRIBUTING THIS
SOFTWARE. INSTALLING, USING OR DISTRIBUTING THIS SOFTWARE
INDICATES ACCEPTANCE OF THESE TERMS AND CONDITIONS. IN THIS
AGREEMENT, "YOU'" MEANS YOU AS AN INDIVIDUAL IF YOU ARE USING
THIS SOFTWARE FOR PERSONAL USE. IF YOU ARE USING THE
SOFTWARE ON EQUIPMENT OWNED OR OPERATED BY A COMPANY OR
ORGANIZATION (COLLECTIVELY '"COMPANY'"), BY ACCEPTING THIS
AGREEMENT, YOU REPRESENT THAT YOU ARE DULY AUTHORIZED TO
ACCEPT THIS AGREEMENT ON BEHALF OF YOUR COMPANY.

COPYRIGHT

The software programs (hereafter the "Software") and documentation (hereafter the
"Documentation") is copyrighted and remains the property of Peer Software, Inc. All rights are
reserved.

LICENSE

Peer Software, Inc. hereby grants you (hereafter the "User") a limited, non-exclusive, non-
transferable license to install and use the Software and accompanying Documentation
contained in the trialware distribution package (hereafter called the "Trialware Package")
you received (THE "Original Distribution") for your internal business purposes only. The
Trialware Package consists of copies of the Software and Documentation received via an
electronic transfer mechanism or an electronic storage medium including, but not limited to,
diskette, hard disk, removable disk, tape or optical devices such as CD-ROM or WORM.
This license to install and use the Software and Documentation is conditioned upon User’s
compliance with the terms of this Agreement.

You may install and use the Trialware Package on one or more computers provided there is
no chance thatitwill be used simultaneously on more than one computer. If you need to use
the Software on more than one computer simultaneously or on a network, please contact
Peer Software, Inc. forinformation about network licenses.

The Software is protected by trade secret and copyright laws and international treaty
provisions. You are not obtaining title to the Software or Documentation or any copyright or
otherintellectual property rights. You further acknowledge thattitle and full ownership rights to
the Software and Documentation will remain the exclusive property of Peer Software, Inc. or
its suppliers, and You will not acquire any ownership rights to the Software. You may not
sublicense, lease, rent, sell, convey, translate, modify, decompile, incorporate into another
product, convert to another programming language, reverse engineer or disassemble the
Software or Documentation for any purpose. You may not modify, or create derivative works
based in whole orin partupon, the Software. You agree to notremove, obscure, or alter Peer
Software, Inc.’s or any third party's copyright notice, trademarks, or other proprietary rights
notices affixed to or contained within or accessed in conjunction with or through the Software
and Documentation. Peer Software, Inc. reserves the right to periodically conduct audits
upon advance written notice to verify compliance with the terms of this Agreement.
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Once a license is purchased from Peer Software, Inc., the Trialware Package will be
authorized to function as the full working version of the Software with access to all licensed
features.

NETWORK LICENSE

Multiple users on a network (e.g. a LAN) requiring access to the Software and Documentation
must purchase a Network License. Two forms of Network Licenses are offered, a Site
License and Enterprise or Concurrent User License. With a Site License, any user who
accesses the Software or Documentation requires a user license, regardless of the
frequency of use. Once a Site License is purchased Software and Documentation may be
copied to all users who have been licensed. Site Licenses are customized for each
purchase. The license is based on a quantity of simultaneous users and or CPU installations.

The Concurrent User License allows the licensed number of users to simultaneously access
the Software and Documentation. The User agrees to operate metering software, which
restricts the simultaneous number of users to the quantity purchased. The Software and
Documentation mustbe installed on network servers under the control of metering software.

Both Site and Concurrent User Licenses allow installation of the Software and Documentation
to any number of servers on any number of geographic sites, limited only by the quantity of
licenses purchased.

TERM AND TRIAL PERIOD

You are permitted to use the Trialware Package for a trial period (hereafter the "Trial
Period") of thirty (30) days or 30 uses (which ever comes first) after receipt of the Trialware
Package. After such time, if you continue to use the Trialware Package, you must register
your copy with Peer Software, Inc. Failure to register after the Trial Period constitutes
termination of this license. Upon registration, a password (hereafter called the "Password")
will be provided to eliminate the registration reminder screen.

This license is effective until terminated. You may terminate it by destroying the Software,
Documentation, and all copies thereof. This license will also terminate if you fail to comply
with any of the terms or conditions herein. You agree, upon such termination, to destroy all
Software, Documentation, and copies thereof. Upon request, You agree to certify in writing
thatall copies of the Software and Documentation have been destroyed.

LIMITED WARRANTY

THE SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS"WITHOUT WARRANTY
OF ANY KIND. PEER SOFTWARE, INC. DISCLAIMS ALL WARRANTIES RELATING TO
THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT
LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, AND INFRINGEMENT AND ALL SUCH WARRANTIES ARE
EXPRESSLY AND SPECIFICALLY DISCLAIMED.

EXCLUSIVE REMEDY
YOUR EXCLUSIVE REMEDY AND PEER SOFTWARE, INC. ENTIRE LIABILITY ARISING

FROM OR IN CONNECTIONS WITH THE SOFTWARE, DOCUMENTATION, AND/OR
THIS LICENSE (INCLUDING WITHOUT LIMITATION FOR BREACH OF WARRANTY OR
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INFRINGEMENT) SHALL BE, AT PEER SOFTWARE, INC.'S OPTION, THE REPAIR OR
REPLACEMENT OF THE SOFTWARE OR REFUND OF REGISTRATION FEES (IF
NOTIFICATION OF PROBLEM IS WITHIN 30 DAYS OF PURCHASE).

LIMITATIONS OF LIABILITY

UNDER NO CIRCUMSTANCES OR LEGAL THEORY, WHETHER IN TORT, CONTRACT,
OR OTHERWISE, SHALL PEER SOFTWARE, INC. OR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE BE
LIABLE TO YOU OR TO ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES (EVEN IF PEER SOFTWARE, INC.
SHALL HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES), INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE,
COMPUTER FAILURE OR MALFUNCTION, OR, FOR ANY OTHER DAMAGES OR
LOSSES OF ANY NATURE.IN NO EVENT WILL PEER SOFTWARE, INC. BE LIABLE FOR
ANY DAMAGES IN EXCESS OF THE LIST PRICE PEER SOFTWARE, INC. CHARGES
FOR A LICENSE TO THE SOFTWARE.

Some states do not allow the exclusion of the limit of liability for consequential or incidental
damages, so the above limitation may notapply to you.

BACK-UP
You may make one copy ofthe Trialware Package forbackup purposes only.
DISTRIBUTION

You may distribute the Trialware Package to others via an electronic transfer mechanism or
electronic storage media provided that no files are deleted from the Original Distribution
Trialware Package or are modified in any way. Files may be added to the Trialware
Package expressly for the purpose of identifying the party distributing the Trialware
Package. You may also place the Trialware Package into any archive or compressed
formatfor ease ofdistribution.

You may notdistribute the product Registration Key to others under any circumstances.
GENERAL

Export of the Software may be subject to compliance with the rules and regulations
promulgated from time to time by the Bureau of Export Administration, United States
Department of Commerce, which restrict the export and re-export of certain products and
technical data. If the export of the Software is controlled under such rules and regulations,
then the Software shall not be exported or re-exported, directly or indirectly, (a) without all
exportorre-exportlicenses and United States or other governmental approvals required by
any applicable laws, or (b) in violation of any applicable prohibition against the export or re-
exportofany partof the Software. Some countries have restrictions on the use of encryption
within their borders, or the import or export of encryption even if for only temporary personal
orbusiness use. You acknowledge thatthe implementation and enforcement of these laws is
not always consistent as to specific countries. Although the following countries are not an
exhaustive list there may exist restrictions on the exportation to, or importation of, encryption
by: Belgium, China (including Hong Kong), France, India, Indonesia, Israel, Russia, Saudi
Arabia, Singapore, and South Korea. You acknowledge it is your ulimate responsibility to
comply with any and all government export and other applicable laws and that Peer
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Software, Inc. has no further responsibility after the initial license to you within the original
country of sale.

In addition, neither the Software nor the Documentation and underlying information or
technology may be downloaded or otherwise exported or re-exported (i) into (or to a national
orresidentof) any country to which the United States has embargoed goods; or (ii) to anyone
on the United States Treasury Department's list of Specially Designated Nations or the
United States Commerce Department's Table of Denial Orders. By using the Software you
are agreeing to the foregoing and you are certifying that you are not located in, under the
control of, or a national or resident of any such country oron any such list.

This agreement shall be governed by the laws of the state of New York and shall inure to the
benefit of Peer Software, Inc. and any successors, administrators, heirs, and assigns. Any
action arising under this Agreement shall be filed in any state or federal court located in
Suffolk county in the State of New York, and You hereby agree, acknowledge and submit to
the exclusive jurisdiction and venue of such courts for the purposes of such action, waive any
right You may have to objectto such jurisdiction or venue.

This Agreement sets forth all rights for the user of the Software and is the entire agreement
between You and Peer Software, Inc. and supersedes any other prior or contemporaneous
agreements or communications with respect to the Software and Documentation. This
Agreementmay notbe modified except by a writen addendum issued by a duly authorized
representative of Peer Software, Inc. No provision hereof shall be deemed waived unless
such waiver shall be in writing and signed by Peer Software, Inc. or a duly authorized
representative of Peer Software, Inc. If any provision of this Agreement is held invalid, the
remainder of this Agreement shall continue in full force and effect. The parties confirm that it is
their wish that this Agreement has been written in the English language only.

PeerSync Installation

PeerSync is shipped (downloaded) in a full installation program. To run, simply double-click
on the executable in the Explorer window, or choose "Run" from the Start Menu and then
select the application. For networked installations, PeerSync supports silent installation by
adding "/S" to the installation application's command line.

Example: %PATH%/ ps90.exe/ S

See Additional Configuration Entries for more Information on silentinstallation configuration.

Additionally, PeerSync can use the PeerSync90.lic file for larger networked sales and site
licensing. This file will be placed in the "PeerSync" folder. If PeerSync detects this file at
startup then it will use this data and bypass all other registration security checks. If the
PeerSync90.lic file is located in the same folder as the PeerSync installation application, this
file will then be automatically placed in the PeerSync installation folder during installation. To
obtain a PeerSync90.lic file, please specify your requirements during purchase/registration.

Note: Adding /S /A INSTALL.LOG to the Uninstall.exe command line will perform an automatic silent uninstall of
PeerSync.

Additional Configuration Entries

PeerSync and the PeerSync installation (ps90.exe) use a configuration file (PSDef.cfg) to
read and set options during and after installation. If a PSDef.cfg file is located in the same
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folder as ps90.exe before installation, this file will be automatically copied to the PeerSync
installation folder during installation.

I PSDEF.CFG - Notepad E@@

File Edit Format ‘iew Help

[application options]
Installation Folder= C:%Program FileshwPeersync
Disahle Install Reboot=ves
Install PsProfiler=ves

Install Pswizards=no

Install SMMP=NO

Create Start Menu Shortcuts=rHo
User Mames=

Company Mama=

options=

Passwords=

[Misc options]
TempFolder=C:3\Temp

Pre-Installation Configuration Options

The following options are available before installation and are used during manual
and silentinstalls:

Installation This option can be set to any directory path and designates

Folder whatdirectory to install PeerSync into.

Disable Install This option can be set to 'Yes' or 'No' and allows you to

Reboot suppress the rebooting (if needed) of your computer after
installation.

Install PSProfiler This option can be set to 'Yes' or 'No' and allows you to

decide if the PSProfiler interface is to be installed.

Install PSWizard This option can be set to 'Yes' or 'No' and allows you to
decide ifthe PSWizard interface is to be installed.

Install SNMP This option can be set to 'Yes' or 'No' and allows you to
decide if files needed for SNMP are to be installed (SNMP is

only available in the Enhanced Package).

Create Start Menu This option can be set to 'Yes' or 'No' and allows you to
Shortcut decide if shortcuts related to the PeerSync installation will be
added to the Start menu.

Post Installation Configuration Options

The following options are used by PeerSync and other installed applications after
install:

User Name This is used to setthe Registration or Evaluation information to
be read in by PeerSync.

Company Name This is used to setthe Registration or Evaluation information to
be read in by PeerSync.

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved


http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx

PeerSync Help 8

Options This is used to setthe Registration or Evaluation information to
be read in by PeerSync.

Password This is used to setthe Registration or Evaluation information to
be read in by PeerSync.

TempFolder This option can be setto any directory path and will be used
for a temporary folder PeerSync to use. If the path does not
exist, an attempt will be made to create it. If it cannot be
created, the default will be used which is the logon users
system Temp path.

Registration and Passwords

If this is an unregistered or Evaluation Copy of PeerSync, you can register it with Peer
Software, Inc. as a fully licensed copy by providing credit card information via phone or
secure Internetregistration, or by sending a check or money order to the address below (see
included "readme.txt" file for pricing information). As an integral component of PeerSync 9.0
and all subsequent versions, the Profiler application is included as part of registration.

Register online via secure Internet credit card registration at:
http ://www.peersoftware.com

Register by phone via credit card by calling:
703.763.7700 between the hours of 9:00 AM to 5:00 PM EST

Register by FAX via Purchase Order:
Send Purchase orders to 703.763.7705

Register by mail, send check or money order to:
Peer Software, Inc.

5900 Fort Drive , Suite 415

Centrevile, VA 20121

Information Required:

Full name (as itappears on the creditcard)

End User Name (userto be licensed for the product)
Company Name (ifapplicable)

Address (City, State / Province, Country, and Postal Code)
Phone Number

Entire Card Number

Card Expiration Date

Card Security Code

Email Address

(Peer Software, Inc. will send the Authorization Key required to unlock PeerSync's Evaluation
Counter to this).

Quantity Discounts
Visit http://www.peersoftware.com or contact us for more information.

Upon registering PeerSync, user information will be generated according to the name and
company name (if any) you specified during registration, as well as a password specific to
the product version you have licensed. This information will be emailed to you and will be
used to activate your current copy. Additional license fees mustbe paid for multi-user use.
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PeerSync may not be commercially distributed or distributed by government agencies
including their contractors UNLESS registration fees are paid for by the distributing party.

See License agreementfor product redistribution.

Please visit hitp://www.peersoftware.com for different versions of PeerSync and types of
licensing we offer.

Note Regarding Updates: As new updates/ changes become available, updated versions of the software will
be posted at http:// www.peersoftware.com. Check this page periodically to download the latest executables. Your
Authorization Key will continue to work with updated versions unless a major release is issued, or PeerSync is
installed in a different folder than the previously installed/ authorized version.

Entering Your User Information and Password
Through an Evaluation Copy of PeerSync:

After registration with Peer Software, Inc., you will receive Registration Information generated
which is from the information you provided during registration. The password you receive will
be specific to the PeerSync product you have licensed and registered with Peer Software.
Upon entering valid password and user information into your Evaluation Copy, that copy will
be immediately converted to a fully licensed version of the appropriate PeerSync product.
The instructions below apply to a "Registered Evaluation Copy" of PeerSync, that being one
whose evaluation period is still active.

To activate your registered and licensed PeerSync product, first run your Evaluation Copy of
PeerSync. Then choose "About" from the Help_Menu located on the far right of the Profiler
Menu Bar. To activate your registered and licensed PeerSync product, first run your
Evaluation Copy of PeerSync. Then choose "About" from the Help Menu.

Located on the far right of the Profiler Menu Bar. This opens the About PeerSync screen,
which contains "User Name," "Company", "Options" and "Password" fields.

Be sure to enter this information exactly as you received it, with the same spacing,
hyphenation, punctuation, and cases (i.e. if a comma or period contained within a company
name is omitted, registration will not be accepted). It is advisable to cut-and-paste
passwords directly from the E-mail registration information. If passwords are typed using
lower case letters where upper cases have been indicated, or if other information is typed
incorrectly, the message shown below will be displayed. This message indicates that
registration was unsuccessful; shows the number of attempts made to register, and contains'
a link to Peer Software's website. You will only be allowed a limited number of attempts
before the application closes entirely and will need to be opened againin orderto retry.

If registration is successful, your will receive a success dialog. Your Evaluation Copy will
have beenimmediately activated as a registered version of the PeerSync product you have
licensed, with this change indicated on the interface titte bar. Click "OK" on the success
dialog to begin usage of your newly activated PeerSync product. You will not have to exit
and restartthe application to do so.

Through an Unregistered Copy of PeerSync:

Unregistered copies of PeerSync are Evaluation Copies whose evaluation period has
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expired, or copies into which a valid password and user information has not yet been
entered. These copies can still be activated as fully licensed versions of whichever
PeerSync product whose usage you have purchased from Peer Software, Inc.

After registration with Peer Software, you will receive Registration Information which is
generated from the information you provided during registration. The password you receive
will be specific to the PeerSync productyou have licensed.

To activate your copy of PeerSync as a fully licensed version, first run the copy. Because
your copy is unregistered, the application will not open in its entirety, instead an About

PeerSync screen will open. This screen contains "User Name," "Company", "Options" and
"Password" fields.

Be sure to enter this information exactly as you received it, with the same spacing,
hyphenation, punctuation, and cases (i.e. if a comma or period contained within a company
name is omitted, registration will not be accepted). It is advisable to cut-and-paste
passwords directly from the Email registration information. If passwords are typed using
lower case letters where upper cases have been indicated, or if other information is typed
incorrectly, the message shown below will be displayed. This message indicates that
registration was unsuccessful; shows the number of attempts made to register, and contains'
a link to Peer Software's website. You will only be allowed a limited number of attempts
before the application closes entirely and will need to be opened againin orderto retry.

If registration is successful, your will receive a success dialog. Your copy will now have been
immediately activated as a registered version of the PeerSync product you have licensed.
Click "OK" on the success dialog to begin using your registered copy: the About PeerSync
screen will close and the full application interface will be displayed. You will not have to exit
and restartthe application to begin usage.

TERMS AND CONDITIONS

READ THE LICENSE AGREEMENT BEFORE USING THIS PROGRAM.

Please send any suggestions, comments or requests for support to the proprietor of
PeerSync:

Peer Software, Inc.
5900 Fort Drive , Suite 415
Centrevile, VA 20121

Phone: 703.763.7700
Fax: 703.763.7705
Web: http:// www.peersoftware.com

Upgrade Information

Visit hitp://www.peersoftware.com/downloads/product updates.aspxto getthe latest version
of PeerSync.

Check this page periodically to download the latest executables. Your Authorization Key will
continue to work with updated versions unless a majorrelease is

To Upgrade PeerSync
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Major productupgrades such as v8.6 to v9.0 will require a new product key. Users currently
on annual maintenance must fill out the request for upgrade form to receive the upgrade
license key before downloading v9.0.x. Users noton annual maintenance must contact sales
for upgrade pricing.

1. Stop the PeerSync service orapplication ifitis running

2. Terminate any instances of PeerSync.exe or PSProfiler.exe running in the Task Manager

3. Download the latest PeerSync executable from the following link: http://www.peersoftware.
com/downloads/product updates.aspx

4. Launch the installation by selecting "Run" from the download dialog or by double-clicking
on the installation file (ps90.exe)

5. If you are upgrading the current version of PeerSync (9.0.x to 9.0.y) simply install the
application over your existing PeerSync and the previous version will be backed up in a
sub-folder called 'BACKUP' (if the option to keep a backup is selected during the
installation). If you are evaluating a new version of PeerSync 9.0 and you already have an
existing copy of PeerSync 8.6 or older, please select a new directory during the
installation.

6. If you wish to remove previous versions of PeerSync you must go to the 'Start Menu-
Settings-Control Panel', select the 'Add/Remove Programs' utility and remove the
PeerSync versions you no longer need.

To Upgrade PSListener

1. Stop the PSListener service ifitis running

2. Terminate any instances of PSListener.exe running in the Task Manager

3. Download the latest PSListener executable from the following link: hitp://www.
peersoftware.com/downloads/product updates.aspx

4. Go into the CAWINDOWS\system32 directory and rename the PSListener.exe file to
PSListener-OLD.exe

5. Launch the installation by selecting "Run" from the download dialog or by double-clicking
on the installation file (pslist21.exe)

6. If you are upgrading the current version of PSListener simply install the application over
your existing location and the previous version will be backed up in a sub-folder called
'BACKUP' (if the option to keep a backup is selected during the installation). If you are
evaluating a new version of PSListener and you already have an existing copy of
PSListenerv2.0 or older, please selecta new directory during the installation.

7. If you wish to remove previous versions of PSListener you must go to the 'Start Menu-
Settings-Control Panel', select the 'Add/Remove Programs' utility and remove the
PSListener versions you no longer need.
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Interface Features
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The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all
responsibility for any data loss or damage.
Copyright © 1993-2012 Peer Software Inc. All Rights Reserved Privacy Policy

PeerSync is a registered trademarks of Peer Software, Inc.
Reproduction in whole or in part without permission is strictly prohibited.

The PeerSync Help Manual was built on Wednesday, August 08, 2012

Getting Started

The Profiler is used to create PeerSync Profiles. A Profile can contain as many as 255
individual synchronization tasks, or Jobs. A Job is defined by identifying a Source Folder, a
TargetFolder (to which the contents of the Source will be synchronized), and then choosing
from more than 80 easily specified Job Settings. These settings determine which contents
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will be synchronized, in what manner, and when they will be synchronized -- according to your
choice of Real-Time, Scheduled, or manually initiated operations.

The process of building a Profile is made quick and simple by allowing you to easily create
Jobs and then follow the sequentially arranged list of Settings screens accessed through the
Selection Tree, which is located on the left side of the application interface. The user begins
by first selecting a single Job or Multiple Jobs from the Profile Job List. Then specific
synchronization criteria is applied to the selected items using Job Settings. Once
synchronization criteria has been configured for each Job, Run/View Current Profile window
is used to launch the entire Profile. By offering a Tool button Toolbar as well as separate
Selection Tree and Profile Job List windows, Profiler's browser-based interface allows you to
easily view, create, copy, rename, move, or delete Jobs regardless of which Settings screen
is currently being displayed.

Product Definitions

Synchronization Updating any existing files or adding new files in the Target
Folder using the Source Folder as the guide. When completed,
the Target Folder should contain all of the files in the Source
Folder with matching contentand time stamps.

Replication Same as synchronization, except files that are in the Target
Folderthatdo nothave a matching Source File will be deleted.

Profiles A Profile is a description of a complete synchronization
scenario. Profiles can contain many Source-Target
combinations allowing the end-user to define very detailed file
synchronizations and run them all within a single request. For
example, you could build a Profile that contains Multiple
Source and TargetFolders such as:

Source = C:\My Documents Target=\\SERVER1
\USERS\TEST\My
Documents

Source =D:\LocalData Target=\SERVER2

\USERS\TEST\LocalData
Source = CAWINDOWS\Profiles Target=\\SERVER3
\USERS\TEST \Profiles

Each of these Source-Target entries can then be further
detailed with more than 65 options each making each entry a
completely self-contained process while still allowing it to be
run as partofa bigger setor Profile.

Jobs A Job is a single entry in a Profile. A Profile can contain from
one to 255 Jobs and each Job contains more than 80
individual option settings.

Real-time Mode In this mode of operation, PeerSync will automatically detect
changes made to the Source Folder(s) and execute the
synchronization options selected for the matching Job.
Typically, the TargetFolder is updated with the Source Folder
change within moments of the change. Note that PeerSync
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may have completed the operation before Windows actually
displays the change in the TargetFolder Explorer window.

Scheduled Mode In this mode of operation, PeerSync will execute the
designated Job at the selected time. Each Job in the Profile
can have the same or differenttime interval.

Product Support All support of PeerSync will be handled on our web site

support page located at hitp://www.peersoftware.com/support/
supportaspx.

PeerSync is fully supported under all NT based platforms of
Windows but should first be evaluated on each machine in
which you wish to register the product on. PeerSync is no
longer fully supported under Windows 9x platforms.

Notes:

1. The Profiler is not meant to be running persistently on the Desktop. Rather it should be accessed to create/
modify Profiles and to view the status of running Jobs.

2. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.conm/ support/ support.aspx.

Tool Buttons

Profiler offers a simple set of browser-style Tool Buttons allowing you to easily modify the
current Profile and its Jobs, regardless of which screen has been chosen from the Selection
Tree. These buttons can be hidden by unchecking the "Tool Buttons" option, accessed
through the "Toolbars" item on the View Menu. Even if this Toolbar has been hidden you will
still be able to access its options by using the File, Edit, and Job Menus. You can also
change the placement of these buttons by clicking on the left side of the Toolbar and
dragging itto restabove or below the Profile Description Toolbar.

Toolbar

The following descriptions are listed in the order in which they appear leftto right on the
Tool Buttons Toolbarand are all accessible via the application Menus.

New Profile Located on the far left of the Toolbar, this button creates a new
Profile. If another Profile containing unsaved changes is
currently open when this button is pressed, a dialog box will
open asking you if you want to save changes to the current
Profile before opening a new one (See Save Profile Button
Below). If you choose "No," the new Profile will replace the
currentone and no changes will be saved.

Note: If the cument Profile has not been previously saved and "No" is
chosen, the entire Profile will be lost.

Open Profile This button displays a "Select Profile File" dialog box allowing
you to open an existing Profile. By default, it will open in the
path in which PeerSync has been installed (i.e. C:\\Program
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Files\PeerSync). Links to previously opened Profiles can be
accessible through a drop-down list opened by clicking on the
arrow key attached to this button.

Save Profile

This button allows you to save new Profiles, or save changes
made to existing Profiles. If you are saving a new Profile, a
"Save As" dialog box will open allowing you to name and store
itas an .SNCfile in your choice of folders, with "NewProfile" as
the default name and the path in which PeerSync has been
installed as the default directory. Profiles and Profile
modifications must be saved in order to be subsequently
accessible.

Launch Current Profile

This feature will launch the current Profile (Job/Global settings).
During this process, an instance of PeerSync will be started
with the current Profile as the first parameter and the arguments
selected from the Options/Commands screen as the
subsequent parameters. You can automate this process via a
shortcut, through the startup folder, in the registry or as a
service by selecting one of these features from the StartUp
Services screen.

Terminate/Stop
Active Profile

This option, when available, will allow a user to terminate an
instance of PeerSync that contains an active Profile that is
connected to the Profiler.

Restart Active Profile

This option, when available, provides intelligent restart
functionality that eliminates/improves scanning upon PeerSync
service/application restart. This greatly improves performance
during a restart (most commonly due to profile changes, but
also for any otherreason).

Add Job

This button adds a Job to the bottom of the current list (See
Profile Job List). Jobs are named "New Job Iltem" and
assigned a number by default. If you have selected "Use
Wizard to Add New Jobs" from the Options Menu, the Wizard
application will open when this button is pressed. The Wizard
provides a guided, step-by-step method for creating and
configuring new Jobs. A drop-down list attached to this button
also allows you to choose between "Add Job With Wizard" or
"Add Job With Defaults" options. If the former is chosen,
Wizard will open every time this button is pressed. If the latter is
chosen, new Jobs added to the list through this button will be
configured manually using Selection Tree screens. These
Jobs will use whichever default settings are currently applied
(See Job Menu, "Save Defaults").

Note: The first time "Add Job With Wizard" is chosen from the drop-down list,
the Wizard application will open. After that point Wizard will be launched by
pressing the Add Job button.

Copy Job

Creates a copy of the currently selected Job and places it at
the bottom of the Profile_Job_List. Copies will be numbered by
defaultand named after the original (i.e. "Copy 1 of My Syncs").
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Rename Job Allows you to rename the currently selected Job. Jobs can
also be renamed manually by clicking on them after they have
been highlighted.

Delete Job Deletes the currently selected Job(s). When this button is
pressed, a dialog box will open asking you to confirm deletion.
Jobs canalso be deleted by selecting them and then pressing
the DELETE key onyourkeyboard.

Move Job Up Moves the currently selected Job up one place within the
Profile Job List.

Move Job Down Moves the currently selected Job down one place within the
Profile Job List.

Show Selection Shows or hides the Selection Tree. If the Tree has been
Tree hidden, its space will be filed within the interface by the
currently selected Settings screen. When the tree is hidden,
screens can still be selected using the drop-down list attached
to the Back button.

Back Opens the screen located immediately above that, which is
currently being displayed. Settings screens can also be
accessed using the drop-down list located on the right side of
the Back button; list items follow the same order as that shown
on the Selection Tree.

Next Opens the Profile Options screen located immediately below
the screen currently being displayed.

Help Manual Opens the application help file. You may also access specific
parts of the help file for features you are currently observing by
pressing 'F1' on your keyboard.

Profile Description

This field is located bellow the Tool Buttons Toolbar by default and displays a textual
description of the current Profile. By default the description for an unsaved Profile will read
"Profile Job List." Unless you enter a unique description into this field, a default description
will be assigned upon saving the Profile; this default description will match the new Profile
name.

Descriptions can be changed atany time; like all Profiler configurations, they must be saved
prior to closing the Profile orapplication in orderto be stored. You can change the placement
of the Profile Description Toolbar by clicking on its left side and dragging it to rest above or
below the Tool Buttons Toolbar. The Profile Description can also be hidden by unchecking
the "Profile Description" option, accessed through the "Toolbars" item on the View Menu.

Menus

1. File Menu

File

This menu includes items allowing you to create and save new Profiles, open existing
Profiles, create Profile desktop shortcuts, and exitthe application.
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New Create a new Profile. This feature is accessible from the Tool
Buttons Toolbar.

Open Open an existing Profile. This feature is also accessible from
the Tool Buttons Toolbar.

Reopen Reopen a recently used Profile.

Save Save the current Profile. This feature is also accessible from
the Tool Buttons Toolbar.

Save as Rename and Save the current Profile.

Profile - Revert to
Saved

Revertto the lastsaved settings of the current Profile.

Profile - Merge
Existing

Merge an existing Profile into the current Profile.

Profile - Create
Shortcut on
Desktop

Create and add a shortcut to PeerSync of the current Profile
and settings/command line arguments to the desktop.

Profile - Save
Defaults

Save the current settings of the Profile as the default settings.

Exit

Close/exitthe application.

2. Edit Menu

Edit

Allows you to move one step up or down between Selection Tree options screens while
providing a shortcut to the Run/View Current Profile Activity screen.

Back Move back to the previous screen. This feature is accessible
from the Tool Buttons Toolbar.
N e xt Move on to the next screen. This feature is also accessible

from the Tool Buttons Toolbar.

Run/View Current
Profile

Go to the Run/View Current Profile Activity screen.

3. View Menu

View

Allows you to change the appearance of the application interface. "Hint" items enable or
disable pop-up hints activated by passing the mouse pointer over interface features, as
well as those displayed in the Status Bar located at the bottom of the application interface.
In addition to a description of Profiler features, hints will identify command line arguments
associated with those features (if any).

Toolbars - Tool

Show/hide the Tool Buttons Toolbar.
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Buttons

Toolbars - Profile Showr/hide the Profile Description Toolbar.
Description

Toolbars - with Hot Show/hide the hottracks features for the Toolbars.
Tracks

Toolbars - with Text Show/hide description textlabels for the Toolbars.

Labels

Selection Tree Show/hide the Selection Tree left side panel. This feature is
also accessible from the Tool Buttons Toolbar.1

Refresh Current Refresh Profile activity.

Profile Activity

Status Bar Show/hide the Status Bar atthe bottom of the application.

Hints - on Application | Show/hide pop-up hints displayed on the application.

Hints - on Status Bar | Show/hide hints displayed on the Status Bar.

Folders Allows for the ability to launch and display Source and Target
Folder selections in organized Explorer windows in a set
viewing area. This helps the user to view and/or validate the
Source and Target Folder content before, after, and during
synchronization. These features may be helpful during
evaluation and when running and testing a newly modified

Profile.
Job Groups *( Similar to Microsofts Multiple Document Interface (MDI),
Enhanced Package) PeerSync now contains a multi-pane interface that allows the

userto organize groups of Jobs (Source and Target pairs) by
any convention necessary. User-specified tab controls allow
quick transition from one group to another. The traditional Job
list interface is still available for those who do not need the
group panes.

Remote Control * ( Displays the Remote Control Dialog which allows for the ability
Enhanced Package) to monitor PeerSync running as a service on the local machine

and/or any instances of PeerSync running on machines that
are connected to the local machine.

Profile Messages Open the Profile Message Log file if it exists. The naming
convention of the Message Log files is as follows: Profile.snc.
log, where Profile represents the name of the current Profile.

* Note: Some features described on this page require the Enhanced Package.

4. Options Menu

Options

Allows you to select options pertaining to the way PeerSync, the Profiler and the Wizard
interact with each otherand Windows Explorer.
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Use Wizard to Add
Jobs

Available only if the Wizard is installed during the PeerSync
installation. If selected, directs Profiler to open the Wizard
application as an easierand simpler way to add new Jobs to a
Profile. If not selected, the Add Job option will use the saved
Job defaults. This feature is toggled on or off depending on
which option was used the lasttime thata Job was added (with
Defaults or with Wizard).

Create SNC extension
association

If selected, creates an association of any file that has an SNC
extension with the Profilerto be used as the default application
to open these files. If not selected, the association of SNC files
with the Profiler will be removed. This feature is also
accessible from the Startup Services screen.

Add Quick-Sync
Folder option to
Explorer menu

If selected, will add our Quick-Sync feature to Windows
Explorer. To access this feature, simply rightclick on any
folder in Explorer, or on your Desktop, and you will be able to
sync the folder to selected Target Folder(s), add the Job to a
Quick-Sync Profile thatis stored outin memory, and administer
the ability to modify/add to the Jobs using the Profiler. This
feature is also accessible from the Startup Services screen.

On Profile Exit

This option allows for the ability to do one of the following when
exiting the Profiler while it is connected to an Active Profile:
Display Terminate Active Profile Dialog, Leave Active Profile
Running, or Terminate Active Profile.

Global Settings

Displays various settings including Recovery/Offline Options,
Performance Options, Reporting Options, Display Options,
ACL Options, Bi-directional Options, Managed Files Options,
and Current Command Line Arguments.

5. Run Menu

Run

Allows you to Launch the
Current Profile.

Current Profile, Terminate the Active Profile and Update the

Launch Current Profile

This feature will launch the current Profile (Job/Global settings)
in PeerSync. During this process, an instance of PeerSync will
be started with the current Profile as the first parameter and the
arguments selected from the Options/Commands screen as
the subsequent parameters. You can automate this process
via a shortcut, through the startup folder, in the registry or as a
service by selecting one of these features from the Startup
Services screen. This feature is also accessible from the Tool
Buttons Toolbar.

Terminate Active
Profile

This option, when available, will allow a user to terminate an
instance of PeerSync that contains an active Profile which is
connected to the Profiler. This feature is also accessible from
the Tool Buttons Toolbar.
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Update Current
Profile

This option, when available, will allow a user to update an
instance of PeerSync with the current Profile opened in the
Profiler.

Restart Active Profile

This option, when available, provides intelligent restart
functionality that eliminates/improves scanning upon PeerSync
service/application restart. This greatly improves performance
during a restart (most commonly due to profile changes, but
also for any otherreason).

Pre-Sync Report

This executes a pre-sync report of the currently selected Jobs.
During this process, files and folders will not be modified and
persistent arguments set for the current Profile will be ignored.
A reportwill be created and displayed with the work that would
be performed if a synchronization was actually run. This feature
may be quite helpful during evaluation and when running and
testing a newly modified Profile. Pre-Sync Report options are
as follows:

Run a Pre-Sync Report (do not sync files/folders)
Starts PeerSync to analyze the work thatwould be performed if
synchronization was actually run. During this process files and
folders will not be modified. The report file, PreSync.Log, will
be displayed atthe end ofthe run.

Overwrite existing Pre-Sync report files
Enabled by default, this setting overwrites the PreSync.Log file
when the Pre-Sync process completes.

Show Pre-Sync report file at end of run
Enabled by default, this setting will open and display the
PreSync.Log reportfile after the Pre-Sync process completes.

Reprocess Failed
Events

This option, when available, will allow for Failed Files to be
processed. Failed Files are files that have failed to be
replicated/synchronized possibly due to Retries being turned
off orexceeded.

Reprocess Failed
Scans

This option, when available, will allow for Failed Scans to be
processed. Failed Scans will only occurif a scan is interrupted
or cannot run and the Retry failed connection every x
minutes option is disabled.

Note: Because it is separate from the core software engine, the Profiler allows you to create and configure new
Profiles while PeerSync runs Synchronization Operations at optimum efficiency. In both this Help file and on Profiler
screens, "Cument" refers to the Profile currently being configured but not yet launched, while "Active" most often
refers to the Profile presently being run by the PeerSync engine.

6. Job Menu

Job

Allows you to manipulate Jobs within the current Profile. If "Allow Multiple Selection" has
been checked on this menu, you will be able to selectand apply settings to Multiple Jobs.
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Add - Job with Creates and adds a Job to the current Profile using the saved

Defaults Job defaults. This feature is also accessible from the Tool
Buttons Toolbar and the Profile Job List Pop-Up Menu.

Copy Creates a duplicate copy of the currently selected Job and all
of its settings. This feature is also accessible from the Tool
Buttons Toolbar and the Profile Job List Pop-Up Menu.

Rename Allows for the renaming of the selected Job. This feature is
also accessible from the Tool Buttons Toolbar and the Profile
Job List Pop-Up Menu.

Delete Allows for the deletion of the currently selected Job(s). This
feature is also accessible from the Tool Buttons Toolbar and
the Profile Job List Pop-Up Menu.

Clear All This will close the current Profile allowing for the user to create
a new Profile.

Move Up Moves the currently selected Job up one in the list. This feature

is also accessible from the Tool Buttons Toolbar and the
Profile Job List Pop-Up Menu.

Move Down

Moves the currently selected Job down one in the list. This
feature is also accessible from the Tool Butions Toolbar and
the Profile Job List Pop-Up Menu.

Select All

This will selectall of the Jobs.

Invert Selection

This will change the selected state ofall the Jobs.

Allow Multiple
Selection

Gives the ability to selectand apply settings to Multiple Jobs.

Create Auto Job
Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Log File - View

Display the log file for the selected Job.

Log File - Clear

Clearthe log file for the selected Job.

Message Log File -
View

Display the message log file for the selected Job or profile.

Message Log File -
Clear

Clear the message log file for the selected Job or Profile.

Save Defaults

Stores the currently selected Job Settings as the default for all
subsequent newly added Jobs.

7. Help Menu

Help

While allowing you to access Help files and the About screen, this menu also provides
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demonstrations of PeerSync's Real-Time Monitoring and Scheduled Operation modes.

Demos This option allows the user to instantly run either a Real-Time
or Scheduled test Profile to demonstrate PeerSync's
synchronization capabilities.

Web Site This menu item will have many links back to our web site for

productinformation, downloads, updates and support.

Online Resources

Provides links to online demos/tutorials/documents and
forums.

Check for Updates...

Checks whether you are using the latest version of PeerSync.
This process requires an Internet connection in order to
transmit your registration information to our web server for
validation. This feature also has the ability to check updates for
all PeerSync related products (if they are installed) directly
from the Profiler. This includes the PSListener, PeerlLock, and
the PSObserver. A menu option to check for updates will be
displayed for all products thathave been installed.

PeerSync Help

Will open the application help file to the contents section. You
may also access specific parts of the help file for features you
are currently observing by pressing 'F1' on your keyboard.

Create Support Info

File on the Desktop...

This option will compile all Profile related files into a zip folder
on the Desktop. This information can be submitted to our
supportteam for analysis. The following is a list of files that are
included ifthey exists:

PeerSync Files:
[ProfileName].snc
PSDEF.CFG
[ProfileName].totxml
[ProfileName]_np.totxml

- Profile

- Configuration File

- Total SupportFile

- Total SupportFile (Non
Persistent)

- Current SupportFile

- Current SupportFile (Non
Persistent)

- Last SupportFile

- LastSupportFile (Non
Persistent)

[ProfileName].cur.xml
[ProfileName]_np.cur.xml

[ProfileName].las.xml
[ProfileName]_np.las.xml

[ProfileName].snc[.bak*].log
PSError.Log
[JobName].[bak*].log
[JobName]fitf.bak*].log
[JobName].del[.bak*].log
[ProfileName].tir
[%VariableNames%].txt

ADDCache.cur.txt

- Profile Error Log Files

- Application Error Log File
-Job Level Log Files

-Job Level Error Log Files
- Deletion Cleanup Log Files
- Time LastRun Log File

- Also included are Variable
Data Importand Job Data
Importfiles

- Current cache file of Add
events
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ADDCache las.txt
UPDCache.cur.txt

UPDCache.las.txt
DELCache.cur.txt
DELCache.las.txt
JSCCache.cur.txt

JSCCache las.txt
EXCCache.cur.txt

EXCCache las.txt
FFLCache.cur.txt
FFLCache las.txt
JSHCache .cur.txt
JSHCache las.txt
MSGCache.cur.txt

MSGCache las.txt
CTPCache.cur.txt

CTPCache.las.txt
SNCCache.cur.txt

SNCCache.las.txt
MFLCache.cur.txt

MFLCache.las txt

Supportinfo.txt

PeerLock Files:

PLDef.CFG

PeerLock[.bak*].log

- Lastcache file of Add events
- Current cache file of Update
events

- Lastcache file of Update
events

- Current cache file of Deleted
events

- Last cache file of Deleted
events

- Current cache file of Job
Scans

- Lastcache file of Jobs Scans
- Current cache file of Excluded
items

- Last cache file of Excluded
items

- Current cache file of Failed
Events

- Last cache file of Failed
Events

- Current cache file of Historical
Data

- Last cache file of Historical
Data

- Current cache file of
Messages

- Lastcache file of Messages
- Current cache file of Copy
Thread Progress

- Last cache file of Copy
Thread Progress

- Current cache file for the
Profile

- Last cache file for the Profile
- Current cache file of Managed
Files Listitems

- Lastcache file of Managed
Files Listitems

- Contains the list of files that
PeerSync will try to include in
the supportzip folder

- Configuration File
- PeerLock Log Files

The files will be zipped and stored on the Desktop for easy
attachmentto e-mails. A copy of the zipped folder will also be
stored in the PeerSync installation folder (i.e. C:\Program
Files\PeerSync\InfoFiles\Supportinfo_date/time .zip).
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Create System Info
File on the Desktop...

Creates a system info file (Sysinfo.nfo) on the Desktop. A copy
of the file will be kept in the InfoFiles folder located in the
PeerSync installation folder (i.e. C:\Program Files\PeerSync
\InfoFiles\SystemInfo_200810081953.zip - where 200810081953
represents yyyymmddhhss respectively). Creating the System
Information File takes a few minutes. Keeping a copy of the
System Information file in the InfoFiles folder eliminates the
need to wait for the creation of a new file whenever one is
needed and provides an archive of previous system states
thatcan be used for troubleshooting.

Register PeerSync

Will display the PeerSync Registration Screen to activate the
PeerSync trial version or upgrade the currentlicense.

License Information

Will display the different Product Editions and Licensing
available for PeerSync. Will also display what the current
edition has available as well as other useful information about
the current package you are running.

About PeerSync

Will display an about screen, which contains information about
the current PeerSync you are running.

8. Evaluation Menu

Evaluation

Only displayed in evaluation copies of the software, this menu item will contain features that
we believe are helpful to the user during evaluation such as demos, README files, and
other evaluation oriented features.

Read me first...

Opens the Evaluation.txt file that provides instruction on how to
run the built-in Demo, add your first Job, run your first Profile
and steps on how to use Quick-Sync and the Wizard.

Reviewer's Guide

Opens the Reviewer's Guide manual that provides a quick
product overview and useful evaluation scenarios and
demonstrations.

Real-Time Monitoring
Demo

Launches a demo that will synchronize the designated source
and targetfolders automatically upon change in real-time.

Scheduled Operation
Demo

Launches a demo that will synchronize the designated source
and targetfolders every 15 seconds.

End Demo

Available only if PeerSync is running either the "Real-Time" or
"Scheduled" demo. Selecting this option will terminate the
running demo.

License Information

Opens the Licensing dialog which lists all the options/features
thatare Active or Inactive in the product. The About screen can
be accessed from this dialog by clicking on the Register
button.

Buy Now ...

Opens the web browser to our online purchase page from
where the product can be purchased directly.
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9. Popup View Menu

View Popup Menu

Activated by right clicking on the Tool Butions Toolbar, Profile Description Toolbar, or the
Status Bar. Some ofthese options can be selected from the View Menu.

Tool Buttons

Show/hide the Tool Buttons Toolbar.

Profile Description

Show/hide the Profile Description Toolbar.

with Hot Tracks

Show/hide the hottracks features for the Toolbars.

with Text Labels

Show/hide description textlabels for the Toolbars.

Status Bar

Show/hide the Status Bar atthe bottom of the application.

10. Popup Tray Icon Menu

PeerSync Tray Icon Popup Menu

Activated by right clicking on the Tray Icon. The Tray Icon is only accessible when
PeerSync is running as an application (not as a service) and has the "Show tray icon"
option enabled in the Options/Commands window.

View Log File

Allows you to access, launch and view Log files in the default
text editor for the current Profile.

View Message Log
File

Allows you to access, launch and view the Message log file for
the current Profile.

View Admin Folder

Allows you to access, launch and view Admin log file Folders
in Explorer for the current Profile.

Open Source Folder

Allows you to access, launch and view Source Folders in
Explorer for the current Profile.

Open Target Folder

Allows you to access, launch and view Target Folders in
Explorer for the current Profile.

Show Status Display

This item will show the PeerSync Status Display dialog box
during synchronization so the user can see activity, status, and
other information while PeerSync is running. T his feature is only
available if the Display Status in the PeerSync feature was
enabled for the current Profile.

Connect/Launch
PeerSync Profiler

This item will open the Profiler, if it is not already open, and
send status messages to be displayed on the Run/View
Current Profile Activity screen. This connection feature will only
work if the Display Status in Profiler feature was enabled for the
current Profile.

About PeerSync

Will display an about screen, that contains information about
the current PeerSync you are running.
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Exit PeerSync Allows you to close/exitthe current session of PeerSync.

Note: A pop-up hint message will be displayed when you mouse over the Tray Icon. This wil provide key
information about the cument PeerSync application running including the Profile name and the status of VSS if it is
running.

11. Profile Job List

Located beneath the Toolbars, this window displays all Jobs associated with the current
Profile. Use ofthis listis central to the Profile-building process; all configurations made on the
Job Settings screens (accessed through the Selection Tree) will only be applied to those
Jobs currently selected from this list.

To selecta Job, highlight it using the left mouse button. The "Allow Multiple Selection" item
must be checked on the Job Menu in order to select and have settings applied to Multiple
Jobs. To select Multiple Adjacent Jobs, highlight the first Job, hold down the SHIFT key on
your keyboard, and then highlight the last Job you wish to include. You can also hold down
the SHIFT key and then use the up or down arrow keys on your keyboard. To select Multiple
Nonadjacent Jobs, highlight the first Job, then hold down the CTRL key on your keyboard
and click on each additional Job you wish to include. Once you have selected a Job or Jobs,
move through the screens found on the Selection Tree and apply settings as desired.
Highlighting on the selected Job(s) will appear gray as you move through these screens,
indicating thatany configured settings will only be applied to those selected Jobs.

The box appearing to the left of each Job must be checked in order for that Job to be
included in the active Profile when launched. Although unchecked Jobs will not be
processed upon launch, they will be saved within the Profile for future use and/or selection.

Upon creating a new Profile, an initial Job will be displayed bearing the name "New Job ltem
1" by default (this applies to manual Job creation only). The first New Job added within an
existing Profile will also bear this name. Successive Jobs will be named "New Job Item 2"
"New Job Item 3," etc. Any selected Job can be renamed through the "Rename" Tool Button,
through items found on both the Job Menu and Profile Job List Pop-Up Menu described
below, or manually by selecting ita second time using the left mouse button.

In both new and stored Profiles, you can navigate the Profile Job List as well as add, copy,
delete, and navigate Jobs using the Tool Buttons; using items from the Job Menu, and by
using items found on the Profile Job List Pop-Up Menu described below. You can also
navigate the list and delete items using the DELETE and up and down arrow keys on your
keyboard.

Note: In orderto navigate or modify the Profile Job List, you must have first clicked somewhere within the Profile Job List
window; this ensures that during configuration any options chosen from the Selection Tree screens are applied exclusively
to the cumently selected Job.

The height of the Profile Job Listwindow can be changed by passing the mouse pointer over
its bottom border until a double/Arrow cursor appears, then dragging the window to meet the
desired size. At minimum size, only a single Job may be viewed. Adding a new Job while this
view is in effect prompts display of up and down arrow buttons in the right side of the window.
These buttons allow you to view different Jobs within the list.
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Job List Pop-Up Menu

Activated by right clicking on the Profile Job List, this menu duplicates the mostly used
features found on the Job Menu while providing some additional items listed below.

Synchronize Selected
Jobs

This executes an immediate, non-persistent synchronization of
the currently selected Jobs ("non-persistent” refers to a one-
time sync process; "persistent' refers to ongoing sync
operations such as Real-Time Monitoring or Scheduled
Operations). During this process, persistent arguments set for
the current Profile will be ignored. When the button is released,
a confirmation dialog will be displayed indicating which Jobs
have been selected from the active Profile and asking you to
confirm synchronization through a "Yes" or "No" button. If "Yes"
is selected, the synchronization will proceed. A message will
always be displayed upon completion of this operation. Other
sync operations allow you to choose whether or not such a
message will be displayed.

Create Pre-Sync
Report

This executes a pre-sync report of the currently selected Jobs.
During this process, files and folders will not be modified and
persistent arguments set for the current Profile will be ignored.
A reportwill be created and displayed with the work that would
be performed if a synchronization was actually run. This feature
may be quite helpful during evaluation and when running and
testing a newly modified Profile.

Log File - View

This menuitem allows you to view Log reports by opening the
file in a text editor. This feature is also accessible from the

Reporting screen.

Log File - Clear

This menuitem allows you to clear Log reports. This feature is
also accessible from the Reporting screen.

Message Log File -
View

This menu item allows you to view Message Log reports by
opening the file in a text editor. This feature is also accessible
from the View Menu item.

Message Log File -
Clear

This menuitem allows you to clear Message Log reports. This
feature is also accessible from the View Menu item.

Job List View Options

This feature enables/disables the ability to display the "Click
Here to Add Another Job" Job every time a new Job has been
created.

Use "<Click Here to
Add Another Job>"
Feature

This menu item will add a new Job to the end of the Job list
named "<Click Here to Add Another Job>" every time a new
Job is created.

Suppress Add Job
Confirm Dialog

This menu item will suppress the Confirmation Dialog that is
launched when clicking on the "<Click Her to Add Another
Job>" Job.
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View Job Groups™® ( This feature enables/disables the ability to allow the user to
Enhanced Package) organize/categorize Jobs within a Profile into Job Groups.

When this feature is enabled, you can create as many Job
Groups as desired. Each Job Group is represented by a Tab.
Each Tab displays the Job Group Name, the number of
Checked Jobs and the number of Total Jobs for the
corresponding Job Group, in the following format GROUP
NAME [CHECKED JOBS / TOTAL JOBS]

Select All This menu item will select/highlight all Jobs within the current
Job Group for a quick and easy way of modifying all Jobs
within a given Profile. If this feature is not enabled you must turn
on the Allow Multiple Selection feature on from the Job Menu.

Last Run On This is a display of the last run date/time of the selected Job
within the current Profile. This is the date/time that will be used
when comparing files for the Bi-directional Synchronization
Mode option on the File Options screen. This feature is also
displayed on the from the Folder Selection screen.

Last Run On - Reset This allows a means of resetting the last run date/time of the
selected Job within the current Profile.

Job Group Pop-Up Menu* (Enhanced Package)

Activated by right clicking on the Profile Job List, this Popup menu allows for the following

features:

Add Job Group This menu item will create and add a new Job Group to the
existing Profile.

Editor Delete Job These menu items will display the Modify Job Groups Dialog,

Groups allowing for the adding, renaming, moving, re-ordering,
modifying and/or the deletion of Job Groups.

Edit Job Groups To add a Job Group click "New," then type the desired name

Dialog into the field located at the bottom of the dialog. Repeat this
process for each Job Group you wish to add. Entries can be
deleted by selecting them from the listand clicking the "Delete"
key at the bottom of the box. You can also use the "Up" and
"Down" buttons to reorder the items.

All Tabs - Check All This menu item will set all Jobs to the checked state allowing

Jobs for a quick and easy way of checking all Jobs across all Job
Groups.

All Tabs - Uncheck This menu item will set all Jobs to the unchecked state

All Jobs allowing for a quick and easy way of unchecking all Jobs
across all Job Groups.

* Note: Some features described on this page require the Enhanced Package.
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Selection Tree

Customized hd
| ustomize J £ Selection Tree Modes

Peersync -
- Peerdync Job Settings

- Folder Selection

- Aukomakion

- Blackout Settings

- 5Scan Limitakions

- File Options

- Qpen Files

- Managed Files

- Perfarmance e Se|ection Tree
- ByteReplicator

- Revisioning

- Miscellaneous

- Additional Features
- Exceptions

- Reporting

- Adrin Reparting

- Emnail Reparking

- Compressian

- PrefPost Process

- Advanced Options

- PeerSync Global Setkings LI

PeersSync

€— Selection Tree Categories
Peerlock

SkartupfService

Foumiew

Screens can be accessed through the Selection Tree that are used to set synchronization
criteria for individual Jobs (Job Settings), as well as set global properties relating to
execution of the entire Profile and all related Jobs (Global Settings). Once you have selected
a Job or Jobs from the Profile Job List, all options configured on Job Settings screens will
only be applied to those selections. After synchronization criteria for all individual Jobs have
been established, use the Global Settings screens to set global properties relating to all
Jobs, as well as choosing how you would like the Profile to be executed. The Profile Job List
will appear gray when any Global Settings screen is displayed, indicating that all properties
seton thatscreen will be applied to the entire Profile.

Selection Tree

The Selection Tree is located at the left side of the Profiler interface. The Selection Tree
can also be hidden by unchecking the "Selection Tree" option, accessed through the
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"Toolbars" item on the View Menu.

Selection Tree
Modes

The Selection Tree Modes are located in a drop-down list
above the Selection Tree. These modes can be used to show/
hide PeerSync configuration windows. The Selection Tree can
be setto Basic, Intermediate, Advanced or Customized.
Some Selection Tree items will not be accessible depending
on the package you are currently using. "Basic" is the default
Selection Tree Mode.

Selection Tree
Categories

New in PeerSync v7.4, customers who are running PeerlLock
v2.0.1 or higher on the same machine as PeerSync will now be
able to configure PeerlLock directly from the PeerSync Profiler.
Configuration options include the ability to link specific
PeerSync Profile Jobs to PeerlLock, ability to access/view/edit
the PeerLock Global Settings from the PeerSync Profiler,
ability to install/uninstall the PeerLock Service, as well as
launch and view PeerLock directly from the PeerSync Profiler.

The Selection Tree can be categorized into four sections:
PeerSync, PeerLock, Startup/Service, and Run/View.
By defaultthese categories will not be shown unless you have
PeerLock v2.0.1 or newer installed on the same computer as
PeerSync. You can manually display these categories by
adding PeerLock windows to the Customized tree mode.

Selection Tree Pop-Up Menu

Activated by right clicking on the Selection Tree, this menu duplicates the items listed in the
Selection Tree, as well as, the items listed in the drop-down listlocated on the right side of
the Back button on the Tool Buttons Toolbar. When right-clicking on the PeerSync
Selection Tree Category, this Menu offers the following options:

Show All Profile
Options

This feature will toggle between showing all Profile Options
and the Custom Options in the Selection Tree.

Customize

This feature will allow the user to select which Profile Options to
display in the Custom Selection Tree, when the "Show All
Profile Options" is turned off. When selected the user will be
given the dialog box shown below to pick and choose which
Profile Options to use.

- Selection Tree Categories

PeerSync
PeerlLock

Startup/Service
Run/View
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1. PeerSync
1.1 PeerSync Job Settings

—Peeraync Job Settings

& Job is & source-target backup)synchronization scenario,

Jobs are created by identifying a Source Folder and a Taraet Faolder, to which the
contents af the Saurce Falder will be synchronized ta the Target Folder, Each Job has
unique options, setkings and modes that can be applied ko i,

These options, settings and modes are cakeqorized inko screens based on what they wil
dao ko the Job ar what thesy will da ko the daka that will be madified by the Jab,

These selections determine which contents will be synchraonized and in what manner they
will be synchronized, As well as, when they will be synchronized according o your choice
af real-time, interval scheduling, daily kimer scheduling, trigger driven or manually
initiated operations,

J PeerSync Job Settings Screens
Eolder Selection
Automation
Blackout Settings
Scan Limitations
File Options
OpenFiles
Managed Files
Byte Replicator
Revisioning
Miscellaneous
Additional Features

Exceptions
Reporting

Admin Reporting
E-mail Reporting
Compression
Pre/Post Process

Note: Some settings are ignored when enabled in conjunction with other settings. For example, report summaries
are ignored in multiple threaded or enhanced Real-Time mode.
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1.1.1 Folder Selection

—Folder Selection

—Tode —Source Folder

& Mormal Hosk Mame: SERMER
Iser 2 Password: <Mone =

" TCP ID:'IF.-".:J:::I::Name".-'h'I, j EI - |
i FTP nhDakaset 1) Configure |

v Include sub-folders  Swap < | Seb Alternatelsdditional Targets

TMode ~Target Folder
= Mormal Hosk Mame: 192,1658,171.149
Encrypkion: OFF
v TP ITCF':'I,'I,192.168.1?1.149'|,E'|,°a"an:|I:|I"-.Iame°fo |
i FTF E:\Dataset 1 Configure |

Laskt Save: S121Z012 1:353:50 PM (Saved by DOMAIMIISER )
Lask Scan: 8/2/2012 1:26:06 PM {(Completed with Messages)

- Topics
Folder Selection Overview
Source Folder Selection

TargetFolder Selection
Include Sub-folders

Swap Source and TargetFolders
LastRun On

Other Features

Note: Features listed on this page may require the TCP_WAN Connector and/ or File Transfer Protocol (FTP)
options.

Each Job within a Profile is initially defined by using the Folder Selection screen to selecta
Source and Target Folder. The contents of a Source Folder will be synchronized to a Target
Folder according to criteria further defined on other Settings screens. Once you have
highlighted a Job or Jobs from the Profile Job List, this screen offers several different
methods to locate and select folders for synchronization. File paths can be typed manually,
oryou can browse local and network drives to locate and selectyour desired folders.

Source Folder Selection

The options listed on this page can be accessed from the Folder Selection window. The
following options are available for selecting a Source folder.

Using Normal Mode Select a "Normal" Source folder if you can navigate to the
desired Source directory via a Local Path, a UNC Path, or a
Mapped Drive. This selection requires that the machine on
which PeerSync is running has full access to the desired
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Source directory. In some instances Network Logon may be
required.

Select a Source Folder by typing the file path into the field
provided or by using the Select Source Folder Button. By
default, the Source Folder field will contain the path in which
PeerSync has been installed: in most cases this will be C:
\Program Files\PeerSync\Source. The convention outlined in
this path must be used when manually typing entries, (i.e. a
drive must be specified followed by a colon, with subsequent
folders separated by backslashes). This field is not case
sensitive, though spaces may only be entered where they are
part of valid folder names (i.e. "Program Files"). No space
should appear between slashes and folder names. This field
also supports Eile/Folder Path Variables.

UNC names can be entered manually, or can be selected from
the Network Neighborhood using the "Browse for Folder"
dialog box (see Select Source Folder Button). UNC names will
appear in the form \COMPUTER\SHAREDDEVICE\PATH.
Forexample: \SERVER11\D\USERDATA.

Starting with the release of v9.0, we now support the ability to
connect to a remote NetApp filer and register for real-time
event notification. Please visit http://www.peersoftware.com or
contact Sales for license information.

Note: We do not recommend using UNC paths for folders that reside on the
local machine, in this scenario you should use the local path to that folder.

Folders canalso be dragged and dropped from MS Windows
Explorerinto the Source Folder Field forautomatic insertion.

The Source Folder Field holds a folder selection History of up
to 10 entries. They can be selected by clicking on the drop
down button located to the right of the field.

The current path will be displayed below the Source Folder
Selection Field. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to
correct the invalid path and you exit the Source Folder
Selection field, the application will throw a message and use
the default PeerSync installation path C:\Program
Files\PeerSync\Source instead.

The Host Name and User Name & Password values (if
provided) are displayed above the Source Folder Selection

field (see Network Logon).

Using TCP Mode

Selecta "TCP" Source folder if the Source directory is outside
the scope of the machine on which PeerSync is running. TCP
enables access to machines not located on the same network
as PeerSync. As a prerequisite, the PSListener needs to be
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installed and running on the remote Source machine in order
for PeerSync to be able to communicate with it. This feature
supports encryption and compression.

Note: We strongly recommend the use of a VPN when transfering files over
the public Intemet for security purposes. Otherwise, you should use our
Encryption feature with a user name and password to protect data and all
communication as it is being transferred.

When selecting the TCP Mode for the first time the Source
TCP/Port Configuration window will open automatically for
Source Folder configuration. Otherwise, the previously entered
TCP folder path will be displayed. This path can be manually
edited by typing directly into the field provided or by using the
Configuration button. The convention outlined in this path must
be used when manually typing entries, (i.e. the key word TCP
must be specified followed by a colon, two backslashes, the
Source IP address or machine name, and subsequent folders
separated by backslashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should
appear between slashes and folder names. This field also
supports File/Folder Path Variables.

The Source Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on the
drop down button located to the right of the field.

The current path will be displayed bellow the Source Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to
correct the invalid path and you exit the Source Folder
Selection field, the application will throw a message and use
the last valid TCP path specified or the default path TCP:\
\127.0.0.1\C\Source. 127.0.0.1 represents the loopback IP
address of the local host (i.e. the machine on which PeerSync
is running).

The provided Host Name and User Name & Password values
are displayed above the Source Folder Selection field.

Using FTP Mode Select an "FTP" Source Folder to automatically logon to a
Source FTP server. This feature supports proxy servers/
firewalls and has an option to adjust for GMT time on the FTP

serverside.

When selecting the FTP Mode for the first time the Source FTP
Logon Configuration window will open automatically for Source
Folder configuration. Otherwise, the previously entered FTP
folder path will be displayed. This path can be manually edited
by typing directly into the field provided or by using the
Configuration button. The convention outlined in this path must
be used when manually typing entries, (i.e. the key word FTP
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must be specified followed by a colon, two forward slashes, the
Source IP address or machine name, and subsequent folders
separated by forward slashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should
appear between slashes and folder names. This field also
supports File/Folder Path Variables.

The Source Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on the
drop down button located to the right of the field.

The current path will be displayed bellow the Source Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to
correct the invalid path and you exit the Source Folder
Selection field, the application will throw a message and use
the lastvalid FTP path specified.

The provided HostName and User Name & Password values
are displayed above the Source Folder Selection field.

- Related Options
Source Folder Configuration Button
Select Source Folder Button
Explore/Open/Create Button
Source Folder Popup Menu

Notes:

1. The TCP features listed on this page require the TCP_WAN_ Connector option. Please visit http://www.
peersoftware.com or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit http://www.
peersoftware.com or contact Sales for additional information.

3. You cannot monitor a TCP, FTP or any other remote folder/ device in Real-Time.
4. Compression, Bi-directional synchronization mode, File Recovery, Exclude empty Source Folders, Tum file archive

attribute off after synchronization and CRC32, as well as other non applicable features are ignored when using an
FTP Source.

5. Folder Compression and Bi-directional synchronization mode, as well as other non applicable features are ignored
when using a TCP Source.

6. Selecting an FTP Source and a FTP Target for the same Job is not recommended/ supported.
7. Selecting a TCP Source and a TCP Target for the same Job is not supported.

8. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the
synchronization process (Source or Target).

Source Folder Configuration: Using Normal Mode

The Source folder configure button is activated by clicking on the Configure button located
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in rightlower corner of the Source Folder panel/section. Selecting the Configure button opens
the Source Folder Configuration window. Alternatively, you may right-click on the Source
Folder field and select Configure: Source Folder (See Source Folder Popup Menu). This
window allows for network logon Name and Password information for a remote Source

connection.

Detection Method - Global

Detection Method for
Real-Time Monitoring

Choose the desired detection method for the Source folder.
You may choose from the following options:

Normal
(default)

NetApp
fPolicy

Select this option to specify a local or remote drive
which resides on the network (LAN, WAN, or VPN).
This is the recommended detection method for
mostscenarios. Close the Source Folder
Configuration dialog once you have selected
your desired source folder detection mode and
enter the path to the source folderinthe Folder
Selection screen (i.e. D:\\Path\Folder).

Note: PeerSync must reside on the source system in order to
enable Normal real-ime detection.

Selectthis option to specify the path to a NetApp
filer for either real-time or scanning scenarios.
Close the Source Folder Configuration dialog
once you have selected your desired source
folder detection mode and enter the path to the
source folderinthe Folder Selection screen (i.e.
\\NetAppFilenn\Share\Folder).

Note: This option can only be activated if the license supports
NetApp detection. Please visit http:// www.peersoftware.com
or contact Sales for additional information.

Detection Method
Options

Exclude
Users

Allow for
remote
real-time

configuratiis only supported forNetApp fPolicy detection

on

When selecting NetApp fPolicy as the source
detection mode, you have the option to filter/
exclude real-time activity from a list of specific
users. Real-time events from the users in this field
will be excluded. Enter the desired user names in
a command delimited format (i.e. user1, userz,
user3).

This option indicates whether or not the selected
source folder detection method supports real-time
detection for remote paths. Presently, this feature

modes.

Connection Manager - Global

The Connection Manager tracks and determines if connections are lost to source and/
or target folders. With this new capability PeerSync can proactively detect when a
connection is lost or reconnected, giving the ability to restart real-time and/or scan Jobs if
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needed.

Automatically use
recommended
settings based on
Detection Method
(Default)

Check this option if you wish to let the Connection Manger
track the connection status on both the source and target
locations. When a lost connection is restored, PeerSync will
restart real-ime and/or scan Jobs if the option to "Scan Job
once atstart" is enabled. In addition, this logic will apply to only
connections which are setfor real-time monitoring.

Connection Manger
for Failed
Connections

Choose one of the following options to manually disable
or enable the Connection Manger which tracks the
connection status on the desired locations.

Disabled Disable the Connection Manager

Enabled Enable the Connection Manger to track the
for Source connection status only on the source location.
Connectio

ns Only

Enabled Enable the Connection Mangerto track the
for Target connection status only on the targetlocation.
Connectio

ns Only

Enabled Enablethe Connection Manger to track the
for Source connection status on both the source and target
and locations.

Target

Connectio

ns

Connection Manager
Options

Only Setthe Connection Manager to monitoronly
include connections that are setfor real-time detection.
connectio

ns that are

set for

real-time

monitoring

Scan real-Setthe Connection Manager to scanreal-time
time Jobs Jobs onreconnectifthe Scan Job once atstart
on optionis enabled.

reconnect

if "Scan

Job once

at start" is

enabled

NetApp Settings

method.

Edit or maintain default NetApp settings when selecting NetApp fPolicy as the detection
method. These options are only applicable when using the NetApp fPolicy detection
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Automatically detect
and use recommended
NetApp configuration

When using the NetApp fPolicy detection method, checking
this option will automatically populate the required NetApp
settings with the defaults. Uncheck this option if you wish to
manually edit these settings.

NetApp Settings

Host Editthe hostname or IP address ofthe NetApp
Server filer.
Name

Root Path Editthe local path ofthe NetApp share you wish to
Prefix monitor.

fPolicy Editthe fPolicy name thatis used to register for

Named event notification on the filer. By default PeerSync
uses PEERSYNC_COMPUTERNAME, where
COMPUTERNAME is the name of the hostwhere
PeerSync is running. PeerSync will create the
fPolicy name atthe startof the Job.

Delete By default PeerSync will remove/delete the fPolicy

fPolicy on name itused to register for event notification when

Close the Job is stopped. Disable this option ifyoudo
not want PeerSync to delete the fPolidy name
when the Job is stopped.

Network Logon Settings

Provides the ability to connect to a source folder that may require a different account then
the on PeerSync is running under.

Network Logon Settings

Connect Provide the username to allow PeerSync

As connection to the source directory thatis not
accessible using the currentservice orlogged on
account. Be sure to include the domain name if
applicable (i.e. MyDomain\UserName).

Password Enterthe password information for login.

Source TCP/Port Configuration

The Source Folder Configure Button is activated by clicking on the Configure button located
in rightlower corner of the Source Folder panel/section. Selecting the Configure button opens
the Source TCP/Port Configuration window. Alternatively, you may right-click on the Source
Folderfield and select Configure: Source Folder (See Source Folder Popup Menu).

TCP Configuration Tab

This tab provides a guided method for entering the Source TCP path.

Host Name

Enter the IP address or machine name of the Source Folder
into this filed. You may use the machine name only if the
remote Source Machine resides on the same network as that
on which PeerSync is running.
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Path to Host

Provide the full path (i.e. C:\Documents and Settings\Source) to
the Source folder in this field. The path entered needs to be a
local path without a machine name or UNC format. This field
does not validate the existence of the path you provide
therefore you must exercise great care when doing so. If the
path does not exist, PeerSync will create it during run time as
long as a valid host name or IP address has been provided
and itcan find the drive letter specified.

Care must be exercised if your PSListener contains a "Root
Path". If you specify such a path in your PSListener it will
behave like an FTP server that sets Root Paths to limit user
access to the local file system. If a "Root Path" exists on the
PSListener it will limit PeerSync's ability to access directories
on the remote device. PeerSync will only be able to access
directories equal to or bellow the specified "Root Path" level
provided thatit meets the Port and Encryption requirements. In
no circumstances can PeerSync access directories located
above this path. If the remote path you enter in the Path to Host
field references a directory above the "Root Path", PeerSync
will create that folder structure at runtime bellow the "Root
Path".

Example:

PSListener "Root Path" = C:\Backup\Users\Admin
PeerSync's "Path to Host" = C:\Backup\My Documents
Actual Remote Source Path =C:

\Backup\Users\Admin\C\Back
up\My Documents

Note: The "Root Path" will be ignored when performing byte-level replication
using Nomal Mode (i.e. Local or UNC paths).

Port Configuration Tab

This tab provides settings to be used by both the Source and Target connections when
using TCP and/or Byte Replicator.

Time Out Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure
operation.

Port This is the TCP Port used to communicate with the Listener on

the remote machine. This must match the port number that the
PSListener is configured for. By default both Listener and
PeerSync use port7333.

Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024.

Compression

Uses a lossless compression algorithm to transmit data in
fewer bits. By default Compression is disabled to achieve
faster performance.

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved




PeerSync Help

40

User Information

This is an optional setting that allows you to specify a User
Name and Password to be used for encryption as well as
authentication purposes when connecting to the remote
PSListener. In order to activate encryption or authentication,
you mustspecify botha User Name and a Password value.
Strong DES encryption will be used to encrypt the data and
communication as itis being transmitted over the Internet, LAN,
WAN, or VPN.

The User Name and Password entries can be arbitrarily
chosen and are not required to be valid. However, once
specified, you mustenter the same User Name and Password
entries in the PSListener Configuration residing on the remote
location.

If you specify a User Name without a Password, the User
Name entry will be ignored and no encryption or authentication
with the PSListener will occur.

Source FTP Logon Configuration

The Source Folder Configure Button is activated by clicking on the Configure button located
in right lower corner of the Source Folder panel/section. Selecting the Configure button opens
the Source FTP Configuration window. Alternatively, you may right-click on the Source Folder
field and select Configure: Source Folder (See Source Folder Popup Menu).

FTP Configuration Tab

authentication.

Provides a guided method for entering the Source FTP path as well as connection

Host Name

Enter the IP address or machine name of the Source folder into
this filed. You may use the machine name only if the FTP
Source machine resides on the same network as that on which
PeerSync is running.

Path to Host

Provide the full path to the Source folder in this field (i.e. /
FTProot/My Data/Source). Make sure the path begins at the
base directory to which the FTP server allows connection. The
path does not need to be preceded by the key phrase 'FTP'
however it must start with a forward slash (/). This field does
notvalidate the existence ofthe path you provide therefore you
must exercise greatcare when doing so. If the path does exist,
PeerSync will create it during run time as long as a valid host
name or IP address has been provided.

User Name

Stores the Source FTP User Name information for login.

Password

Stores the Source FTP Password information for login.

FTP Settings Tab
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Provides configuration for the FTP Source Selection.

Enable Passive Mode | Sets the FTP mode to passive. The phrase passive refers to
the FTP serverwhich passively accepts connections and data
while the client initiates both the control connection and the
data connection to random ports specified by the server.
Passive mode is enabled by default.

Hostis using GMT Option to adjustfor GMT time on the FTP server side.

Time Out (seconds) Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure
operation.

Port Port number used to initiate an FTP session or "command"
connection to the FTP server. Uses standard port 21 by
default.

Use Proxy - Firewall This option allows you to specify the Host Name, User ID,

Password, and Portnumberto a network Proxy - Firewall.

File types to transfer | Through this field, file types can be selectively tagged for
as ASCII transfer as ASCIl upon synchronization. File types can be
typed manually, or can be specified using either the "Files to
Transfer as ASCII Button" or the drop-down list located to the
right of the field. The drop-down list located to the right of this
field will be dynamically populated with file types as they are
set through the dialog box described above. They are also
added to the list when you exit the field after manually editing
the file types field. File types can then be specified by
selecting them from this list. This provides a way to store and/
or retrieve sets offile types for later use with other Jobs.

Alternatively, clicking on the "Files to Transfer as ASCII Button"
to the right of this field opens a dialog box into which file types
may be entered. To add a File Type click "New," then type the
desired file type into the field located at the bottom of the
dialog. These file types are set by specifying file extensions (i.
e. ".ixt") which, if found within a file name, will be transferred as
an ASCII file during synchronization. Multiple strings will be
semicolon delimited. These settings are not case sensitive, (i.
e. "A" = "a"). Repeat this process for each File type. Entries
can be deleted by selecting them from the list and clicking the
"Delete" key atthe bottom of the box. Once you have finished,
click the "OK" button. The box will close and all of the file types
you have specified will automatically appear in the Files to
transfer as ASCII field.

Notes:

1. The TCP features listed on this page require the TCP_WAN_ Connector option. Please visit http://www.
peersoftware.com or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit http://www.
peersoftware.com or contact Sales for additional information.
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Located to the right of the Source Folder Selection Field, this button opens a "Browse for
Folder" dialog box. Once this box has opened, locate your chosen Source folder, select it
using the leftmouse button, and click "OK."

Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

Explore/Open/Create Source Button

This button provides three options to be selected from the attached drop-down list. The
button label will change to reflect whichever item has been checked on this list.

Explore

When "Explore" has been selected and the button is
depressed, an Explorer-type window will open displaying all
available directories. By default, this window will show the
folder whose pathis currently designated in the Source Field. If
the folder shown in this field does not exist, Profiler will display
a dialog alerting you to this fact and asking if you would like to
create it. You may do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created folder will be shown in the Explorer-type window.

Open

When "Open" has been selected and the button is depressed,
a traditional MS navigation window is opened displaying the
contents of whichever folder is currently shown in the Source
Folder Field. If this folder does not exist, Profiler will display a
dialog alerting you to this fact and asking if you would like to
create it. Youmay do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created Folder will be shown in the navigation window.

Create

When "Create" has been selected and the button is
depressed, a "Select Directory" dialog will open allowing you
to specify a Source Folder path by using the mouse to select a
desired drive, directory, and folder. Folder paths can also be
manually entered into the "Directory Name" field. If you enter a
path for a folder that does not exist and hitthe ENTER key or
click "OK," a dialog box will appear allowing you to create this
folder.

Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

Source Folder Popup Menu: Using Normal Mode

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The first four features allow the user to Browse for Source Folder, Explore, Open and/or
Create the Source Folder selection.

Configure: Source
Folder

Selecting this option displays the Source Network Logon
Settings window. This allows the user to specify Network
Logon credentials for the Source Folder which enables
connection to directories that are not accessible with the
currentlogged on account.
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Edit: Source Variable | This will allow the userto view/editVariable Data Import and/or

File Job Data Import files that are used in the Source Folder
selection. This option is only available if using Job data import
files.

Create Auto Job This feature allows a simple way to generate meaningful Job

Name names. When selecting this item, Job names are automatically

generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Source Folder Popup Menu: Using TCP Mode

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The firsttwo features allow the user to Explore and Open the Source Folder selection.

Configure: Source Selecting this option displays the Source TCP/Port
Folder Configuration window. This window provides a guided method
for entering the Source TCP path as well as TCP and/or Byte
Replicator settings (see TCP Configuration).

Create Auto Job This feature allows a simple way to generate meaningful Job
Name names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Notes:

1. The TCP features listed above require the TCP_ WAN_Connector option. Please visit http:// www.peersoftware.
com or contact Sales for additional information.

2. The Browse for Source Folder and Create options are not available when using TCP Source Mode.

Source Folder Popup Menu: Using FTP Mode

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The firstfeature allows the userto Open the Source Folder selection.

Configure: Source Selecting this option displays the Source TCP/Port
Folder Configuration window. This window provides a guided method
for entering the Source TCP path as well as TCP and/or Byte
Replicator settings (see TCP Configuration).

Create Auto Job This feature allows a simple way to generate meaningful Job
Name names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Notes:

1. The FTP features listed above require the File Transfer Protocol (FTP) option. Please visit http://www.
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peersoftware.com or contact Sales for additional information.

2. The Browse for Source Folder, Explore, and Create options are not available when using FTP Source Mode.

Target Folder Selection

The options listed on this p
following options are availa

age can be accessed from the Folder Selection window. The
ble for selecting a Targetfolder.

Using Normal Mode

Select a "Normal" Target folder if you can navigate to the
desired Target directory via a Local Path, a UNC Path, or a
Mapped Drive. This selection requires that the machine on
which PeerSync is running has full access to the desired
Target directory. In some instances Network Logon may be
required.

Select a Target Folder by typing the file path into the field
provided or by using the Select Target Folder Button. By
default, the Target Folder field will contain the path in which
PeerSync has been installed: in most cases this will be C:
\Program Files\PeerSync\Target. The convention outlined in
this path must be used when manually typing entries, (i.e. a
drive must be specified followed by a colon, with subsequent
folders separated by backslashes). This field is not case
sensitive, though spaces may only be entered where they are
part of valid folder names (i.e. "Program Files"). No space
should appear between slashes and folder names. This field
also supports File/Folder Path Variables.

UNC names can be entered manually, or can be selected from
the Network Neighborhood using the "Browse for Folder"
dialog box (see Select Target Folder Button). UNC names will
appear in the form WCOMPUTER\SHAREDDEVICE\PATH.
Forexample:\SERVER11\D\USERDATA

Note: We do not recommend using UNC paths for folders that
reside on the local machine, in this scenario you should use
the local path to thatfolder.

Folders can also be dragged and dropped from MS Windows
Explorerinto the TargetFolder Field for automatic insertion.

The Target Folder Field holds a folder selection History of
more then 10 entries. They can be selected by clicking on the
drop down button located to the right of the field.

The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to
correct the invalid path and you exit the Target Folder
Selection field, the application will throw a message and use
the default PeerSync installation path C:\Program
Files\PeerSync\Targetinstead.
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The Host Name and User Name & Password values (if
provided) are displayed above the Target Folder Selection

field (see Network Logon).

Using TCP Mode

Selecta "TCP" Target folder if the Target directory is outside
the scope of the machine on which PeerSync is running. TCP
enables access to machines not located on the same network
as PeerSync. As a prerequisite, the PSListener needs to be
installed and running on the remote Target machine in order for
PeerSync to be able to communicate with it. This feature

supports encryption and compression.

Note: We strongly recommend the use of a VPN when transfering files over
the public Intemet for security purposes. Otherwise, you should use our
Encryption feature with a user name and password to protect data and all
communication as it is being transferred.

When selecting the TCP Mode for the firsttime the Target TCP/
Port Configuration window will open automatically for Target
Folder configuration. Otherwise, the previously entered TCP
folder path will be displayed. This path can be manually edited
by typing directly into the field provided or by using the
Configuration button. The convention outlined in this path must
be used when manually typing entries, (i.e. the key word TCP
must be specified followed by a colon, two backslashes, the
Target IP address or machine name, and subsequent folders
separated by backslashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should
appear between slashes and folder names. This field also
supports File/Folder Path Variables.

The Target Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on the
drop down button located to the right of the field.

The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to
correct the invalid path and you exit the Target Folder
Selection field, the application will throw a message and use
the last valid TCP path specified or the default path TCP:\
\127.0.0.1\C\Target. 127.0.0.1 represents the loopback IP
address of the local host (i.e. the machine on which PeerSync
is running).

The provided Host Name and User Name & Password values
are displayed above the Target Folder Selection field (see
Configuration Button).

Using FTP Mode

Select an "FTP" Target folder to automatically logon to a
Target FTP server. This feature supports proxy servers/
firewalls and has an option to adjust for GMT time on the FTP
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serverside.

When selecting the FTP Mode for the first time the Target FTP
Logon Configuration window will open automatically for Target
Folder configuration. Otherwise, the previously entered FTP
folder path will be displayed. This path can be manually edited
by typing directly into the field provided or by using the
Configuration button. The convention outlined in this path must
be used when manually typing entries, (i.e. the key word FTP
must be specified followed by a colon, two forward slashes, the
Target IP address or machine name, and subsequent folders
separated by forward slashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should
appear between slashes and folder names. This field also
supports File/Folder Path Variables.

The Target Folder Field holds a folder selection History of up
to 10 entries. They can be accessed by clicking on the drop
down button located to the right of the field.

The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to
correct the invalid path and you exit the Target Folder
Selection field, the application will throw a message and use
the lastvalid FTP path specified.

The provided HostName and User Name & Password values
are displayed above the Target Folder Selection field (see

Configuration Button).

- Related Options
TargetFolder Configuration Button
SelectTargetFolder Button
Explore/Open/Create Button
TargetFolder Popup Menu
Alternate Target Path Selection

Notes:

1. TCP (i.e. TCP WAN Connector Option) and FTP are optional modes which may not be included in your package.
Please visit http:// www.peersoftware.com or contact Sales for additional information.

2. Folder Compression and Bi-directional synchronization mode, as well as other non applicable features are ignored
when using a TCP Target.

3. Selecting an FTP Source and a FTP Target for the same Job is not recommended/ supported.
4. Selecting a TCP Source and a TCP Target for the same Job is not supported.

5. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the
synchronization process (Source or Target).
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Using Normal Mode

The TargetFolder Configuration Button can be activated by clicking on the Configure button
located in right lower corner of the Target Folder panel/section. Selecting the Configure
button opens the Target Network Logon Settings window. Alternatively, you may right-click on
the TargetFolderfield and select Configure: TargetFolder (See Target Folder Popup Menu
). This window allows for network logon Name and Password information for a remote Target
connection.

Using TCP Mode

The TargetFolder Configuration Button can be activated by clicking on the Configure button
located in right lower corner of the Target Folder panel/section. Selecting the Configure
button opens the Target TCP/Port Configuration window. Alternatively, you may right-click on
the TargetFolderfield and select Configure: TargetFolder (See Target Folder Popup Menu

).

TCP Configuration Tab

This window provides a guided method for entering the Target TCP path.

Host Name Enter the IP address or machine name of the Target folder into
this filed. You may use the machine name only if the remote
Target machine resides on the same network as that on which
PeerSync is running.

Path to Host Provide the full path (i.e. C:\Documents and Settings\Target) to
the Target folder in this field. The path entered needs to be a
local path without a machine name or UNC format. This field
does not validate the existence of the path you provide
therefore you must exercise great care when doing so. If the
path does exist, PeerSync will create it during run time as long
as a valid host name or IP address has been provided and it
can find the drive letter specified.

Care must be exercised if your PSListener contains a "Root
Path". If you specify such a path in your PSListener it will
behave like an FTP server that sets Root Paths to limit user
access to the local file system. If a "Root Path" exists on the
PSListener it will limit PeerSync's ability to access directories
on the remote device. PeerSync will only be able to access
directories equal to or bellow the specified "Root Path" level
provided thatit meets the Port and Encryption requirements. In
no circumstances can PeerSync access directories located
above this path. If the remote path you enter in the Path to Host
field references a directory above the "Root Path", PeerSync
will create that folder structure at runtime bellow the "Root
Path".

Example:

PSListener"Root Path" =C:\Backup\Users\Admin
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PeerSync's "Path to Host" = C:\Backup\My Documents

Actual Remote TargetPath = C:
\Backup\Users\Admin\C\Back
up\My Documents

Note: The "Root Path" will be ignored when performing byte-level replication
using Normal Mode (i.e. Local or UNC paths).

Port Configuration Tab

and/or Byte Replicator.

Provides settings to be used by both the Source and Target connections when using TCP

Time Out Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure
operation.

Port This is the TCP Port used to communicate with the Listener on

the remote machine. This must match the port number that the
PSListener is configured for. By default both Listener and
PeerSync use port 7333.

Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024.

Compression

Uses a lossless compression algorithm to transmit data in
fewer bits. By default Compression is disabled to achieve
faster performance.

User Information

This is an optional setting that allows you to specify a User
Name and Password to be used for encryption as well as
authentication purposes when connecting to the remote
PSListener. In order to activate encryption or authentication,
you mustspecify botha User Name and a Password value.
Strong DES encryption will be used to encrypt the data and
communication as itis being transmitted over the Internet, LAN,
WAN, or VPN.

The User Name and Password entries can be arbitrarily
chosen and are not required to be valid. However, once
specified, you must enter the same User Name and Password
entries in the PSListener Configuration residing on the remote
location.

If you specify a User Name without a Password, the User
Name entry will be ignored and no encryption or authentication
with the PSListener will occur.

Using FTP Mode

The TargetFolder Configuration Button can be activated by clicking on the Configure button
located in right lower corner of the Target Folder panel/section. Selecting the Configure
button opens the Target FTP Configuration window. Alternatively, you may right-click on the
TargetFolderfield and select Configure: TargetFolder (See Target Folder Popup Menu).
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FTP Configuration Tab

authentication.

Provides a guided method for entering the Target FTP path as well as connection

Host Name

Enter the IP address or machine name of the Target folder into
this filed. You may use the machine name only if the FTP
Target machine resides on the same network as that on which
PeerSync is running.

Path to Host

Provide the full path to the Target folder in this field (i.e. /
FTProot/My Data/Target). Make sure the path begins at the
base directory to which the FTP server allows connection. The
path does not need to be preceded by the key phrase 'FTP'
however it must start with a forward slash (/). This field does
notvalidate the existence of the path you provide therefore you
must exercise greatcare when doing so. If the path does exist,
PeerSync will create it during run time as long as a valid host
name or IP address has been provided.

User Name

Stores the Target FTP User Name information for login.

Password

Stores the Target FTP Password information for login.

FTP Settings Tab

Provides configuration forthe FTP Target selection.

Enable Passive Mode

Sets the FTP mode to passive. The phrase passive refers to
the FTP server which passively accepts connections and data
while the client initiates both the control connection and the
data connection to random ports specified by the server.
Passive mode is enabled by default.

Hostis using GMT

Option to adjustfor GMT time on the FTP serverside.

Time Out (seconds)

Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure
operation.

Port

Port number used to initiate an FTP session or "command"
connection to the FTP server. Uses standard port 21 by
default.

Use Proxy - Firewall

This option allows you to specify the Host Name, User ID,
Password, and Port number to a network Proxy - Firewall.

File types to
transfer as ASCII

Through this field, file types can be selectively tagged for
transfer as ASCIlI upon synchronization. File types can be
typed manually, or can be specified using either the "Files to
Transfer as ASCII Button" or the drop-down list located to the
right of the field. The drop-down list located to the right of this
field will be dynamically populated with file types as they are
set through the dialog box described above. They are also
added to the list when you exit the field after manually editing
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the file types field. File types can then be specified by
selecting them from this list. This provides a way to store and/
orretrieve sets offile types for later use with other Jobs.

Alternatively, clicking on the "Files to Transfer as ASCIl Button"
to the right of this field opens a dialog box into which file types
may be entered. To add a File Type click "New," then type the
desired file type into the field located at the bottom of the
dialog. These file types are set by specifying file extensions (i.
e. ".xt") which, if found within a file name, will be transferred as
an ASCII file during synchronization. Multiple strings will be
semicolon delimited. These settings are not case sensitive, (i.
e. "A" ="a"). Repeat this process for each File type. Entries
canbe deleted by selecting them from the list and clicking the
"Delete" key atthe bottom of the box. Once you have finished,
click the "OK" button. The box will close and all of the file types
you have specified will automatically appear in the Files to
transfer as ASClI| field.

Notes:

1. The TCP features listed on this page require the TCP_WAN_Connector option. Please visit http://www.
peersoftware.com or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit http://www.
peersoftware.com or contact Sales for additional information.

Located to the right of the Target Folder Selection Field, this button opens a "Browse for
Folder" dialog box: once this box has opened, locate your chosen Target folder, select it
using the leftmouse button, and click "OK."

Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

Explore/Open/Create Target Button

This button provides three options to be selected from the attached drop-down list. The
button label will change to reflect whichever item has been checked on this list.

Explore

When "Explore" has been selected and the button is
depressed, an Explorer-type window will open displaying all
available directories. By default, this window will show the
folder whose path is currently designated in the Target field. If
the folder shown in this field does not exist, Profiler will display
a dialog alerting you to this fact and asking if you would like to
create it youcando so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created Folder will be shown in the Explorer-type tree.

Open

When "Open" has been selected and the button is depressed,
a traditional MS navigation window is opened displaying the
contents of whichever folder is currently shown in the Target
Folder Field. If this folder does not exist, Profiler will display a
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dialog alerting you to this fact and asking if you would like to
create it youcando so by clicking "Yes" button located at the
bottom of this dialog. Once you have done so the newly
created Folder will be shown in the navigation window.

Create

When "Create" has been selected and the bution is
depressed, a "Select Directory" dialog will open allowing you
to specify a TargetFolder path by using the mouse to select a
desired drive, directory, and folder (See image in "Source
Folder Selection" topic above). Folder paths can also be
manually entered into the "Directory Name" field. If you enter a
path for a folder that does not exist and hitthe ENTER key or
click "OK," a dialog box will appear allowing you to create this
folder.

Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

Target Folder Popup Menu: Using Normal Mode

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field.
The first four features allow the user to Browse for Target Folder, Explore, Open and/or
Create the TargetFolder selection.

Configure: Target
Folder

Selecting this option displays the Target Network Logon
Settings window. This allows the user to specify Network
Logon credentials for the Target Folder which enables
connection to directories that are not accessible with the
currentlogged on account.

Edit: Target Variable
File

This will allow the userto view/edit Variable Data Import and/or
Job Data Import files that are used in the Target Folder
selection. This option is only available if using Job data import
files.

Create Auto Job
Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Set Alternate/
Additional Targets

Selecting this menu item will open the Alternate/Additional
Targets selection window. This feature allows for alternate or
additional Targetpaths associated with the base Job.

Force Source Folder
Rootas Target
Folder Root

Appends the Source folder directory to the Targetfolder path.

Target Folder Popup Menu: Using TCP Mode

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field.
The firsttwo features allow the userto Explore and Open the Target Folder selection.
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Configure: Target Selecting this option displays the Target TCP/Port
Folder Configuration window. This window provides a guided method
for entering the Target TCP path as well as TCP and/or Byte
Replicator settings (see TCP Configuration).

Create Auto Job This feature allows a simple way to generate meaningful Job
Name names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Force Source Folder | Appends the Source folderdirectory to the Targetfolder path.
Rootas Target
Folder Root

1. The TCP features listed above require the TCP_ WAN_Connector option. Please visit http:// www.peersoftware.
com or contact Sales for additional information.

2. The Browse for Target Folder and Create options are not available when using TCP Target Mode.

Target Folder Popup Menu: Using FTP Mode

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field.
The firstfeature allows the userto Open the TargetFolder selection.

Configure: Target Selecting this option displays the Target FTP Configuration
Folder window. This window provides a guided method for entering
the Target FTP path, specify network authentication, as well as
FTP configuration options (see ETP Configuration).

Create Auto Job This feature allows a simple way to generate meaningful Job
Name names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Force Source Folder | Appends the Source folderdirectory to the Targetfolder path.
Rootas Target
Folder Root

Notes:

1. The TCP features listed on this page require the TCP_WAN Connector option. Please visit http://www.
peersoftware.com or contact Sales for additional information.

2. The FTP features listed on this page require the File_Transfer Protocol (FTP) option. Please visit http://www.
peersoftware.com or contact Sales for additional information.

3. The Browse, Explore, Create, and Set Altemate/ Additional Target options are not available when using TCP and
FTP Target Modes.

This link will be enabled ifyou are using a Normal Target Mode Selection. By selecting this
link you can set and access your current Alternate Target Path Selections. Through this
feature, Jobs can now have alternate or additional Target paths associated with the base
Job. This allows for the ability to redirect data on a failed connection to the base Target and/
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or easily setup, one-to-many scenarios for distribution purposes. Selecting this menu item will
open the Alternate Target Path Selection dialog.

To add an alternate or additional Targetclick "New," then type the desired path into the field
located atthe bottom of the dialog or selectthe "Browse" button to selecta path.. Repeat this
process foreach Targetpath you wish to add. Entries can be deleted by selecting them from
the listand clicking the "Delete" key atthe bottom of the box. You can also use the "Up" and
"Down" buttons to reorder the paths.

Notes:

1. This feature requires the Enhanced Package.

2. Altemate Target Path Selection is not available for TCP or FTP Target Mode Selections.

3. When using Altemate Target Path Selections you cannot use variables that are specific to the Job (i.e. %
JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.

If this check box is selected, all sub-folders contained within the Source Folder will be
synchronized to the Target.

This button reverses placement of the file paths shown in the Source and Target Folder
Fields (so that what was formerly a Source Folder now becomes a Target Folder, and vice
versa).

Represents the date/time the last scan started for the selected Job. This is the date/time of
the last bi-directional synchronization scan of a Job that will be used when comparing files
during the Bi-directional Synchronization Mode option on the File Options screen. This
feature is also displayed and can be resetfrom the Profile Job List Pop-Up Menu.

Represents the date/time and user when the selected Job was lastsaved.

This section describes additional features related to the Folder Selection topic. The features
below apply to both the Source and Target folder selections and related configuration
options.

- Related Options
File/Folder Path Variables
Variable Data Import

Job Data Import
Dynamic Network Drive Mapping and Unmapping

Variable file/folder paths can be used to create:

. Dynamic archives for yearly, monthly, weekly and/or daily backups

. Dynamic synchronization based on date

. Dynamic synchronization based on logged on user or machine name

. Dynamic synchronization based on personal folders or other variables read in from the
registry

. Log file storage, manipulation and organization

. Administrative reportfile storage, manipulation and organization

7. Deleted file storage, manipulation and organization

A OODN =

[e20é)!
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File/Folder Path Variables

Depending upon the argument used, these folders will be dated, named after the currently
logged user, named for the PC from which synchronization was launched, or based on a
pre-determined variable stored out and read in from the registry. The following variables
can be used in any folder path Job setting available through the Profiler:

Date %Date%

Time %Time%

Date/Time %DateTime%

Minute %Minute %

Hour %Hour%

Day %Day%

Year %Year%

Month/Year %MonthYear%

Minute (all formats) %n, nn%

Hour (all formats) %h, hh%

Day (all formats) %d, dd,ddd, dddd, ddddd, dddddd%
Month (all formats) %m, mm, mmm, mmmm, mmmm%
Year (all formats) %y, yy%

Custom Peer Variables

Logged On UserName %UserName %

Computer Name %ComputerName %
Job Name %JobName %
Source Folder Path %SourcePath%
TargetFolder Path %TargetPath%
Deletion Folder Path %DeletePath%
ReportFile Path %ReportPath%

Windows Variables

Windows Directory %WinDir%

Windows %Windows% (also %SystemRo0t%)
System Temp Path % Temp%

System Temp Path % Tmp%

System Drive Letter %SystemDrive %

System 32 (WIN 9x/ %System32%

NT/00)
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Windows Variables from the
"HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explo
rer\Shell Folders" Registry

Desktop %Desktop%
Favorites %Favorites%
Fonts %Fonts%
Personal %Personal%
Programs %Programs%
Recent %Recent%
SendTo %SendTo%
StartMenu %Start Menu%
Startup % Startup %
Templates %Templates%
Notes:

You can also use any variables that are located in the registry under HKEY_CURRENT_USER. For example:

HKEY_CURRENT_USER\ Environment (used by default default)
HKEY_CURRENT_USER\ Volatile Environment (used by default)

The HKEY_CURRENT_USERS locations can be modified in the PSDef.cfg file as follows:

[Misc Options]
RegVarStr=\ Environment;\ Volatile Environment;

In addition, the %9USERPROFILE% Environmental Variable is now also supported.

Use the variable %Personal% to define the "My Documents" folder in Profiles that will be used on multiple
operating systems such as XP and Windows 7. Since the location of the My Documents folder is different on these
operating systems, using the %Personal% variable will dynamically resolve to the correct location on each system.
This simplifies configuration and keeps the Profile generic and deployable on multiple operating systems.

Note for PeerSync Jobs linked to PeerLock: PeerLock supports the usage of Windows System and
Registry variables in the Source and Target fields (i.e. %UserName%, %ComputerName%,). Custom PeerSync
variables such as %JobName% are cumently not supported and will not work in PeerLock.

PeerSync now contains tools forimporting data from files. The ability to extract specific fields
of data from a file has been included to allow unlimited scalability. Within an organization,
one generic Profile can now be created, and utilizing text files, specific information about the
user and the desired folders to be synchronized can be imported dynamically. Variables can
be used to dynamically introduce data from a file into various fields throughout the interface
including file paths, deletion paths, log file paths, log file names, etc.

Field data is imported through:
<<#FileName.ixt [section] item#>>

In which the [section] is a defined field in a file, such as the example file content below.
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[Info]
Name=Cris Smith
Home=c:\mydocuments

Using <<#FileName txt[Info] Name#>> will import "Cris Smith" into the path it was used in and
using <<#FileName.ixt [Info] Home#>> will import "c:\mydocuments" into the path it was used
in.

Note: This feature requires the Enhanced Package.

PeerSync now contains tools forimporting data from files to dynamically create Jobs. Within an
organization, one generic Profile can now be created, and utilizing textfiles, specific information
aboutthe userand the desired folders to be synchronized can be imported dynamically. Lists can
be used in Source and Target path names as such:

Source: <<$FileNameSources.xt$>>
Target: <<$FileNameTargets.txt$>>

or:

Source: <<$C:\Path\T o\File\FileNameSources .txt$>>
Target: <<$C:\Path\T o\File\FileNameTargets.xt$>>

Corresponding entries of each delimited file entry will be used to dynamically create a Job
based upon the Jobs properties.

Note: This feature requires the Enhanced Package.

PeerSync allows for the ability to dynamically map and un-map a Source or Target folder
selection. The way you do this is to add a letter to the beginning of the UNC path that you
wish to map the drive to. This can be done for the Source or Target selection (i.e. n\
\COMPUTER\SHAREDDEVICE\PATH).

For Example: '\\DELLSERVER\D\USERDATA

The example above will map the D drive on the DELLSERVER to the N drive upon start of
PeerSync and will unmap the drive when PeerSync terminates. This is a quite useful feature
especially when running PeerSync as a service in the scenario where you want to
synchronize to a mapped drive. This feature will allow for itto occur seamlessly.

Note: If you are going to run PeerSync as a Service it is advised to use UNC paths or
PeerSync's Dynamic Network Drive Mapping and Unmapping feature instead of using
mapped drives due to the fact that mapped drives are not understood when a user is not
logged on.

Next/Last Available Drive Mapping

This feature allows for the dynamic mapping of the next (A) or last (B) available network drive
by using the following formatin the Source or Target Fields:
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Map Next Available Example: ANCOMPUTER\SHAREDDEVICE\PATH
Map Last Available Example: BACOMPUTER\SHAREDDEVICE\PATH
Local Drive Mapping

This feature allows for the dynamic mapping of a local drive by using the following format in
the Source or Target Fields:

Map Local to N Example: NW\LOCALCOMPUTER\SHAREDDEVICE\PATH

1.1.2 Automation

—Auktomation

—Scanning Opkions

[ Scan Job omce at stark

[T Scan Job every |12IZI minukels)
[T Scan Job at I::Nu:u Selections = j |

[T Use Enhanced Scanning  Use Tree Depth of 1 Level

—Real-time Event Detection Options

¥ Use real-time monitaring Real-time Options. .. Global Setkings

- Topics
Automation Overview
Automation Options

The Automation screen allows you to apply Real-Time Monitored or Scheduled
synchronization to individual Jobs within a given Profile. Real-Time operations (also referred
to as "File/Folder Change Detection") monitor Source Folders for any changes and
synchronize them to the specified Targetas they occur. Scheduled operations automatically
launch synchronization according to a user-specified schedule. Through these settings,
PeerSync allows you to build a Profile with as many as 255 different Jobs -- each run

according to a unique schedule or in Real-Time (Also see Command Line Arguments for
Global Automation Settings).

Scanning Options
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The options listed on this page can be accessed from the Automation window. This screen
allows the user to setthe frequency of scans as well as enable Real-Time replication.

Scan Job Once at
Start

This feature directs PeerSync to run the currentJob as an
Automatic Operation. An Automatic Operation allows you to
perform animmediate launch of the current Profile. As a non-
persistent process, Automatic Operations are run a single time
upon manual initiation by the user. We also refer to this type of
run as an Initial Sync.

Scan Job every x
minute(s)

Checking this feature assigns a Scheduled operation to the
selected Job(s). The field associated with this feature allows
you to setaninterval in minutes: after this time has elapsed the
selected folders will be synchronized. 5 minutes is the default
setting. Intervals in seconds can be specified through the use
ofdecimals, (i.e. 0.5, 2.5, etc.); the minimum interval is 0.01.

Scan Job atx

Checking this feature will allow for the synchronization of Jobs
at a specific times of the day for selected days of the week.
When selected the Daily Timer Options dialog will appear
with the following options:

Run selected Jobs at

Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field.
Selecting this feature will run the Job at the selected time of
day.

Listof Job Selections

Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field. This
is a list of the currently selected Daily Timer selections. You
can Add New selections by selecting the New button and
Delete existing selections by selecting the Delete button.

Select days of week to run

Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field.
Allows you to turn on/off which days to run this schedule.

Selection Options

Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right ofthe "Scan Job at" field. This
feature will give you the option to run the selected daily timer
schedules in a Recurring mode (synchronization will run every
time according to the set scheduled options) or Run Once
(synchronization will run only once).

Use Enhanced

Scanning (Enhanced
Scanning)

The Enhanced Scanning option is required for this feature to
be enabled. Enhanced Scanning provides the ability to build
multiple dynamic Jobs for parallel processing of folders during
scans. This will significantly improve the time PeerSync takes
to scan trough directories. By default PeerSync scans through
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a Job sequentially, one folder at a time. With the Enhanced
Scan option enabled PeerSync will spawn a Job Thread for
each folder or subfolder encountered during a scan.

When the Use Enhanced Scanning checkbox on the
Automation window is checked the Enhanced Scanning
dialog will open. By default the slider in the Enhanced
Scanning dialog is set to the Off position all the way to the left
side. To enable the Enhanced Scan feature move the slider to
the right. Each slide position represents a depth level of 1, 2, 3,
4,and 5respectively. Each value represents the depth level at
which PeerSync will spawn a Job thread for each folder it
encounters.

Example:

If you set the Enhanced Scanning slider to Level 3, then
PeerSync will spawn 7 dynamic Jobs for the Users directory
depicted bellow. It will in essence create a dynamic Job for
each of the folders at Level 3 (Folder1, Folder2, Folder3, and
Folder4). It will then create a Job for the folders at Level 2
(Users1 and User2) butwill exclude all their subfolers. Lastly, it
will create a Job for the directory at Level 1 (Users) and
exclude all the subfolders.
= ) Users

=l | Userl
=l |} Folderi

) Faldera
= ) Folderz
) FolderB
= () Userz
= ) Folders
) FolderC
=l |} Folders
i) FalderDr

Notes:

1. The Enhanced_Scanning and the Multi-Threading add-on options are
required for this feature. Please visit http://www.peersoftware.com or
contact Sales for additional information.

2. When using this option be sure you make available a large pull of Job
Threads to be used by PeerSync so that dynamic Jobs can be created for
each folder during a scan.

3. This feature is not supported when using FTP source or target modes.

4. This feature is not supported when using the Enhanced_Bi-directional
option.

Real-Time Event Detection Options

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved


http://www.peersoftware.com/products/recommended_options/enhanced_scanning.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_scanning.aspx
http://www.peersoftware.com/products/recommended_options/multi_threading.aspx
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.aspx

PeerSync Help 60

The options listed on this page can be accessed from the Automation window. This screen
allows the user to setthe frequency of scans as well as enable Real-Time replication.

Use Real-Time Selects the current Job(s) for Real-Time Monitoring.
Monitoring
Real-Time Options... | This button opens an "Additional Options" dialog box. Once

this box has opened, it allows you to choose from two Real-
Time operations. The first is a Folder Replication feature,
which monitors for changes to the Source Folder and
synchronizes the Target accordingly. The second, a Folder
Restoration feature, monitors for changes to the Target Folder
and restores files on the Target accordingly. To properly use
the restore feature, you will need to select the "Always
overwrite Targetfiles" option.

Notes:
1. Bi-directional will be ignored for Real-Time Jobs.

2. When synchronizing to an FTP Target, PeerSync will suppress Real-Time
Jobs until initial synchronization has completed.

Enhanced Real-Time Monitoring

This feature allows the Real-Time feature in PeerSync to
detectindividual changes to files and synchronize only the file
which has changed without scanning the entire folder where the
change occurred. Normally, synchronization software scans
and compares all files into a folder which is being
synchronized. This feature does not scan folders unless the
change is indeterminate. If a file or folder is renamed,
PeerSync will rename the corresponding Target File or folder
using rename functions as opposed to copying the newly
renamed Source Folderto the Target and then subsequently
deleting the outdated Target file/folder. This feature greatly
reduces the time required to synchronize files and also
reduces network band width requirements.

With this option enabled PeerSync will continue to detect real-
time events even during a scan.

Notes:

1. Bi-directional, During comparison subtract/ add x minute(s) from Target, and
Trigger. Selections, as well as, other non applicable features may be ignored
during Enhanced Real-Time.

2. It is recommended either use the Enhanced Real-Time option for all or none
of your Real-Time Jobs within a Profile.

3. Using Enhanced Real-Time will produce a different file output format for all
modes of reporting and message logging (Reporting, Admin Reporting and
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Email Reporting). The output will NOT contain a start and stop section or a
summary, each entry will also be initially marked with a date and time stamp. If
use summary is selected for Admin or Email reporting then the standard
selection will be used. The reason this is done is due to the fact that processes
will be running in parallel.

Use Standard Real-Time Monitoring

When the Real-Time feature detects a change to synchronize,
this method will cause a scan to run on the root folder, but not
the subfolders. For folder manipulations such as renames, the
entire folderincluding its subfolders will be scanned.

Global Settings See Source Folder Global Options.

1.1.3 Blackout Settings

rBlackout Setkings
v Set Elackout Times

Skark kime: I g:00 AM ::II e I 5:00:00 AM - 6:00:00 PM
End kirne: IE:DD P _,::' Delete |

List af Current Seleckions {17 ;

00 01 02 03 04 05 05 07 05 08 10 11 12 15 14 15 16 17 1§ 19 20 21 22 23

[T suspend active scans when a Blackout period starts

- Topics
Blackout Settings Overview

Blackout Period

This screen will enable you to set a Blackout period during the daily synchronization. This
is a period in which the synchronization will stop and wait until the blackout period has
expired according to the specified settings. This would be a useful feature if you wish to
stop all the synchronization activities during a particular time when the Network Bandwidth
is busy with other activities (such as during working hours).

Suspend active scans | Enabling this option will pause all the scheduled scans during
when a Blackout the specified Blackout and will resume after the Blackout
period starts period ends.
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What happens if PeerSync is performing a scan when it enters the Blackout
period?

If the option to "Suspend active scans when a Blackout period starts" is enabled the scan will

be suspended and resumed at the point it was left off after the Blackout period ends. If this

option is not enabled, the scan will be stopped during the Blackout period and will be

restarted from the beginning after the Blackout period ends.

What happens if PeerSync was in the middle of transferring a large file
when it entered the Blackout period?

PeerSync will allow the transfer to complete but suspend any new events from being
processed until the Blackout period ends. The suspended events or scans will be
processed after the Blackout period ends.

What happens if a scan is scheduled to run during the Blackout period?
Regardless if the option to "Suspend active scans when a Blackout period starts" is enabled
the scan thatis scheduled to run during the Blackout period will run after the Blackout period
ends. Multiple suspended scans for a single Job will be compiled into a single scan that will
run atthe end of the Blackout period.

1.1.4 Scan Limitations

—5Scan Limitations

Mazxirumn Curation of Scans
[ Set maximurn duration of scans bo |12III minukels)

—Initiate Scan on Trigger File Change

[~ Use Trigget Files Default Marne: IGLELCHG.EIEIEI =l
Source Trigoer File:
| =
Target Trigger File: se Current Paths |

! =)=

- Topics
Maximum Duration of Scans
Initiate Scan on trigger File Change

Note: Features listed on this page require the Enhanced Package.

Enabling the Set maximum duration to x minutes option allows you to specify a
maximum duration for each Job. This gives you the ability to limit the run time of a Job during
initial, interval, and scheduled scans.
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Trigger Files

These settings ensure that the Target Folders always remain updated to their
corresponding Source by comparing dates indicated by individual Trigger Files. For
example, ifa Source Trigger is found to be newer than a corresponding Target Trigger, a
synchronization process will be allowed to proceed for the selected Job(s). If the files date
and time stamps match then the synchronization will not be processed. Therefore, the run
ofthe sync process is in essence, determined by the trigger files.

Use Trigger Files This feature is used to activate or trigger synchronization
based upon date comparison between an individual Source
Trigger File and a separate Target Trigger File. If the Target
Trigger File is older then the Source Trigger File, the entire
Source Folder(s) will be synchronized.

Default File Name Displays the Default Global Trigger File Name: GLBCHG.000

Source Trigger File This field allows you to specify a Global Trigger File by
entering it manually, or by selecting it using the browse button
located atthe right side of the field.

Use Current Paths Automatically selects the current Trigger Files associated with
the Source and TargetFolders.

Target Trigger File This field allows you to specify a Global Trigger File by
entering it manually, or by selecting it using the browse button
located atthe right side of the field.

Note: During Enhanced Real-Time, Trigger Selections will be ignored.
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1.1.5 File Options

64

—File Cptions

~TMode Selection

% Standard (update target files if source is newer)
" Always Overwrite {(update targek files if source is newer or older)

" Bi-directional (both directions) Global Sethings

—Ewent Options

v add - synchronize new Files
[ Update - synchronize existing Files

v Replicate - Delete unmatched Files Deletion Opkions. .. |
eletion Folder
[+ Maove deleted Files to an alternate location Move Cpkions, ., |
- Topics

Mode Selection
Event Options

Mode Selection

The options listed on this page can be accessed from the Eile Options window.

Standard (update
Target Files if Source
is newer)

With this mode selection, PeerSync will update files on the
Targetonly ifthe Source is newer.

Always overwrite
(Update Target Files
if the Source is newer
orolder)

This feature automatically overwrites any files in the Target
Folder that have a different date\time stamp than their
corresponding Source File, even if the Target File is newer.
This feature can be used to restore folders to a previous state
either for backup/restore operations or to reset files after
training operations.

Bi-directional (both
directions)

With this feature selected, PeerSync will merge the data of the
Source and the Targetfolders during Scan at Start, interval and
scheduled scans. This feature may be ignored during Real-
Time and Enhanced Real-Time modes. The following will
happen when this feature is selected with the Replicate -

Delete unmatched files/folders option enabled:

If a File exists in both Source and Target Folders
PeerSync will compare the Modified date/time of the files and
update/overwrite the older file with the newer file. If the modified
date/time is identical PeerSync will notperform any action.
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If a File exists in only the Source or Target Folder
PeerSync will compare the Modified, Created and Accessed
date/time of the file with the stored Last Run On date/time of the
Job. Ifany of the three file date/times are newer than the stored
Last Run On date/time the file will be added, otherwise the file
will be deleted.

If a Sub-Folder exists in only the Source or Target
Folder

The Source will be seen as the primary folder and any sub-
folders with content existing on the Source will be added to the
Target. Ifthe folder is empty or exists on the Target, PeerSync
will compare the Modified, Created and Accessed date/time of
the folder with the stored Last Run On date/time of the Job. If
any ofthe folder date/times are newer than the stored Last Run
On date/time the folder and all of its contents will be added,
otherwise the folder will be deleted.

Note:

PeerSync now also supports real-time or scheduled bi-directional replication
using our TCP replication mode. To achieve real-time bi-directional replication
across TCP, PeerSync and PSListener would need to be installed on both the
Source and the Target machines. For scheduled bi-directional replication
across TCP, PeerSync would need to be installed on one side, while the
PSListener on the other. This feature is not supported when using a TCP or
FTP Target.

- Related Options
Global Bi-directional Options

Notes:

1. The Bidirectional feature is only supported when working with a Normal Source and a Normal or TCP Target.

2. The Bi-directional feature may be ignored when using FTP Source or Target.

3. The Bidirectional feature may be ignored when using TCP Source.

4. The Bi-directional feature is only valid during scans and will be ignored during Real-time monitoring.
5. The Bi-directional feature may be ignored when using Compression.

6. Non NTFS partitions may behave differently using the Bi-directional mode. You may notice files being retained for
up to one day, even if you delete a file from the Source or Target.

7. Modifications, such as renames and deletes, of Target Folders are subject to restoration in the Bi-directional
mode.

Event Options

The options listed on this page can be accessed from the Eile Options window.

Add - synchronize If the Source contains files not found within the Target and this
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new files to Target

feature is selected, those files will be added to the Target
Folder during synchronization. This feature is selected by
default.

Update - synchronize
existing files in Target

If this feature is selected, Target Folder files which are also
found within the Source will be updated to match those Source
files during synchronization. This feature is selected by default.

Replicate - Delete
unmatched files

If this feature is selected, any unmatched files found in Target
Folders will be deleted automatically.

CAUTION: Use this feature carefully. If not configured
properly, needed files may be permanently deleted. A deletion
warning is NOT displayed by default: Profiler must be first set
to display this warning through the "Deletion Warning
Message" check box.

- Related Options
Deletion Options

Move Options

Note: The Replicate feature may be ignored when using Compression.

Delete Options

following features:

The options listed on this page can be accessed by clicking on the Deletion Options
button from the File Options window. Once the Replicate - Delete unmatched files option is
turned onthe Deletion Options button will be enabled for further configuration. Clicking on
the Deletion Options button opens the "Additional Options" dialog box which contains the

Deletion Warning
Message

The upper section of this screen allows you to enable or
disable a Deletion Warning Message, as well as set the
number of seconds for which a Message will be displayed. (a
message is NOT enabled by default and is not available
during Enhanced Real-Time). In addition, you can also choose
to display a message requiring manual intervention in order to
activate deletions.

Move Options

By clicking on the Move Options button in the File Options window you will be able to
access the Move Deleted File Options dialog which has the following settings available:

Move Deleted Files
Options

This section provides a field where the user can designate an
alternate folder to which unmatched files will be moved in order
to avoid permanent deletion. This folder path can be typed
manually, or selected using the browse button provided to the
right of the field. If the designated folder exists, all unmatched
files will be moved there, allowing you the opportunity to
recover files deleted from the Target. This field also supports
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File/Folder Path Variables and when used, the current path will

be displayed above the field. Beneath this field are path
options.

We strongly recommend using a Deletion Folder that is
located on the Target host computer. Relocation to an
alternate drive or host adds unnecessary processing and
bandwidth overhead. For this reason PeerSync uses the
following Deletion Folder variables:

%TARGETROOT %

This variable resolves to the root directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the deletions path % TARGETROOT %\Deletions will resolve
to \machine 1\c$\Deletions. This variable is used by default.

% TARGETPARENT%

This variable resolves to the parentdirectory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the deletions path %TARGETPARENT%\Deletions will
resolve to \\machine 1\c$\Target\Deletions.

Relative Paths

This feature will move files deleted by PeerSync from the root
folderto the root of the selected folder. Files deleted from sub
folders will be moved to corresponding sub folders below the
root selected deletion folder. This feature is intended (works
best) for a Profile with a single Job.

ExampSource Folder: C:\ MyDocs\ Files\

le:
Target Folder: D:\MyDocs\ Files\
Move Path: C:\ DeleteFolden
If you delete: C:\ MyDocs\ Files\ Sub\ File.txt
PeerSync will move: D:\ MyDocs\ Files\ Sub\ File.txt
To: C:\ DeleteFolden Sub\ File.ixt

Preserve Paths

This feature will recreate the original path of the deleted file
under the specified path. Therefore, a file deleted by PeerSync
will be moved into a folder thatcorresponds to the file's original
location: under the selected deletion folder. This feature is
intended (works best) for a Profile with Multiple Jobs.

ExampSource Folder: C:\MyDocs\ Files\
le:
Target Folder: D:\MyDocs\ Files\
Move Path: C:\ DeleteFolden
If you delete: C:\MyDocs\ Files\ Sub\ File.txt
PeerSync will move: D:\ MyDocs\ Files\ Sub\ File.txt
To: C:\ DeleteFolden D_MyDocs\ Files\ Sub\ File.
txt

Use Recycle Bin

This feature allows you to specify the Windows Recycle Bin as
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a location for unmatched files. This feature is not intended for
use when file deletions made by PeerSync may occur on a
non-local machine or device. Only files deleted from a local
drive can be moved to the Recycle Bin, if this feature is used
all network files will be permanently deleted.

Delete unmatched
Target Files older
than x days

This feature is intended for the cleanup of files that were
candidates for deletion but were selected to be moved to an
unmatched folder. By use of this feature, PeerSync can be
used to temporarily store files setup for deletion and then have
the files deleted after a specified number of days. By default
deletion folders are checked every 24 hours or immediately
after the initial scan (if Scan Job Once at Start is enabled). This
interval can be modified by using the /LH:n argument where n
is represented in minutes.

Notes:

1. Only one copy of any file can exist in your designated Recovery folder.

2. To avoid filling up your hard drive unnecessarily, you should periodically check this folder and delete unwanted
files or use the Delete unmatched Target Files older than x days option.

3. Only files deleted from a local drive can be moved to the Recycle Bin, if this feature is used, all network files will

be permanently deleted.

4. When synchronizing to an FTP Target, the Move unmatched Target Files option is not available.

5. When using Compression, the Move unmatched Target Files option is not available.

6. The Deletion Waming Message option is not available during Enhanced Real-Time.

7. When using the Altemate Target Path Selections feature you cannot use variables that are specific to the Job (i.
e. %JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved



69

PeerSync Help

1.1.6 Open Files

~Open Files

—Cpen Files

" Include open files (allow read and write access o source File during transfer)
% Include open files (allow read access ko source file during transfer)
" Exclude open files (allow read access ko source File during kransfer)

" Exclude open files {dervy all access ta source file during transFer)

~Open/Locked Files

- To configure options for OpenfLocked Files click here Managed Files

—Relakted Global Settings

- To set Global RecoveryOffline Options click here Global Settings

- Topics
Open Files Overview
Managed Files
Global Settings

Open Files

The options listed on this page can be accessed from the Open Files window.

Include open files
(allow read & write
access to source file
during transfer)

Use this option when you want to include open files and allow
users to modify them while they are being transferred. For
locked files such as database files, PeerSync will first attempt
to process them using the Managed Files setting if enabled. If
this process is not enabled or fails, locked files will be retried

based onthe retry open/inaccessible files setting.

Note: If PeerSync is able to synchronize files which are in use by other
applications, access to those applications may in certain instances be
temporarily lost during synchronization.

Include open files
(allow read access to
source file during
transfer)

Use this option when you want to include files that are open for
read-only access. Users will be able to open source files for
read-only access while they are being transferred. For files
that are being modified or are locked PeerSync will first
attempt to process them using the Managed_Files setting if
enabled. If this process is not enabled or fails, these files will
be retried based on the retry open/inaccessible files setting.

Exclude open files
(allow read access to

Use this option when you want to replicate only files that are
closed. Files that are opened or locked will be retried based
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source file during
transfer)

on the retry openl/inaccessible files setting. Users will be
denied write access to source files that are being transferred

but may have the option to open them in read-only mode.

We recommend you use this option when doing replication/
collaboration from one source to multiple destinations. This
option allows PeerSync to replicate files from one source to
multiple destinations, in parallel, while at the same time
protecting the source files from write access during their
transfer.

Exclude open files
(deny all access to
source file during
transfer)

Use this option when you want to replicate only files that are
closed. Files that are opened or locked will be retried based
on the retry openl/inaccessible files setting. Users will be
denied complete access to the source files that are being
transferred.

We recommend you use this option when doing real-time bi-
dirrectional synchronization/collaboration between two hosts.
For collaboration between more then two machines we
recommend you use the Exclude open files (allow read
access to source file during transfer) option.

-1 Related Options

Managed Files
Global Settings

Note: In order to replicate locked files you will require the VSS add-on module. If you do not configure the Managed
Files setting to use VSS, locked files will be retried based on the retry open/ inaccessible files setting.
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1.1.7 Managed Files

~TManaged Files

~TManaged Files

[+ Enable Managed File Access (Source Files Cnly)

Moke

Prafile.

clicking the link below,

Files that are synchronized via Managed Files will be processed after the "Scan
Job once at start" option {if enabled) and on a specified Global interval For the

The Global interval ko process files is set ta 120 minutes and can be modified by

—Tanaged Files Options

% Synchronize open/locked files via Managed Files

" Synchronize ALL files wia Managed Files fincluding files that are not openflocked)

—Related Global Settings

- Ta set Global Managed Files Options click here  Global Setkings

- Topics

Managed Files Options

Managed Files - Global Settings

Note: Features listed on this page require the VSS option.

Managed Files

The options listed on this page can be accessed from the Managed Files window.

Enable Managed File
Access (Source Files
Only)

Enabling this option will allow you to reliably backup open and
locked files while users continue to work on them. For this
feature to be available you will require the Volume Shadow
Copy Service (VSS) add-on module. This technology has
been integrated with PeerSync to allow synchronization of
critical data such as system files and databases. By default
this feature is enabled at the end of a manual synchronization
and is run every 2 hours during persistent (Real-Time or
scheduled) modes. This interval can be modified from the
Global Settings screen via the Global Managed Files Options
link to @ minimum interval of 30 minutes. For more features on
configuring this option please view the Managed Files

Arguments.

Synchronize open/
locked files via
Managed Files

Through the use of this feature PeerSync will enable
processing of the Open and Locked Files from the local
machine, through the use of the Volume Shadow Copy Service
(VSS) technology. Please note VSS will delay processing of
files to the specified interval. VSS is an add-on module.
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Synchronize ALL files
via Managed Files
(including files that
are notopen/locked)

Through the use of this feature, you can force PeerSync to
send all the file processing through the Volume Shadow Copy
Service (VSS) technology. Please note VSS will delay
processing of files to the specified interval. VSS is an add-on
module.

- Related Options
Global Settings

Notes:

1. These options require the VSS add-on module. Please visit http:// www.peersoftware.com or contact Sales for

additional information.

2. This feature only works for local Source folders and will be ignored with an FTP Source.

3. This feature may be ignored whe
4. This feature may be ignored whe

1.1.8 Performance

n using an ETP Target in conjunction with File Compression.

n using Folder Compression.

Set ko |32?E'8 vl bytes

—Performance
—File Read/"'rite BuFfer Size
Improved Maximurm
Load Balancing Petrformance
| |
1 1 1 1 1 1 1 1 1
256 bytes 256 KB

Reset ta Defaulk |

[ Thrattle bandwidth - Use I 100 vI percent of available bandwidth
[~ Enable inteligent network load balancing {when applicable)

[ Set maximurm nurmber of Copy Threads I:l:ul a 37

elated Global Setkings
- Ta canfigure Global Performance Options click here Options/Commands

- Topics
Performance Overview
Options/Commands

Performance Options

The options listed on this page can be accessed from the Performance window.

File Read/Write

This feature allows you to change the read/write buffer sizes to
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Buffer Size

optimize performance/speed across various network
environments or on the local machine. In most cases this will
increase performance dramatically but you will probably need
to test this feature in your environment to determine what
advantages can be gained from altering this size.

The minimum value is 256 bytes.

The defaultvalue is 64 KB.

The maximum value thatcan be set using the track baris 128
KB.

The maximum value thatcan be setusing the up arrow or by
manually typing in the spin editfield is 128 KB

Buffer Size Upper
Limit (* Multi Threading
Optionng Option)

A higher upper limit of 1 MB is available with the Multi
Threading Option option. This value can be set using the up
arrow or by manually typing a setvalue into the spin editfield.

Note: This option may be intemally set to a maximum value when using an
FTP Source or Target.

Throttle bandwidth -
Use x percent of
available bandwidth

This feature is designed to limit or slow down the pulse of
reads and writes performed by PeerSync, at the percentage
specified, in order to keep bandwidth available for other
applications to use. This is done at the file level and is
performed by each Copy Thread during the transfer of each
file. As we copy a file we track how long it takes to read and
write data from the source to the target. Every 100 milliseconds
from the start of a file transfer we calculate how much time to
allotfor processing and sleeping based on the percentage set
for the option.

Examples:

100% Always Process
90% Process for 90 milliseconds Sleep for 10 milliseconds
every 100 milliseconds
50% Process for 50 milliseconds Sleep for 50 milliseconds
every 100 milliseconds
10% Process for 10 milliseconds Sleep for 90 milliseconds
every 100 milliseconds

In summary, PeerSync determines bandwidth throtling by
calculating the amount of time required to send a packet of
data across your network and then applying a delay based on
the throttling percentage specified.

Notes:

1. This methodology should dynamically allow for PeerSync to transfer data at
a fast pace when no other applications are using bandwidth and allow it to
back off when other applications are using bandwidth.

2. This methodology is more accurate when using smaller Read/ Write Buffer
settings.

3. This methodology does not include small files that take less than 100
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milliseconds to process.

Enable intelligent
network load
balancing (when
applicable)

The network load balancing option will automatically set a
read/write buffer size based on recommendation from NIC
network cards (Installed network cards must also support this
feature).

Set maximum number
of copy threads to x (*
Multi Threading Option)

This feature will limit the number of copy threads to be
spawned and used for the selected Job during folder scans.
This thread limit does not apply to enhanced Real-Time
events. By using limits for scanning, it helps the Profile to better
process Enhanced Real-Time events during heavy scan
operations.

- Related Options
Options/Commands

Note: Some features described
peersoftware.com or contact Sales

1.1.9 Byte Replicator

on this page require the Multi Threading Option. Please visit http://www.
for additional information.

—ByteReplicatar

v Use blockfbyte level synchronization

On Failure: ILIse Default File Copy Far Synchronization

=~

~Block, Size Selection

Improved
Bandwidth Lkilizakion

Improved
Petrfarmance

1
Smaller

Block Size

1 1 1
Larger Block Size

Reset to Defaulk

File Exclusions | Excluded File Tvpes: OM - Minimurm File Size: 100 KB

Port Configuration | Part: 7333 - Time Out: 120 seconds - Compression: OFF

Moke: This opkion requires our P3Listener tool ko be installed on the
remoke computer with identical Encryption and Port configurations,

Topics

Byte Replicator Options

Note: Features listed on this page require the Byte Replicator options.

Byte Replicator Options
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The Byte Replicator screen enables and configures Block/Byte level synchronization for
the selected Job. Through the use of this feature PeerSync will be able to transmit only the
bytes/blocks of a file that have changed instead of transferring the entire file.

Use block/byte level | Select this option to enable/disable block/byte level
synchronization replication. If this is disabled, PeerSync will use the standard
copy method to synchronize the file. If the Byte Replicator fails
to synchronize a file, i.e. On Failure, PeerSync will either:

1. Log Messages & Use Recovery Intervals (if applicable)

2. Use DefaultFile Copy for Synchronization

Block Size Selection | This slider controls whether either Performance or Bandwidth
Utilization is most important. Files synchronized with the slider
set Low will take longer to complete than with the slider set
High.

File Exclusions Clicking on the Exclusions button in the Byte Replicator
window opens theByte Replicator File Exclusions dialog.
Files that match types in the exclusion string (types by file
extension) or files that have a size lower than the Minimum File
Size will use the default file copy method instead of the Byte
Replicator feature.

Excluded File Types by Extension

Field containing a list of file types that will use the default file
copy method instead of the Byte Replicator. This feature can
be configured by clicking the button to the right of this field. For
example, to exclude files with the extension LOG you may add
either .log orlog to the exclusion list. Multiple entries need to
be semicolon (;) delimited.

Minimum File Size

Files with sizes lower than the value in this field will be copied
using the default file copy method instead of using the Byte
Replicator.

Port Configuration Clicking on the Port Configuration button in the Byte
Replicator window displays the Port Configuration dialog.
This window allows fora common TCP and/or Byte Replicator
configuration option for both the Source and Target paths (see
the TCP Port Configuration tab for more information).

Note: The TCP WAN Connector (TCP) is an optional feature which may not
be included in your package. Please visit http:/ / www.peersoftware.com or
contact Sales for additional information.

Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024.

Notes:

1. The Byte Replicator is an optional feature which may not be included in your package. Please visit http:// www.
peersoftware.com or contact Sales for additional information.

2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is
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assigned as an administrative share (i.e. D$) in order for the Byte Replicator to work properly.

3. In order for Byte Replicator to be enabled, the following criteria must be present:
* The Target Path cannot be an FTP Target
* The PS Listener Service has been installed on the remote machine
* The PeerSync license has the Byte Replicator add-on feature

1.1.10 Revisioning

—Revisioning

v Revisioning - Keep backup files of overwritken target files

Mumber of backup files to keep: |3

{* Keep files in Target Folder
i Keep files in Deletion Folder
i Keep files in &lkernate Falder

ITCF‘:'I,'I,192.16EE.1?1.149'!,E'|,°.-".:J:::I::I"-.Iame°.-"o =l ﬁl

J Topics
Revisioning Options

Revisioning

The options listed on this page can be accessed from the Revisioning window. Through
the use of this feature, you can use PeerSync to keep multiple versions of each file. This is
a greatfeature for recovering a previously saved version of a file.

Revisioning - Keep Select this option to enable/disable the use of Revisions.
backup files of
overwritten Target

Files

Number of backup Designates the number of revisions to keep for each file.

files to keep PeerSync revisions each file by adding a ".PSBAK1" extension
to the existing Target File before replacing it with the updated
Source File.

Example: "MyFile.txt" will become "MyFile.txtPSBAK1"

If more than one backup is selected, each file will be renamed
to the nextrevision when an update occurs:
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Example: "MyFiletxtPSBAK1" is renamed to ".MyFile.txt.
PSBAK2"

The newest revisions (backup files) will bear the lowest
number while the oldest will have the higher number:

Example: Newer.. PSBAK1, PSBAK2, PSBAK3, PSBAKn ...
Older

Note: If the "Delete Unmatched" option is selected and the Source File that
has comesponding PSBAK files deleted, all associated PSBAK files will also be
deleted.

Keep files in Target
Folder

By default, revisions will be stored in the Target Folder where
the updated TargetFiles reside.

Keep files in Deletion
Folder

You also have the option of using the Deletion Folder for
storing revisions. This is quite useful when used in conjunction
with the Delete_unmatched_Target Files_older_than_x days
option, which is used for automatic cleanup of old revisions.

Keep files in Alternate
Folder

You may specify the folder path where you would like the
revisions stored to. This option will give you the ability to
specify a separate revision folder per Job. We strongly
recommend using a Revisions Folder that is located on the
Target host computer. Relocation to an alternate drive or host
adds unnecessary processing and bandwidth overhead. For
this reason PeerSync uses the following Revisions Folder
variables:

% TARGETROOT %

This variable resolves to the root directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the revision path % TARGETROOT %\Revisions will resolve to
\\machine 1\c$\Revisions. This variable is used by default.

% TARGETPARENT %

This variable resolves to the parentdirectory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the revisions path %TARGETPARENT %\Revisions will
resolve to \\machine 1\c$\Target\Revisions.

Notes:

1. This feature may be ignored when using an ETP._Source.

2. This feature may be ignored when using Folder Compression.
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1.1.11 Miscellaneous

rMiscellaneous

~Target File/Folder Alterations
v Use intermediate file during copy

[~ Trigger additional event after successful copy

[~ TransFer NT securiby descripkors (ACLs) ACL Opkions, .. | Global Sethings

[~ Force karget file attribute settings aktribute Options, .. |

—Source File/Folder Alkerations

[T Mave Files - Delete source File after successful copy ko barget

[~ Turn file archive attribuke off after synchronization

—Additional Event Options

[T Include attribute change as synchronization criteria

-l Topics
Temp Files
Source File/Folder Alterations
Additional Event Options

Target File/Folder Alterations

These options can be found in the Miscellaneous window.

Use intermediate file | If this box is checked, a temporary file will be created in the
during copy Target Folder: the contents of the Source File will then be
copied into this temporary file. After a successful copy, the
Target File will be deleted and the temporary file will be
renamed to bear the Target File name. This feature ensures
that the updated file will only replace the Target File if copy is
successful. Ifthe copy process should be interrupted because
of some outside factor (network down, power outage, etc), the
original Target file will still be preserved. This option is
enabled/disabled automatically when the Bi-directional or
Revisioning options are enabled/disabled.

Trigger additional When this option is checked PeerSync will apply the time
event after successful [ stamp of the target file after successfully completing the file
copy transfer in order to trigger an event on the target side. This

action will cause the PeerSync installed on the Target to take
further action with the file such as transferring it to another
location thatis notaccessible from the originating machine.

Transfer NT security If this feature is checked, PeerSync will transfer over and match
descriptions (ACLS) the security descriptions (ACLs) to the Target file upon
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synchronization, under Windows NT platforms. When this
option is enabled, the "ACL Options" and Global Settings link
will be enabled for further configuration.

ACL Options

This dialog is available if you enable Transfer NT security
descriptions (ACLs) or click on the" ACL Options" button
located on the Miscellaneous window. The options in this
dialog allow you to specify the types of permissions you want
PeerSync to transfer.

Force targetfile
attribute settings

If this feature is selected, the File Attributes Options dialog
will be displayed. In this dialog, you may select to force any
attribute on or off for the Targetfiles thatare synchronized within
the selected Job(s).

File Attribute Options

This dialog provides the user the selection to ignore, force on,
or force off attribute settings on Target files that are
synchronized within the selected Job(s).

- Related Options
Global Settings

Notes:

1. Care must be exercised when using ACL options to synchronize files and folders between different domains. File
security transfers could make the target file inaccessible after transfer/ update.

2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is
assigned as an administrative share (i.e. D$) in order for ACLs to work properly.

3. This feature may be ignored when using an FTP or TCP Source or Target.

4. This feature may be ignored when using Folder Compression.

Source File/Folder Alterations

These options can be found in the Miscellaneous window.

Move Files - Delete
source file after
successful copy to
target

This feature will delete the Source file after the file is copied to
its corresponding Targetfolder.

Note: This feature should not be used with the Delete Unmatched Target
Files option on the File Options screen because conjunct use of the two
options will greatly increase the chance of data loss.

Turn file archive This feature resets the archive flag on the Source and Target
attribute off after file after synchronization. The Windows file system
synchronization automatically sets the archive bit for every file that has
changed; normally, this is used to indicate that a given file has
been modified since the last time its archive bit was set. Most
tape back-up programs use this flag to determine which files
have changed since the last backup. This option will alter
Source files. PeerSync uses this feature to reduce the number
offiles thatare checked on the Source drive.
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1. Source files that are not being synchronized to Target folders will NOT have their archive flags reset. This

process only occurs after successful synchronization of a changed file.

2. This feature may be ignored when using an FTP Source.

Hint: To reset all Source file archive flags, use the "Always Overwrite Target Files" feature.
This configures all files for synchronization and consequently qualifies them for the reset of
archive flags. This feature only needs to be selected once to be applied to existing sync

operations.

Additional Event Options

This option can be found in the Miscellaneous window.

Include attribute This feature allows for the synchronization of files that have
change as different attributes. If this feature has been selected, a Source
synchronization file whose attributes do not match the Target will still be
criteria included in the synchronization process.

Notes:

1. This option is not supported for Jobs using FTP source or target.

2. By default this option only works during scans. Use the /LA command line
argument if you wish to enable attribute detection in real-time.

1.1.12 Additional Features

—Additional Features

—Additional Options
[~ Enable file recovery

[~ Replace in-use files upon reboot Rebook Cptions. .. |

—Walidation Options
[~ Perform binary comparison on all files (using CRC32)
[ walidate target file (using CRC32) Retry Options. .. |

~File Time Change Cptions

[T During comparison Isubtract j IEI minukels) From target

[T Coreert file times ko GMT Far cormparison between tme zones

[~ After synchrunizatinrlsubtract j IEI minutels) from karget
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- Topics
Additional Options
Validation Options

File Time Change Options

Note: Features listed on this page require the Enhanced Package.

Additional Options

The options on this page can be accessed from the "Additional Features" window,
available only with the Enhanced Package.

Enable file recovery

This enables the file recovery option to continue a file copy
which may have been interrupted. If the Source and Target file
name and date match but the Target file is smaller, PeerSync
will startthe copy operation from the last byte that was sent the
nexttime a sync operation is executed on the folder.

Note: Enable file recovery will be ignored with an ETP._Source or ETP Target.

Replace in-use files
upon reboot

If this feature is selected, once a file is open and locked on the
Target Folder, it will be set to be replaced the next time the
machine is rebooted.

Note: This option is only applicable for Jobs with a local Target Folder.

Reboot Options
Button

This button opens the Reboot Options dialog box. The
default option is "Do not reboot", you may also choose to
"Display rebootdialog"”, or to "Automatically reboot".

Note: Features described on this page require the Enhanced Package.

Validation Options

These settings can be accessed from the "Additional Features" window, available only
with the Enhanced Package.

Perform binary
comparison on all
files (using CRC32)

Option to check all Source and Target files for binary match
during folder scan/compare cycle (using CRC32). This check
ensures that what is on the Target matches the Source at a
binary level.

Validate target file
(using CRC32)

Option to validate file using CRC32 binary comparison after
successful file copy operation. Clicking on the Retry Options...
button opens the Validate File Copy Options dialog box. In
this window you may set PeerSync to continue re-validating a
file a setnumber oftimes.

Retry file copy until CRC of target files is validated
Checking this option will enable the CRC Retry cycle, where, if
a file is not validated, PeerSync will retry the CRC32 validation
xtimes. The defaultretry value is 1.
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Set maximum number of tries to

Specify the number of times PeerSync will perform CRC32
validation on a file if the initial validation fails. The default retry
value is 1.

Note: Features described on this page require the Enhanced Package.

File Time Change Options

These settings can be accessed from the "Additional Features" window, available only
with the Enhanced Package.

During comparison
subtract/add x minute
(s) from target

Option to add or delete time from Target file during folder
comparison. This allows for synchronization of files between
dissimilar time zones or to allow for some time difference
between Source and Target in case Target machine date is
slightly differentfrom Source.

Note: This feature may be ignored during Enhanced Real-Time.

Convertfile times to
GMT for comparison
between time zones

Option to convert file times to GMT for comparison between
time zone differences of the Source and Target folders. This
feature is quite useful way of synchronizing data between
machines located in different parts of the world.

After synchronization
subtract/add x minute
(s) from target

This option can add or delete time from Target file after
synchronization. This allows for synchronization of files
between dissimilar time zones, or to allow for some time
difference between Source and Target in case Target
machine date is slightly differentfrom Source.

Note: Features described on this page require the Enhanced Package.
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1.1.13 Exceptions

—Exceptions

~Inchide Files

F ko
~Exclude Files
|3, b =l _I
Exclude Folders
l e

—Selected File Dates

|Llse all dates _I

Exclude File Sizes

Less than; IU bytes Greater than: |0 bykes
—Include Atkributes xclude Atkributes
|Default | |Default |

= Topics
Exceptions Overview
Include Files
Exclude Files
Exclude Folders
Exclude File by Size

Exclude Files by Attributes
Exclude Selected File Dates

The Exceptions screen is used after you have selected a Job or Multiple Jobs from the
Profile Job List and then created an associated Source and Target Folder on the Folder
Selection screen. Through Exception options, PeerSync allows you to selectively apply
synchronization to files contained within the Source Folder according to a wide range of
explicit criteria.

Include Files

The options on this page can be accessed from the Exceptions window.

Include Files Use this field to determine which file types will be included as
partof synchronization. File Type Inclusions are specified by a
star command followed by the file extension (i.e. *.doc). You
can also specify specific file names and/or sub strings using
the * wildcard character.

The default setting * includes all files.

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved



PeerSync Help 84

Multiple Inclusions can be used and are semicolon delimited (i.
e.*.doc;*.txt;*.exe).

Inclusions are notcase sensitive, (i.e."A" ="a").

Exampl*.doc - includes any file ending with the extension .
es doc
docs - includes any file thatcontains the string docs
copy* - includes any file starting with the string copy

file; - includes any file containing the strings file or
data; data

You may also use the ? wildcard character to further narrow
down yourinclusions. The ? wildcard character can be used to
substitute any single character in the file name including
numbers.

Exampl????.* -includes files thathave extensions and

es contain only 4 characters in the name
June? -includes files thathave extensions, start with
???.* the word June, and are followed by 4

characters
?? -includes files that have the characters ne in
ne??? the 3rd and 4 th positions followed by atleast4
?* characters

Inclusions can be typed manually, or can be specified using
either the Include File Types button ordrop-down listlocated to
the right of the field.

Include Files Button

Opens an "Exceptions" dialog box into which file extensions
may be entered. The "include all files" command * will be
shown by default.

To add an extension, click "New." Next, type the desired
extension into the field located at the bottom of the dialog.
Repeat this process for each desired file type. Inclusions can
be deleted by selecting them from the list and clicking the
"Delete" key at the bottom of the dialog box. Once you have
finished, click the "OK" button. The dialog will close and all of
the Inclusions you have specified will automatically appear in
the Include File Types field in the proper format (separated by
semi-colons).

The drop-down list located to the right of this field will be
dynamically populated with Inclusions as they are set through
the "Exceptions" dialog described above. They are also
added to the list when you exit the field after manually editing
the Include File Types field. Inclusions can then be specified
by selecting them from this list. This provides a way to store
and/or retrieve sets of Inclusions for later use with other Jobs.
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Exclude Files

The options on this page can be accessed from the Exceptions window.

Exclude Files

Through this field, files can be selectively excluded from
synchronization using sub strings or using wild cards.
Exclusions are set by specifying individual characters (i.e. ™),
sets of characters (i.e. copy*), or file extensions (i.e. *.tmp)
which, if found within a file name, will exclude that file from
synchronization.

Multiple characters and strings can be used and are
semicolon delimited (i.e. ™ ;*.tmp;copy®)

These settings are notcase sensitive, (i.e."A" ="a")

Exampl™ - excludes any file containing the character ™
es
tmp  -excludes any file that contains the string tmp
copy* -excludes any file starting with the string copy
*tmp -excludes any file ending with the extension .
tmp
.tmp;. -excludes any file bearing the strings .tmp, .
bak;™ bak orthe character™

You may also use the ? wildcard character to further narrow
down your exclusions. The ? wildcard character can be used
to substitute any single character in the file name including
numbers.

Exampl*tmp? -excludes all files that contain the string tmp
es <. followed by atleastone character before the
extension

Exclusions can be typed manually, or can be specified using
eitherthe Exclude Files Button or drop-down list located to the
right of the field.

Exclude Files Button

Opens a dialog box into which Exclusions may be entered.

To add an Exclusion click "New," then type the desired
character or string into the field located at the bottom of the
dialog. Repeat this process for each Exclusion. Entries can be
deleted by selecting them from the listand clicking the "Delete"
key atthe bottom of the box. Once you have finished, click the
"OK" button. The box will close and all of the Exclusions you
have specified will automatically appear in the Exclude Files
field.

The drop-down list located to the right of this field will be
dynamically populated with Exclusions as they are set through
the dialog box described above. They are also added to the
list when you exit the field after manually editing the Exclude
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Files field. Exclusions can then be specified by selecting them
from this list. This provides a way to store and/or retrieve sets
of Exclusions for later use with other Jobs.

Exclude Folders

The options on this page can be accessed from the Exceptions window.

Exclude Folders

Use this field to exclude folders from synchronization by
specifying a folder name in file path format, (i.e. \TEMP\ or C:
\WINDOWS\). These examples will exclude any folder path
that contains these strings including sub-folders.

If you wish to exclude only a specific or root folder such as "C:
\WINDOWS\" but include sub-folders you mustinclude a "#"
in front of the complete folder path (i.e. "#C:\WINDOWS\").
This example will exclude any files in this directory but include
any files in its sub-folders. A semicolon separates multiple
folder exclusions.

If you wish to exclude multiple folders that contain the same
string do notinclude the "\" atthe end of the folder exclude (i.e.
\Docs).

These settings are notcase sensitive, (i.e."A"="a")

Exampl\Docs -excludes files and sub-folderin folders

es starting with Docs (i.e. Docs, Docs1, DocsA,
etc.)
\Docs -excludes files and sub-folderin folders named
\ Docs
C: - excludes files and sub-folder in the folder C:

\Docs \Docs\

\

#C: -excludes files in the folder C:\Docs\ but
\Docs includes files in its sub-folders

\

Exclusions can be typed manually, or can be specified using
either the Exclude Folders Button or drop-down list located to
the right of the field.

Exclude Folders
Button

Opens a dialog box into which Folder Exclusions may be
entered.

To add an Exclusion, click "New," then type the desired folder
name into the field located at the bottom of the dialog. Repeat
this process for each Exclusion. Entries can be deleted by
selecting them from the list and clicking the "Delete" key at the
bottom of the box. Once you have finished, click the "OK"
button. The box will close and all of the Exclusions you have
specified will automatically appearin the Exclude Folders field.
The drop-down list located to the right of this field will be
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dynamically populated with Exclusions as they are added.
Exclusions can then be specified by selecting them from this
list. This provides a way to store and/or retrieve sets of
Exclusions for later use with other Jobs.

Exclude empty source
folders

This feature will exclude and will not sync empty Source
Folders to the Target.

Exclude File by Size

The options on this page can be accessed from the Exceptions window.

Exclude File Sizes

Use the "Less Than" or " Greater Than" fields to exclude files
based ontheir size in bytes. Zero, by default, includes all files.

Include Files by Date

The options on this page can be accessed from the Exceptions window.

Selected File Dates

Use this field to specify files set for synchronization according
to their date stamp. The default setting includes all file dates.
Clicking the button to the right of this field opens a "Select File
Dates" screen. This screen allows you to include all files,
include files more than x days old, include files bearing the
currentand past x day's date, or specify a range of the dates.
The Set Today's Date button automatically updates the
existing range to reflectthe currentday.

Include Files by Attributes

The options on this page can be accessed from the Exceptions window.

Current Attributes

This field displays "Default' or "Customized" to indicate
whether the default attributes have been changed. Clicking the
button to the right of this field opens a window from which file/
folder attributes may be included. All attributes are selected by
default. Uncheck the file/folder attributes you do not wish to be
used as criteria for synchronization.

Exclude Files by Attributes

The options on this page can be accessed from the Exceptions window.

Current Attributes

This field displays "Default' or "Customized" to indicate
whether the default attributes have been changed. Clicking the
button to the right of this field opens a window from which file/
folder attributes may be excluded. All attributes are unchecked
by default. Select the file/folder attributes you wish to be used
as criteria for exclusion.
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1.1.14 Reporting

—Reporting
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-l Topics
Reporting Overview
Report File Content
Log File Size/Content
SNMP Options

Reporting

The options listed on this page can be accessed from the Reporting window. PeerSync
automatically generates Log Files providing a detailed history of all synchronization
events. This screenis used to view Log Files and set their reporting characteristics.

Use Log File

This feature enables or disables Log file generation. The
default file, PeerSync.Log, is located in the path in which
PeerSync has been installed. This field also supports FEile/
Folder Path Variables and when used the current path will be
displayed above the field.

Overwrite Existing

Use this feature to report only the most recent PeerSync

Log File activity in the Log File. If this feature is not selected, all
PeerSync processes will be reported in succession.
View Log File This button allows you to view Log reports by opening the file in

a text editor.

Clear Log File

This button allows you to clear Log reports.

Reporting File Content

The options listed on this page can be accessed from the Reporting window. Using the
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check boxes provided in this section of the Reporting screen, you can specify what will be
reported in the Log File. The Default setting is to include all items except Folder Names.

Added Files This feature adds an entry for any file that has been added to
the Target.

File Date Includes date associated with each file contained in the Log.

File Size Includes size of each file contained in the Log.

Updated Files

This feature adds an entry for any file that has been updated
inthe Target.

File Time

Includes time associated with each file contained in the Log.

Transfer Time

Includes time ittakes to transfer the file in milliseconds.

Summary

Appends a summary of activity to the end of the report.

Folder Names

Indicates the names of synchronized folders.

Folder Creation

This feature creates an entry for any folders thatdid not existin
the Target and had to be created during the synchronization
process.

Messages This feature logs any messages or application errors found
during synchronization.

Exceptions This feature logs any file/folder exclusion found during
synchronization.

ACLs This feature logs any file/folder ACL updates during scans

and real-time.

Note: Application erors are additionally written to a file called "PS Enor.log," regardless of whether or not that

option has been selected.

Log File Size/Content

The options listed on this page can be accessed from the Reporting window.

Setthe maximum log
file size to x bytes

By entering an amount into this field you can limit the size of
Log Files created by PeerSync. When this limit is reached, the
next reporting session will first rename the existing file to
FILENAME .BAK1.Log and then create a new, blank Log File to
which subsequent data will be added. Two backups
FILENAME.BAK1.Log and FILENAME.BAK2.Log will be kept
for each unique Log file.

Unicode content

This option will enable the reporting of Unicode content.

SNMP Options

The options listed on this page can be accessed from the Reporting window, available
only with the Enhanced Package.
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Use SNMP reporting
(errors only)

Use Simple Network Management Protocol error reporting.

SNMP Options Button

This button opens the SNMP Options dialog box. Once this
box has opened, it allows you to select the Destination IP and
Trap Prefix to be used for SNMP reporting. Please referto your
SNMP management software for more details.

Note: To properly use the installed mib file you need to rename the
psi_def.mib to psi.mib.

Note: Features described on this page require the Enhanced Package.

1.1.15 Admin Reporting

—Admin Reporting

—Repart File Content

v Create administrative repart Files
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Advanced Settings. .. I

- Topics

Admin Reporting Overview

Report File Content

ReportFile Name
ReportFile Path

Admin Report Cycle Options

Advanced Settings

Admin Reporting

The options listed on this page can be accessed from the Admin Reporting window. T his
screen allows you to create a unique report for administration purposes. Admin Reports
generated during sync operations can be saved to a specific administrative folder (in a
local or network path). Admin Reports are made uniquely identifiable through a choice of
naming conventions, (i.e. Computer Name or User Name with date\time stamps).
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Create administrative
report files

This feature enables or disables the Administrative Reporting
feature.

Note: Admin reporting files do not display Unicode characters.

Report File Content

The options listed on this page can be accessed from the Admin Reporting window.

Summary/Messages
only

Appends a summary of activity to the end of the report. This
option will also log messages.

Standard reportfile
content

This feature directs Report content to follow those conventions
also utilized in PeerSync Log Files.

Messages only

Only reports messages and application errors.

Note: When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if

summary is selected.

Report File Name

The options listed on this page can be accessed from the Admin Reporting window.

Report file name

Allows you to choose between a "Local Computer" or
"Logged-On User" Administrative Report. The reports will bear
the selected name as a prefix, followed by the created date
and time of the Report (ie. COMPUTER-
111507172625011_00001.RPT).

Report File Path

The options listed on this page can be accessed from the Admin Reporting window.

Reportfile path

This field displays the location of Admin Report files. This field
also supports Eile/Folder Path Variables and when used the
current path will be displayed above the field.

Admin Report Cycle Options

The options listed on this page can be accessed from the Admin Reporting window.

Create a report for
every event

This option allows fora report to be generated on every event
(Add/Update/Delete/Message).

Create a reporton an
interval

This option allows for a report to be generated at a specific
interval. You may specify the interval from the input field to the
right of this option.

Create a reportonce
a day

This option allows for a report to be generated once a day.
You may specify the time of the day from the input field to the
right of this option.
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Create a reportonce | This option allows for a reportto be generated once a week.
a week You may specify the day of the week from the drop down list to
the right of this option.

Only use Advanced This option allows for a report to be generated based on the
Settings configuration of the Advanced Settings only.

Advanced Settings

The options listed on this page can be accessed on the "Advanced Settings" button from
the Admin Reporting window.

At the start of this This option allows for a report to be created at the start of the
Profile Profile.

At the stop of this This option allows for a report to be created at the stop of the
Profile Profile.

For each individual This option allows for a reportto be created foreach error.
error message as it

occurs

After each scan (log This option allows for a report to be created once a day. You

all non-scan events may specify the time of the day from the inputfield to the right of
on the cycle this option.

specified)

After each scan/cycle | This option allows for a report to be created after each scan
even if no events even when no events occurred.

occurred

1.1.16 E-mail Reporting

—Email Reparking
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- Topics
E-Mail Reporting Overview
ReportFile Content
ReportFile Name
Email Configuration
Email Report Cycle Options

E-Mail Reporting

The options listed on this page can be accessed from the E-Mail Reporting window. T his
screen allows you to create a unique report for administration purposes. E-mail Reports
generated during sync operations can be sent to an administrator, shared mailbox or a
specified user. E-mail notification of synchronization activity can be sent upon completion
of entire Profile or during persistent synchronization operations. E-mail Reports are made
uniquely identifiable through a choice of naming conventions, (i.e. Computer Name or User
Name with date\time stamps).

Create administrative | This feature enables ordisables the E-mail Reporting feature.
E-mail messages

Note: E-mail reporting messages do not display Unicode characters.

Report File Content

The options listed on this page can be accessed from the E-Mail Reporting window.

Summary/Messages | Appends a summary of activity to the end of the report. This
only option will also log messages.

Standard report file This feature directs Report content to follow those conventions
content also utilized in PeerSync Log Files.

Messages only Only reports messages and application errors.

Note: When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if
summary is selected.

Report File Name

The options listed on this page can be accessed from the E-Mail Reporting window.

Report file name Allows you to choose between a "Local Computer" or
"Logged-On User" Administrative Report. The e-mails will bear
the selected name as part of the Subject filed. For example:
"PeerSync Summary Report for COMPUTER (PeerSync
Started)".

E-mail Configuration

The options listed on this page can be accessed by clicking on the "Email Configuration"
button from the E-Mail Reporting window.
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Attach log files

Allows you to attach the reporting section log file to e-mails
generated by this application.

Delete
successful send

after

Deletes the log file after a successful e-mail attached send.

Button

E-mail Configuration

This button opens the Email Configuration dialog box:
Once this box has opened, it allows you to select the SMTP
Host, User ID, Port, who to send to, and who to send Carbon
Copies to and what e-mail address to send from.

SMTP Host
The hostname or IP address of the SMTP mail server to send
alertemails to.

User ID
The username to authenticate with the SMTP mail server. This
is normally notneeded. (Optional)

Port
TCP/IP connection port. It is recommended that you leave the
default setting unless your email server requires otherwise.

To

The email address of the person who is to receive the email.
This user sometimes needs to be a valid user on the SMTP
mail server. You may add multiple email addresses in this
field. Use a semicolon (;) as a delimiter.

CcC

The email address of the person who is to receive a Carbon
Copy of the email. You may add multiple email addresses in
this field. Use a semicolon (;) as a delimiter.

From

The email address that will appear in the From field of the
email. This e-mail does not need to be a valid e-mail. For
example itcan be used to identify the Job that generated the e-
mail by using the %JobName% variable (i.e. %JobName%
@MyCompany.com).

Send Test Email

Clicking on the Test Connection button will send a test email to
the configured email address(es) and letyou know if PeerSync
was able to successfully connect and send an email via the
configured SMTP mail server. It is highly recommended that
you testthe configuration before saving the options.

E-mail Report Cycle Options

The options listed on this page can be accessed from the E-Mail Reporting window.

Create a report for

This option allows for an E-mail to be sent on every event
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every event

(Add/Update/Delete/Message)

Create a reporton an
interval

This option allows for an E-mail to be sentata specific interval.
You may specify the interval from the input field to the right of
this option.

Create a reportonce
a day

This option allows for an E-mail to be sent once a day. You
may specify the time ofthe day from the inputfield to the right of
this option.

Create a reportonce
a week

This option allows for an E-mail to be sent once a week. You
may specify the day of the week from the drop down list to the
right of this option.

Only use Advanced
Settings

This option allows for an E-mail to be sent based on the
configuration of the Advanced Settings only.

Send E-mail Reports

The options listed on this page can be accessed by clicking on the "Advanced Settings"
button on the E-Mail Reporting window.

At the start of this
Profile

This option allows for an E-mail to be sent on every event
(Add/Update/Delete/Message).

At the stop of this
Profile

This option allows for an E-mail to be sentata specific interval.
You may specify the interval from the input field to the right of
this option.

For each individual
error message as it
occurs

This option allows for an E-mail to be sentata specific interval.
You may specify the interval from the input field to the right of
this option.

After each scan (send
all non-scan events
on the cycle
specified)

This option allows for an E-mail to be sent once a day. You
may specify the time of the day from the inputfield to the right of
this option.

After each scan/cycle
even if no events
occurred

This option allows for an E-mail to be sent after each scan
even when no events occurred.

E-mail Report Content

The options listed on this page can be accessed by clicking on the "Advanced Settings"
button on the E-Mail Reporting window.

Send contentin the
body of the E-mail

This option will write the content for the email report into the
body ofthe e-mail.

Send contentas an
attachment to the E-
mail

This option will generate a file with the content of the e-mail
reportand attach the file to the e-mail.

Place contentin a file

This option will generate a file with the content of the e-mail
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and send a link in the |reportand a link to the file will be sent within the body of the e-
E-mail mail.

1.1.17 Compression

_Ompressian
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- Topics
Compression Overview
Compression Options

Compress/Expand
Compression File Extension

Compression Speed
Password-Encryption

While compressing your choice of folders, the Compression utility also employs a unique
method to minimize file damage. While creating Target directory structures to match those
found in the Source, the folder compression option creates a single file for every folder
contained within the Target Folder set. This minimizes the amount of data added to each
compressed file. If a single file were used for the entire directory structure were to become
corrupt, all files might be lost. PeerSync's "one file per folder" scenario ensures that if
damage occurs, itis limited to individual folders only. We also offer file compression, which
will compress the Source Files to the corresponding Target Files down to the file level which
adds even more flexibility.

During folder compression, all selected Source Files are synchronized to the compressed
Target Folder file bearing the name of the active folder plus the user selected extension
(defaultextension is "ZIP").

During file compression, all selected Source Files are synchronized to the compressed
TargetFolder file bearing the name of the active file plus the user selected extension (default
extensionis "ZIP").
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Compressed folderfiles can be expanded using most PKZip compatible extraction utilities. In
addition, passwords can be specified and entered on this screen to protect against
unauthorized access to compressed files.

Compression Options

The options listed on this page can be accessed from the Compression window.

Use folder This check box enables or disables the folder compression
compression feature which will compress files in each sub-folder to a single
file per sub-folder.

Notes:
1. Folder Compression may be ignored when using an FTP_Source or FTP
Target.

2. Bidirectional, Transfer NT security descriptions (ACLs), Move unmatched
target files, Force target file attribute settings, Use intermediate file_during_copy
and Reuvisioning, as well as, other non applicable features may be ignored
when using Folder Compression.

Use file compression | This check box enables or disables the file compression
feature will compress file by file.

Notes:
1. File Compression may be ignored when using an FTP Source.

2. Bidirectional, Transfer NT security descriptions (ACLs) and Move
unmatched Target Files, as well as, other non applicable features may be
ignored when using Folder Compression.

Compress/Expand

The options listed on this page can be accessed from the Compression window.

Compress target Selecting this feature enables compression of the Target
Folder.
Expand source This feature extracts (expands) the Source folder. Use this

feature to extract files from Source Folders that have already
undergone compression.

Note: This option is not supported when using a TCP target.

Note: A compressed Source Folder can not be synchronized to a compressed Target Folder.

Compression File Extension

The options listed on this page can be accessed from the Compression window.

Compressed File The extension entered into this field will be applied to the
Extension compressed folder file name. For example, if "rar" is entered
for a folder named "Samples," the compressed folder file
name willbe "Samples.rar."
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Note: itis NOT necessary to add a period (" . ") before this extension name. The default extension is "ZIP," which
associates the file with a Zip application (i.e. WinZip).

Compression Speed

The options listed on this page can be accessed from the Compression window.

Compression Speed

This setting allows you to set the compression speed and
level of compression. You may choose from "Normal"
compression, "Maximum" compression or "Maximum speed".

Encryption

The options listed on this page can be accessed from the Compression window.

Password
Encryption

The password entered into this field will be used as a key to
encrypt the compressed files. Without this key the original file
CAN NOT be extracted from the compressed files. Do Not
Lose This Password. Without it you will not have access to
your encrypted files, nor will Peer Software be able to recover
them.

Change Password

Selecting this button will display the Password Change
dialog box. This allows you to change your existing password
for the selected Job. This box requires you to enter your old
password in addition to whichever new one you wish to begin
using. This dialog boxis also used to create a password if you
do notcurrently have one. The password will be encrypted and
saved for the selected Job.

Note: You may only change the password for a single Job at a time. The old password must be checked against
the stored password for this feature to be changed.
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1.1.18 Pre/Post Process

—Pre/Post Process

Before

Select Application)Script ko Run Beforefafter Selected Job

After
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W | Use a maximum wait bme af IE.IZI seconds

- Topics

Pre/Post Process Overview

Pre/Post Process

The options listed on this page can be accessed from the Pre/Post Process window. This
screen allows the user to choose external applications / scripts to be run before and after
the processing ofa given Job.

Before

Use this field to specify (by file path) which application or script
you would like to run before processing a Profile. File paths
can be manually entered, or the open folder icon can be used
to locate files. You may also use pre defined configuration
commands. See our support page for a list of available
options.

After

Use this field to specify (by file path) which application or script
you would like to run after processing a Profile. File paths can
be manually entered, or the open folder icon can be used to
locate files. You may also use pre defined configuration
commands. See our support page for a list of available
options.

Wait for application to
end before continuing

Check this feature if you want PeerSync to wait for the
applications specified in the "Before" and "After" fields to close
before processing additional tasks.

Use maximum wait
time of x seconds

Selecting this feature sets a limit (in seconds) for how long
PeerSync will wait for the applications specified in the "Run
Before" and "Run After" fields to close. In order to activate this
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function, the "Wait for Application to Terminate" function must
be checked. The default, when this feature is not checked, is to
waitindefinitely.

1.2 Advanced Options

—Advanced Options

v Migrate Shares

IMatch Shares: Add, Update and Delete j I

Copy shares within the source Folder to the relative target Folder, where non-matching
shares within the target folder are removed,

ralobal Migrate Shares Options (Faor All Jobs with Migrate Shares Enabled)

¥ Process Migrate Shares after each scan

[~ Process Migrate Shares every |12III minutels)

ralobal Advanced File ¥fer Options (For All Jobs)
[~ Adrmin Backup (i.e. Files that are denied access because of the current ACL setkings)

[~ Advanced Backup (i.e, Reparse Points, Sparse, COffline, Stub Files, st

[~ Alternate Data Stream (A05) Backup

- Advanced Options
Migrate Shares

Global Migrate Shares Options

Global Advanced File Xfer Options

1.2.1 Migrate Shares

Migrate Shares

The following settings can be accessed from the Advanced Options window.

Add Shares: Do Not
Update or Delete

Copy shares from the source folder to the relative target folder,
where non-matching shares within the target folder are left on
the target.

Match Shares: Add,
Update and Delete

Copy shares from the source folder to the relative target folder,
where non-matching shares within the target folder are
removed.

Replace Shares: Add
and Overwrite

Copy shares from the source folder to the relative target folder,
where existing matching shares on the target system are
overwritten.

Add Shares with the
selected Prefix

Copy shares from the source folder to the relative target folder,
with the selected prefix.

Add Shares with the

Copy shares from the source folder to the relative target folder,
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selected Suffix with the selected prefix.

1.2.2 Global Migrate Shares Options

Retry Open and Inaccessible Files

The following settings can be accessed from the Advanced Options window.

Process Migrate If the Migrate Shares option is checked, this setting will
Shares after each process the selected share migration setting after each scan.
scan

Process Migrate If the Migrate Shares option is checked, this setting will
Shares every x process the selected share migration setting every x minutes.
minute(s)

1.2.3 Global Advanced File Xfer Options

Retry Open and Inaccessible Files

The following settings can be accessed from the Advanced Options window.

Admin Backup Provides the ability to replicate files and folders that are denied
access because of their current ACL settings.

Advanced Backup Select this option to replicate files such as Symantec
Enterprise Vault stub files or files/folders which may be Reparse
Points, Sparse, Offline, Stub Files, etc.

Alternate Data Replicate hidden Alternate Data Streams (ADS) which may be
Stream (ADS) Backup | stored behind a filename.

1.3 PeerSync Global Settings

—Peersync Global Sektings

The Global Settings section contains Features that apply
ko the entire Prafile (all selected Jobs),

Fallowing is a lisk aof Global Settings that can also be Found on ather screens:

Global Recovery (OFfline Opkions

Global Performance Opkions

Global ACL Cptions

Global Bi-directional Options

Global Managed Files Options

Current Command Line Argument Seleckion
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- PeerSync Global Settings

Global Recovery/Offline Options
Global Performance Options

Global ACL Options

Global Bi-directional Options

Global Managed Files Options
Current Command Line Argument Selection

Options/Commands

1.3.1 Global Recovery/Offline Options

menu.

Retry Open and Inaccessible Files

The following settings can be accessed from the Global Settings window. Alternatively you
can access them from the Options >"Global Settings" > "Global Recovery/Offline Options"

Retry open/
inaccessible files
every x seconds

Use this feature to specify, in seconds, how often PeerSync will
attempt to synchronize Source Files that are in use. If the
"Include open files" option on the File Options screen has not
been checked and "Retry" is selected, PeerSync will continue
attempting to synchronize files that are opened by other
applications. "Retry" will also work when "Include open files"
has been checked and a file is read-locked by another
application. When the "Retry" option is on, PeerSync will
synchronize the open file within x seconds after the file has
been closed.

Set maximum number
of retries to x

This feature sets a limitindicating how many times to attempt to
process open files. If the maximum number of retries gets
exceeded for a particular file PeerSync will remove it from the
retry-list until another real-time event occurs on the file or a
scan detects that the file needs to be added/updated. Setting
the retry cycle to 0 will check the file indefinitely.

Failed Connection Options

The following settings can be accessed from the Global Settings window. Alternatively you
can access them from the Options >"Global Settings" >"Global Recovery/Offline Options"

menu.
Retry failed PeerSync monitors persistent Jobs (Real-Time, scheduled,
connections every x interval) for connectivity, and suspends the Job until a
minutes connection is resumed. This allows PeerSync to ensure that

synchronizations are only attempted when a connection exists.
This feature is set by default to a 1 minute interval and can be
modified ordisabled.

Run a scanon
reconnect (if needed)

This feature will initiate a full scan at reconnect to process any
file/folder changes which may have occurred during the
connection failure. A scan will be performed only if a failure
occurs in the middle of scan or if a scan was missed when the

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved



103 PeerSync Help

connection was lost.

Store missed events
and process on
reconnect

This feature pertains to any Job running in a Real-Time mode.
Having this option enabled will store Real-Time events during
failed connections and will process these events at
Reconnect, eliminating the Source/Target Folder scan.

Note: These settings are Global. Global Settings are global to the cument Profile. These settings and options pertain
to all of the Jobs in the cumrent Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

1.3.2 Global Performance Options

information on this topic.

Global Performance Options

The options listed on this page can be accessed by clicking on the "Global Performance
Options" link on the PeerSync Global Settings window as well as the Options/Commands
window and the Options menu. Please visit Global Performance Options for more

Set Application
Priority

If this feature is selected, anicon willappear on the system tray
when PeerSync is loaded. When you right/click on this icon a
menu will appear. Through this menu the Profiler can be shown,
the About PeerSync screen can be accessed, and PeerSync
can be terminated. Once this dialog has opened, it gives you
the ability to Set the Application Priority allowing PeerSync to
run ata higher orlower priority then other applications.

Use Multiple Job
Threads / Set
maximum number of
Job threads to x (Multi

Threading)

This option is accessible with the Multi-Threading add-on
module available for the Server version of PeerSync only.
Enable this option to allow multiple Job threads to be used for
parallel processing of Jobs. Without this feature each Job will
run sequentially in the order itis listed, scheduled to run, or in
the orderthatevents are received.

Use Multiple Copy
Threads / Set
maximum number of
Copy threads to x (

Multi Threading)

This option is accessible with the Multi-Threading add-on
module available for the Server version of PeerSync only.
Enable this option to allow multiple Copy Threads to copy
multiple files in parallel processes (i.e. Simultaneous
Distribution - Synchronizing from one server to multiple servers
simultaneously ina Web Farm type environment).

Use Enhanced Event
Processing

This option provides the ability to parallel process real-time,
retry or any other non-scan events. Enabling this feature will
improve the speed of synchronization during real-time or any
other non-scanning scenarios.

Exclude Common Job
Exceptions in Event
Processing

This option checks the global exclusions list before file hits
such as before event processing and before adding the event
to the visual list The command line argument for this option is /[

OR.
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Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the cumrent Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

2. Some features described on this page require the Multi Threading, Option. Please visit http:// www.peersoftware.
com or contact Sales for additional information.

3. Using Multiple Job Threads will produce a different file output format for all modes of reporting and message
logging (Reporting, Admin Reporting and E-mail Reporting). The output will NOT contain a start and stop section
or a summary, each entry will also be initially marked with a date and time stamp. If use summary is selected for
Admin or Email reporting then the standard selection will be used. The reason this is done is due to the fact that
processes will be running in parallel.

4. We have exhaustively tested PeerSync operations using 50 Job threads and 10 Copy threads. Setting your
threads over this limit may lead to potential operational issues. We strongly discourage the use of more then 50
threads, however, you do have the option to exceed this limit by placing a greater than symbol ">" before your
desired thread value (maximum allowed is 200). We recommend you test your setting to ensure PeerSync
continues to operate acceptably in your environment.

5. The Include open files (if possible) option should be used if you are using the Performance Options: Multiple Job
Threads and Multiple Copy Threads.

6. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use
the Set Processor Affinity argument in this scenario.

1.3.3 Global ACL Options

ACL Options

This screenis activated by clicking onthe Global Settings link located to the right of the
ACL Options button in the Miscellaneous window as well as from the PeerSync Global
Settings window or the Options menu. This window has the following features:

Monitor ACL changes | This global feature will enable Real-Time monitoring to detect
during real-time and process ACL changes.

Check for ACL This global feature will validate and apply ACLs during folder
changes during scans | scans.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

2. Folder security checks occur during scans and folder create only.

3. For real-time detection of ACLs for empty folders or folders that contain files for which inheritance is disabled add
the /LG1 option to the command line argument.

4. If you enable or disable Inheritance at the folder level, these changes will only get replicated during a scan.

1.3.4 Global Bi-directional Options

Global Bi-directional Options
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This screenis activated by clicking onthe Global Settings link located to the right of the
Bi-directional option in the Eile Options window as well as from the PeerSync Global
Settings window or the Options menu. This window has the following features:

Always create a This feature will alter the way the Enable bi-directional
super-set during bi- synchronization mode option functions by always creating a
directional super-set of the data on the source and target. In this mode
synchronization folders and files will always be added and notdeleted.

Use enhanced bi- This feature will alter the way the Enable bi-directional
directional synchronization mode option functions by using enhanced
synchronization mode | features to track all fle and folder adds, updates, deletions,
options renames and moves between scan cycles. In this mode,

PeerSync will use a hidden system trigger file within each sub-
folder to store information about the last scan cycle for that sub-
folder. Using this trigger file, PeerSync can determine if a
Folder was added, deleted, renamed or moved since the last
scan.

Note: This feature is not supported when using the Enhanced
Scanning option.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the cumrent Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

2. Please refer to our White Papers page for step-by-step tutorials to achieve real-time or scheduled bi-directional
synchronization.

3. When the "Always create a super-set during bi-directional synchronization" option is NOT selected (i.e. doing
standard or enhanced bi-directional synchronization) we recommend you add /YO- and /QYD:0 to your list of
command_line__arguments. These options will ensure that during standard or enhanced bi-directional
synchronization, deleted files from one side are not re-added by the other side. These arguments should NOT be
used if there are more than two machines involved in a bi-directional synchronization.

1.3.5 Global Managed Files Options

File Manager Interval

By clicking on the Global Settings link from the Managed Files window you will be able to
configure the File Manager Interval option. Alternatively you can access this screen
from theGlobal Settings window or from the Options menu.

PeerSync uses the Volume Shadow Copy Service (VSS) in order to allow synchronization
of open/locked files. In order to enable this feature you will require the Managed Files add-
on module. Developed by Microsoft, VSS is a storage management framework designed
to create a pointin-time copy/snapshot of a volume. This method works well with
applications thatare VSS compliant. VSS does not support Novell NetWare systems.

Run Managed Files By defaultthe Managed Files is set to run on an interval of 120
List Manager every x | minutes. This interval may be changed by simply changing the
minutes interval time. By default, Managed Files will run atthe end of the

initial scan if Scan Job once at start is enabled. Subsequent
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open and locked files detected in real-time or during scans will
be thrown into the Managed Files listto be processed based
on the Managed Files interval.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

2. These options require the VSS add-on module. Please visit http:// www.peersoftware.com or contact Sales for
additional information.

3. The minimum Managed Files interval is 30 minutes.
4. This feature only works for local Source folders and will be ignored with an FTP Source.
5. This feature may be ignored when using an FTP Target in conjunction with File Compression.

6. This feature may be ignored when using Folder Compression.

1.3.6 Current Command Line Arguments

Global Command Line Arguments List

From the Options/Commands window, double-clicking on the "Command Line Arguments"
filed or selecting the button to the right of it will open the Command Line Arguments dialog.
The Command Line Arguments dialog can also be accessed from the PeerSync Global
Settings window as well as from the Options/Commands window or the Options menu.

Command Line In this dialog you can modify, add or delete arguments to be
Arguments used when launching PeerSync through any of the modes
described in the Startup/Service screen or via the Run/View
Current Profile Activity screen. This dialog displays the current
arguments selected for the Profiler and will also allow for the
selection and modification of additional Command Line
Arguments by double-clicking this field or selecting the Current
Arguments Button to the right of the field.

Note: These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the cument Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.
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1.3.7 Options/Commands

—Options/Commands
~Display/Reporting Options - All Jobs
v sShow kray icon Set Access Password., I
v Enable display options Display Options. .. I
v Enable reparting options Feporting Options. .. I

—Perfarmance Options - All Jobs
¥ Use Mulkiple Job Threads - Set maximum number of threads bo: |5

v Use Multiple Copy Threads - Sek maximum number of threads to: |1|:|
v Use Enhanced Event Processing

[ Set Application Priority  High Formal Briotty

rCommand Line Arguments
|,|'M JTO ML LML 060230 YLP fOR MFT:S fMCT: 10 /4 R |

- Topics
Display/Reporting Options
Performance Options
Command Line Arguments

Profiler Options

Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.

Enable Basic Display | This feature will have PeerSync open the Profiler, if it is not
already open, and send status messages to be displayed on

the Run/View PeerSync screen.

Enable Advanced This option activates the Show Advanced Display link at
Display the bottom right comer of the Run/View PeerSync screen.
When this link is clicked, the PeerSync Advanced Display
panel will be shown. The advanced display contains a Jobs
Stats panel on the top and an Advanced Run/View
PeerSync panel at the bottom. The command line argument
to disable this option is /QQ<<.

PeerSync Options (Application Runs Only)

Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.

Display status in This feature will show the PeerSync Status Display dialog
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PeerSync

box during synchronization to view activity, status and other
information while PeerSync is running.

Display status in
PeerSync upon
completion

This feature will have PeerSync pop-up the PeerSync Status
Display dialog at the end of synchronization (only in non-
persistent modes) to view activity, status and other information
upon completion.

Profiler/PeerSync Options

Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options >Global Settings > Display Options menu.

Job Stats This feature allows forthe Jobs Stats panel in the PeerSync
Advanced Display to getupdated. Use /QP to disable this
option via the command line.

Job Scans When enabled, this option adds a Job Scans tab to the

Advanced Run/View PeerSync panel. This table lists
Base/Root, Enhanced/Expanded, and RT/Sub-folder scans
with statistics and progress for all the Jobs or only the selected
Job. The command line argument for this option is /Q8BJ+.

File Copy Progress

This feature will show the progress of a file transfer in the
PeerSync Status Display or the Advanced Run/View
PeerSync panel. This feature requires the Multi-Threading
Option. The command line argument for this option is /QQ.

Historical Data

When enabled, this option adds a Historical Data tab to the
Advanced Run/View PeerSync panel. This tab contains a
subset of data from the PeerSync Jobs Stats panel (Xfer
Rate, Bytes and Event Averages) and is broken down into
total, hourly, daily, and weekly statistics for all the Jobs or only
the selected Job. The command line argumentfor this option is

/Q8BH+.

Observer Display Options

Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options >Global Settings > Display Options menu.

Send status
information to PS
Observer Utility

This will send statistical information about the current Profile to
the PSObserver, ifitis installed/available. This utility allows for
the ability to monitor PeerSync activity across the LAN for the
centralized viewing of all PeerSync activity on the network.

- Related Options
Performance Options

Command Line Arguments
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Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the cumrent Profile and are used to define, configure and execute the launch of Profiles via the

PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

2. Some features described on this page require the Multi Threading, Option. Please visit http:// www.peersoftware.
com or contact Sales for additional information.

2. PeerLock
2.1 PeerLock Job Settings

—PeerLock Job Setkings
Job Settings
[ Include this Job in PeerLock

v &ppend Default File/Folder Exclusions From PeerLock

4 Topics
Peerlock Job Settings Overview

2.1.1 PeerLock Job Settings Overview

PeerLock Job Settings

If you are running PeerlLock v2.0.1 or newer on the same machine as PeerSync you will
now be able to configure PeerlLock directly from the PeerSync Profiler. The following
options allow you to link the selected Job to PeerLock as well as append the PeerSync
exceptions to PeerLock. The options in this window can be accessed from the PeerLock >
Peerlock Job Settings window.

Include this Job in Select this checkbox to automatically add the selected Job to
PeerLock PeerlLock. This option can be enabled automatically when
selecting the Bi-directional setting. In general PeerlLock is used
in a collaboration environment where PeerSync is configured
for real-time bi-directional synchronization.
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Append Default File/ | This optionis enabled by default. When checked, the
Folder Exclusions PeerSync Exception settings (Include Files, Exclude Files, and
from PeerLock Exclude Folders) will be appended to the default/existing list of
Exceptions in PeerLock.

Note: PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e.
9%JserName%, Y%ComputerName%). Custom PeerSync variables such as %JobName% are cumently not supported

and will not work in PeerlLock.

2.2 PeerLock Global Settings

—PeerLock Global Settings

ralobal Setkings - Current Prafile Linked with 1 Jobs

[ Link this Profile to Peerlock

¥ Disable Jobs that are Mot Configured From this Profile  Save Changes in Peerlock

~Related Global Settings

- To view/edit Global Options in PeerLock click here  Global Cpkions

’—Shnw PeerLaock - Version: 3.6.5.0

To show the PeerLock application click here  Show Peerl ock

- Topics
Peerlock Global Settings Overview

2.2.1 PeerLock Global Settings Overview

PeerLock Global Settings

now be able to configure PeerLock directly from the PeerSync Profiler.

be accessed from the PeerLock >PeerLock Global Settings window.

If you are running PeerlLock v2.0.1 or newer on the same machine as PeerSync you will

The following

options allow you to add the selected PeerSync Jobs to PeerLock and launch the
PeerlLock application or Global Options for configuration. The options in this window can

Link this Profiler to If this global setting is enabled, all the Jobs that have the
PeerLock "Include this Job in PeerLock" option selected will be added to
PeerLock. These Jobs in PeerLock willbe managed by
PeerSync and cannotbe edited/removed directly from the
PeerLock interface. Un-checking this option will remove all
PeerSync managed Jobs from the PeerLock interface.
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Disable Jobs that are | Selecting this option then saving the PeerSync Profiler or

Not Configured from clicking on the "Save Changes in PeerLock" link will remove/
this Profiler delete any existing Jobs from the PeerLock configuration. Only
Jobs thatare managed by PeerSync will be maintained.

Save Changes in Click on this link to commityour PeerSync Job/Profile updates
PeerLock to PeerLock. This link becomes available when you make Job
or Profile changes thatneed to be saved and applied to
PeerlLock (i.e. Source/Target path update, Exceptions, ...). This
can be achieved also by clicking on the Save button from the
ToolbarorEile Menu. Ifthere are no Profile updates to be
saved, this link will be unavailable.

Global Options Selecting this link will open the PeerLock Global Options
dialog that contains the configuration settings for all the Jobs in
PeerLock. When the application is terminated/closed this link
will become available.

Show PeerLock Youcanrun PeerLock as an application oras a service.
Clicking on this link will launch the PeerLock interface where
you can start PeerLock to run as an application oras a service.
You can also start/stop the PeerLock service directly from the
PeerLock Run/View window in the PeerSync Profiler.

Through the PeerlLock interface you will be able to view the
files thatare Locked or Released by PeerLock when itis
running as an application. This status information is not
available when PeerlLock is running as a Service. The
PeerLock Jobs thatare managed by PeerSync will be un-
editable. When the application is terminated/closed this link
will become available.

Note: You will need the PSObserver product In order to view the PeerLock
status while running as a service.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile.

2. PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %
UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are curmrently not supported
and will not work in PeerLock.
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3. Startup/Service
3.1 PeerSync Startup/Service

—Run/View Peersync

Frofile: Safasat
Job: A - Mulinds fop Threack Enabied

Mode: Aufomafic and' Raat fima (Farsrtant!

Skark Skop

FPause | Resumel

[¥ Rum as aservice

112

Source: D:l...\FLDR1L3\FLOR 1L4\FLDR1LS\FLOR 1L&YFLDR 7L 7FLDR 10LS FLDR LY,
Target: ...\FLOR1LZ\FLOR ILFFLOR L4 FLDR LS\ FLDR 1 LEYFLDR 7L 7Y FLDR.1 OLEFLOR.SLSY

Foiders: 368 of 476 | A
Files: 3592 of 3592 |
File: SMALLFILED, TET SkiE Filel
Size: 29 KE |
Checked: 8229 Ipdated: 0 Current Jaob Status; Mormal
Exchuded: 0 Added: 7675 Pending Event Status: Pending Ikems (RT Scans
Messages; 2 Deleted: 0 Current Event Status: Running Ikems (BT Scans
Funning Total Transferred: 194,84 ME - 00:00:52
4 Topics

PeerSync Startup/Service Overview

3.1.1 PeerSync Startup/Service Overview

PeerSync Startup/Service Options

The options in this window can be accessed from the "Startup/Service" > PeerSync
Startup/Service window. This screen allows the user to specify whether or not PeerSync
will be run upon startup of the active PC, while also defining its interaction with the network (if
applicable). This screen provides shortcuts for installing PeerSync as a service, adding it
to the Windows StartUp list, or to the Windows registry for automatic loading upon startup.

Disable all Startup
Options

Check this feature to prevent PeerSync from automatically
loading at Windows startup/logon.

Create Shortcuton
Desktop

This button will place the current Profile into a shortcut on your
desktop (See "Scan at Start of Profile List," Options/Command
). A Profile Shortcut will need to be created through this feature
in orderto use PeerSync's Command Line Mode.

Add to Windows
StartUp

This button opens the Windows StartUp folder, showing links to
files and programs that open automatically upon user logon.
This button is only accessible when "Add to Windows Startup
Folder" is checked.

Add to Windows
registry

Check this feature if you want PeerSync to run automatically
when Windows boots through specification in the Windows

registry.
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Run RegEdit

This button opens the Windows Registry Editor. This button is
only accessible when "Add to Windows registry to run at boot"
is checked.

Install as an NT
Service

Check this feature if you want PeerSync to run automatically as
a service under Windows NT. Click here for a Tutorial on how
to install PeerSync to runas an NT Service.

To configure and run the service you must go to "Services"
located in the "Control Panel" and select "PeerSync
Professional Series Software." By default the service is
installed with the "Local System account" selected for the
service "Log on as:" option.

Caution: If any of your Source or Target Folder Selections are not located on
the local machine, then you will have to configure the service to "Log on as:"
an altemate (Domain Admin) account on your domain so that the service has
the rights to access the remote machines and/ or devices. If you do not do this
the service may not run properly.

Notes:

1. If PeerSync is running as a Service it is advised to use UNC paths or
PeerSync's Dynamic_ Network_Drive_Mapping _and__Unmapping feature
instead of using mapped drives do to the fact that mapped drives are not
understood when a user is not logged on.

2. You can add the argument /LSE (Log Service Events to NT Application
Log) to the following entry in the registry
(HKEY_LOCAL_MACHINE\ Software\ PeerSoftware\ PeerSync\ Service\ Par
ameters). This will have PeerSync log all changes to be reported to
application log in addition to the nomal logging of the start, stop, pause and
continue of the service.

3. If PeerSync is running in Real-Time mode as a service, subsequent real-time
Profiles will interfere with service operation and should not be employed.
Both Scheduled Operations and Manual (non-persistent) operations should
perform without interference to a service installation of PeerSync.

Details

This button is used to view the details of the currently installed
PeerSync service.

Remove

This button is used to remove the currently installed PeerSync
service.

Create SNC extension
association for
Profiler

Checking this feature causes any file with the extension .SNC to
be associated with PeerSync: PeerSync Profiles bear this
extension by default. Once this feature has been selected,
double/clicking on any SNC file will open Profiler and load that
particularfile.

Add Quick-Sync
Folder option to
Explorer menu

Checking this feature adds or removes the Quick-Sync Folder
selection from Windows Explorer. This feature is a quick and
easy way to synchronize folder(s) on the fly to backup location
(s) with the option to modify your Job settings ata latertime.

PeerSync Application
Path

This field is used to specify the location of the PeerSync
executable file. You can use the open folder icon to browse
drives in order to locate this executable file.
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Starting Profiles

The following describes ways in which PeerSync can be launched or started.

Toolbar

From the Profiler By using the Launch Profile Menu ltem in the Run Menu
By using the Launch Current Profile button on the Tool Butions

By using the Launch Current Profile button on the Run/View
Current Profile Activity screen

Externally without the | Setup/runfrom a Shortcuton the Desktop
Profiler Setup/run from the Startup Folder

Setup/run atbootfrom the Registry
Setup/runas a NT Service

Setup/run using the Windows Task Scheduler

Notes:

1. Individual Jobs can be synchronized using the 'Synchronize Selected Jobs' feature, found in the Profile Job List

Popup Menu.

2. Another way of running PeerSync is by using the Quick-Sync Folder feature by right-clicking on a folder from MS

Windows Explorer.

3.2 PeerlLock Startup/Service

—Run/view PeerLock;

Path: CHPROGRA~2IPeerLockl3. 6.5 Peerlock, exe
Skatus: Serwice Stopped
Version: 3.6,5.0

Skart | Skop | FPause | Resumel

v Fun as a service

- Topics
Peerlock Startup/Service Overview
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3.2.1 PeerLock Startup/Service Overview

PeerLock Startup/Services Options

If you are running PeerlLock v2.0.1 or newer on the same machine as PeerSync you will
now be able to configure PeerLock directly from the PeerSync Profiler. This window
provides a way in which you can install the PeerLock service directly from the PeerSync
Profiler interface. The options can be accessed from the "Startup/Service" > PeerlLock

Startup/Service window.

Install PeerLock Check this feature if you want PeerLock to run automatically as
Service a service under Windows NT. To configure and run the service
you mustgo to the Services window by clicking on the "Details"
> "Show Services" butiton and select "PeerlLock Utility
Software" item. By default the service is installed with the
"Local System account". If your Source or Target folder is not
located on the local machine, then you will have to configure
the service to "Log on as:" an alternate (Domain Admin)
account on your domain so that the service has the rights to
access the remote machines and/or devices. Otherwise the
service may notrun properly.

Note: It is advised to use UNC paths if you plan to run PeerSync or PeerLock
as a Service do to the fact that mapped drives are not understood when a
user is not logged on.

Details This button is used to view the details of the currently installed
PeerlLock service.

Remove This button is used to remove the currently installed PeerLock
service.
PeerLock Path This field is used to specify the Ilocation of the

PeerSyncPeerLock executable file. You can use the open
folder icon to browse drives in order to locate this executable
file.

Note: PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e.
Y%JserName%, Y%ComputerName%). Custom PeerSync variables such as %JobName% are cumently not supported
and will not work in PeerlLock.
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4. Run/View
4.1 PeerSync Run/View

—Run/View Peersync

Frofile: Safasat
Job: A - Mulinds fop Threack Enabied

Mode: Aufomafic and' Raat fima (Farsrtant!

Skark Skop FPause | Resume I [¥ Rum as aservice

Source: D:l...\FLDR1L3\FLOR 1L4\FLDR1LS\FLOR 1L&YFLDR 7L 7FLDR 10LS FLDR LY,
Target: ...\FLOR1LZ\FLOR ILFFLOR L4 FLDR LS\ FLDR 1 LEYFLDR 7L 7Y FLDR.1 OLEFLOR.SLSY

Foiders: 368 of 476 | A
Files: 3592 of 3592 |
File: SMALLFILED, TET SkiE Filel
Size: 29 KE |
Checked: 8229 Ipdated: 0 Current Jaob Status; Mormal
Exchuded: 0 Added: 7675 Pending Event Status: Pending Ikems (RT Scans
Messages; 2 Deleted: 0 Current Event Status: Running Ikems (BT Scans
Funning Total Transferred: 194,84 ME - 00:00:52
4 Topics
Basic Display

Advanced Display

4.1.1 Basic Display

PeerSync can be run

screen will be shown

Run/View PeerSync - Basic Display

the Startup/Service screen.

This screen is used to launch the current Profile and to view current Profile activity. If the
Display Status in Profiler option is turned on from the Options/Commands screen this

synchronization of the current Profile as the process occurs. This screen will also be shown
upon using the Synchronize Selected Jobs feature, found in the Profile Job List Popup
Menu to display the Current Activity of the Jobs sentto PeerSync as a temporary Profile.

as an Applicationoras an NT Service, ifavailable and installed from

upon execution of a Profile and will dynamically show the status of

Profile Displays the name of the Profile actively being processed.
This label may not match the name of the Profile currently
being configured through Profiler.

Job This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Mode This indicator will dynamically display the name of whichever

Job is presently being processed for the Active Profile.

Launch Current

This button allows you to launch the current Profile. Once a
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Profile/Terminate
Active Profile

Profile has been launched, its processing may also be
terminated through this button (the label will change to read
"Terminate Active Profile"). This button offers one of three
ways to initiate an Automatic Operation.

View Active Profile

This button allows you to connect to and view the Active
Profile.

Run as a service

If PeerSync is installed as a Service you have the option of
running itas an Application or as a Service from this screen.

Start/View Service

This button allows you to start the current Profile as a Service
orview the Active Profile.

Stop Service

This button allows you to stop the current Profile as a Service.

Pause Service

This button allows you to pause the current Profile as a
Service.

Resume Service

This button allows you to resume the current Profile as a
Service.

Source

Displays a file path for the Source Folder presently being
synchronized.

Target

Displays a file path for the Target Folder presently being
synchronized from the Source indicated above.

Folders

This indicator provides a count of all unsynchronized folders
contained within the Source, and will decrease as each folder
is synchronized. An additional "thermometer" indicator will
also track the progress offolder synchronization.

Files

This indicator displays the total number of files contained
within the Source while also providing a count of synchronized
files. In addition, a "thermometer" indicator will show file
synchronization progress by increasing according to the size
of the current folder, with 100% representing the cumulative
size of files contained within the Source Job set.

File

Indicates the name of the file currently being synchronized.

Large File or
Compression Status

This caption will be displayed to the right of the file name that
is currently synchronized for large files and during
compression. The caption will show the size of the file that has
been copied to the Targetand/or compression status.

Skip File

This button will appear once the active Profile has been
launched. This feature allows you to skip synchronization of
the file currently displayed in the indicator described below.
Skip Files enables you to avoid delays caused by large files
on slow network or dial-up connections.

Size

Indicates the size (in bytes) of the file currently being
synchronized. A related "thermometer" indicator tracks the
progress of synchronization for that file.
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Checked This indicator displays the total number of files contained in
the selected Source Folders.

Excluded Indicates the number of files that were excluded from
synchronization (See Exceptions).

Messages Indicates the number of error messages generated during
Profile processing.

Updated Indicates the number of Target Files that were updated during
synchronization of Profile Jobs.

Added Indicates the number of new files added to Target Folders
during synchronization of Profile Jobs.

Deleted Indicates the number of files deleted (or moved) during

synchronization of Profile Jobs.

Current Job Status

This indicator displays the status of the active Job. The
indicator may display one of the following: Blackout, Source/
Target disconnected (Job name), Connecting to Target
Folder (Folder), or Normal.

Pending Event Status

This indicator displays the number of pending items.The
indicator may display one of the following: Pending ltems
(Events: n) (Managed Files: x) or No Pending ltems

Current Event Status

This indicator display the status of the events pertaining to
Job/Copy thread information or Job automation (such as next
scheduled interval, daily timer info etc.). The indicator may
display one of the following: Running ltems (Job Scans: x)
(Copy Threads:y) (Failed Events: 2)

Total Transferred

Indicates the the total amount of bytes transferred for the entire
running Profile.

Elapsed Time

Indicates the amount of time that has elapsed during the
current Profile activity.

Show Advanced/
Normal Display

Click on this link to toggle between the Normal and
Advanced Run/View PeerSync panels.

Refresh

Click on this link to force a manual reload of the Run/View
PeerSync panel and the statistics thatare being displayed.

4.1.2 Advanced Display

Jobs Stats

To see this panel, click on the Show Advanced Display link at the bottom right corner of the
Run/View PeerSync window. The Enable Advanced Display option must be checked in
order for this link to be active. The Jobs Stats display is the top panel and contains runtime
statistics for all the Jobs configured within the Profile. Clicking on a Job will update the
bottom Advanced Run/View PeerSync panel. Click on the All Jobs entry to display all
the Job statistics, cumulatively, in the bottom panel.

#

Represents the automatically assigned Job number for each
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Job. An icon represents the state of the Job (Green, Yellow, or
Red):

Green Running with no failed events

Yello Warning state indicates the Job is running with
w failed events

Red Failed connection and/or offline/stopped

Job Name

Lists the unique name for each Job.

Last Scan (Status:
Duration)

Displays the date and time of the last scan along with a
description of the scan state and duration. For example:
11/17/2011 4:28:31 PM (Completed Successfully: 00:06:05)

Xfer Rate

Determines the transfer rate in megabits per second for each
Job. Takes into account the Event Averages rate and Total
Transferred and Total Saved bytes (bottom right corner of
Run/View PeerSync) to determine the transfer rate for each
Job. The more ewvents and the larger the awerage file size
calculated in the Ewvent Awerages the more accurate the
transfer rate will be. This also shows a cumulative transfer rate
for all Jobs.

Bytes

Displays the total number of bytes that were transferred for the
specific Job or all the Jobs.

Events

Shows the total number of events detected for the Job or all the
Jobs as well as number of active ewvents currently being
processed.

Event Averages

Displays the awerage number of ewvents that occurred per
minute. The average size of the events are also noted.

Failed Events

Total number of failed events for the selected Job or all the
Jobs.

Status

Shows the status of each Job or all Jobs.

Added

Counter indicating the total number of files that were added and
their size in bytes.

Daily Timer Scans

Information when the next scheduled scan is to occur.

Deleted Counter indicating the total number of files that were deleted
and their size in bytes.
Excluded Counter indicating the total number of files that were excluded

and their size in bytes.

Interval Scans

Information when the next interval scan is to occur.

Log File Path

Displays the location of the log file. Used in pop-up menu.

Messages

Counter indicating the total number of messages.

Next Scan (Runin)

Count down to the next scan for scheduled or interval scans.
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Real-Time

Displays the state of Real-Time detection.

Scan Needed

Lets you know if a scan is needed (Yes) or not (No) after a
connection failure.

Souce Displays the source path.
Target Displays the target path.
Updated Counter indicating the total number of files that were updated

and their size in bytes.

Jobs Stats (Right-Click Pop-Up Menu)

To see this menu, right-click on the Job Stats panel.

Select Columns....

Add or remowe columns from the Jobs Stats display.

View Log File View the log file for the selected Job.

View Source Folder: Opens the source folder in a Windows Explorer window.

Path

View Target Folder: Opens the target folder in a Windows Explorer window.

Path

Save As Sawves the current Jobs Stats list into a CSV file format (i.e.

PSJobStats.csv).

Reprocess Failed
Events

If the Job is running in a Warning state (Yellow), the Job has
failed events. Selecting this option will notify PeerSync to re-
process any failed events. This option is also available in the
Run menu.

Advanced Run/View PeerSync

To see this panel, click on the Show Advanced Display link at the bottom right corner of the
Run/View PeerSync window. The Enable Advanced Display option must be checked in
order for this link to be active. The Advanced Run/View PeerSync display is the bottom
screen. In addition to containing the same information as the Basic Display, the Advanced
Display contains the following additional tabs:

Status

Containing the same information as the Basic_Display view/
panel.

Updated

Lists the total number of files that were updated for the
selected Job or all the Jobs. Right-click and select Save As to
export the list into a CSV file format (PSUpdated.csv).

Added

Lists the total number of files that were added for the selected
Job or all the Jobs. Right-click and select Save As to export
the list into a CSV file format (PSAdded.csv).

Deletions

Lists the total number of files that were deleted for the selected
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Job or all the Jobs. Right-click and select Save As to export
the list into a CSV file format (PSDeleted.csv).

Excluded Lists the total number of files that were excluded for the
selected Job or all the Jobs. Right-click and select Save As to
export the list into a CSV file format (PSExcluded.csv).

Messages Lists the total number of messages for the selected Job or all
the Jobs. Right-click and select Save As to export the list into
a CSV file format (PSMessages.csv).

Job Scans Lists how many scans are running at a Job lewvel either for the
selected Job or for all the Jobs. Right-click and select Save As
to export the list into a CSV file format (PSJobScans.csv).

Managed Files List Lists the total number of files that are in the Managed Files
List for the selected Job or all the Jobs. Right-click and select
Save As to export the list into a CSV file format
(PSManagedFilesList.csv).

Failed Events Lists all the failed files for the selected Job or all the Jobs. You
can right-click the list and select Reprocess Failed Events to
notify PeerSync to re-process them for all the Jobs (not Job
specific). To reprocess only a specific file, you can click the
Reprocess Selected button from the Failed Events tab within
the PeerSync Status Display (when running as an application
only). Right-click and select Save As to export the list into a
CSV file format (PSFaileEvents.csv).

File Copy Progress Visually displays the file copy progress for each file for the
selected Job or all the Jobs. Right-click and select Save As to
export the list into a CSV file format (PSFileCopyProgress.csv)

Historical Data This panel displays a subset of the Job Stats table (Xfer Rate,
Bytes and Event Awerages) in an hourly, daily, weekly, and
total format for all the Jobs or only the selected Job.
Furthermore, it displays a Running Event Count, a Running
Event Awverage and Peak Count, and a Running Job Count.
Right-click and select Save As to export the list into a CSV
file format (PSHistoricalData.csv).

Notes:

For efficiency purposes, only when you click on the screens/ tabs within the Advanced Run/View PeerSync
panel will the values get updated. A Cache folder within the PeerSync installation folder maintains the necessary
event files that will be loaded into the advanced display screens/ tabs.
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4.2 PeerLock Run/View

—Run/view PeerLock;

Path: CHPROGRA~2IPeerLockl3. 6.5 Peerlock, exe
Skatus: Serwice Stopped
Version: 3.6,5.0

Skart | Skop | FPause | Resumel v Fun as a service

- Topics
Basic Display
Advanced Display

4.2.1 Basic Display

Run/View PeerLock - Basic Display

If you are running Peerlock v2.0.1 or newer on the same machine as PeerSync you will
now be able to configure PeerlLock directly from the PeerSync Profiler. This window will
allow you to start/stop/pause/resume the PeerLock service. Click here for information on
how to install the PeerLock service or run PeerLock as an application. The following
options can be found in the Startup/Service window.

Launch PeerLock This button allows you to launch the PeerLock application and
monitor the files that are Locked or Released by PeerlLock.
When the application is terminated this button will become
available.

Run as a service This option is available only ifthe PeerLock service has been
installed and the Run as a Service option is enabled. Check
this option to run PeerLock as a Service. When checked, you
will have the options to Start, Stop, Pause and Resume the
Service. Uncheck the "Run as a service" option run PeerLock
as an Application. When this option is uncheck you will have a
"Launch PeerLock" button available.

Start Service This button allows you to start PeerLock as a Service. This
option is available ifthe PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock
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service is stopped or not running.

Stop Service This button allows you to stop the PeerLock Service. This
optionis available ifthe PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerlLock
service is running.

Pause Service This button allows you to pause the PeerLock Service. This
option is available ifthe PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerlLock
service is running.

Resume Service This button allows you to resume the PeerLock Service. This
optionis available ifthe PeerlLock service has been installed,
the Run as a Service option is enabled, and the PeerlLock
service is paused.

Show Advanced/ Click on this link to toggle between the Normal and
Normal Display Advanced Run/View PeerLock panels.
Refresh Click on this link to force a manual reload of the Run/View

PeerLock panel and the statistics thatare being displayed.

4.2.2 Advanced Display

Jobs Stats

To see this panel, click on the Show Advanced Display link at the bottom right corner of

the Run/View PeerLock window. The Enable Advanced Display option must be checked

in order for this link to be active. The Jobs Stats display is the top panel and contains
runtime statistics for all the Jobs configured within the Profile. Clicking on a Job will update
the bottom Advanced Run/View PeerLock panel. Click on the All Jobs entry to display all
the Job statistics, cumulatively, in the bottom panel.

# Represents the automatically assigned Job number for each
Job. An icon represents the state of the Job (Green, Yellow, or
Red):

Green Running with no failed locks

Yello Warning state indicates the Job is running with
w failed locks

Red Failed connection and/or offline/stopped

Job Name Lists the unique name for each Job.

Locks (Active) Represents the total number of locks created by the specific
Job. The total number of locks that are actively being held are
also shown.

Releases Shows the total number of releases created by the specific
Job.

Lock Average Represents the number of locks that are created on awerage
ever minute for the specific Job.
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Release Average

Represents the number of locks that are released on average
ever minute for the specific Job.

Failed Locks Shows the total number of locks that failed to be created for
the specific Job.

Status Displays the status of the Job (i.e. Stopped, Starting and
Normal).

Source The folder which is monitored for open activity.

Target The folder which is contains the files for PeerLock to lock.

Jobs Stats (Right-Click Pop-Up Menu)

Select Columns....

Add or remowe columns from the Jobs Stats display.

View Log File: Path

Open the log file in the default editor for the selected Job.

Open Source Folder:
Path

Opens the source folder in a Windows Explorer window.

Open Target Folder:
Path

Opens the target folder in a Windows Explorer window.

Save As

Sawves the current Jobs Stats list into a CSV file format (i.e.
PLSelectionList.csv).

Advanced Run/View PeerLock

To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View PeerLock window. The Enable Advanced Display option must be checked
in order for this link to be active. The Advanced Run/View PeerLock display is the
bottom screen. In addition to containing the same information as the Basic Display, the
Advanced Display contains the following additional tabs:

Target File Path

Shows the file name complete with folder path for a target file
that is locked, if the file exists and/or can be locked.

Locked

Display the date/time when the target file was locked.

Duration

Displays the amount of time that the source file has been
opened.

Accessed By

The name of the user who has opened the file or accessed the
resource.

Target Access
Allowed

Displays the permissions that are allowed on the opened target
file which are applied by PeerlLock.

Source File Path

Displays the file name complete with folder path for the source
file that has been detected as an open file.
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Job Number Represents the automatically assigned Job number for each
Job.

# Locks Displays the number of locks on the source.

Application Displays the application that has been detected as opening the

source file.

Detection Type

This column represents the PeerLock detection mode used to
detect what source files are locked/opened. This will either be
File Server Mode Detection or Local Detection.

Note: Starting with version 3.0, PeerLock supports File Server
Mode Detection only.

Idle Time

Shows the amount of time the target file will remain locked
once the source file has been released. When the source file is
closed PeerLock will wait the number of Idle Time seconds
specified before releasing the target file. During the Idle Time
period the file entry in the Locked list will be highlighted
Yellow. The Idle Time value can be set in the Release Options
dialog. This feature is intended to protect the releasing of files
during file opens and sawes. Certain applications may
temporary release files during these procedures. With this
feature enabled PeerLock will wait the set period of time to
make sure the file is fully released before unlocking the
corresponding target files

Lock File Handle

Displays the handle value created that is being used to lock
the temporary Lock File created by PeerLock to Interact with
other Peer Software Products. If the Interact features are
disabled then this will display 'None'.

Release Detected

Shows the date and time when PeerlLock detected the source
file was closed. This value will be cleared if the file is reopened

within the Idle period and the target file handle is not released.

Source Access
Allowed

Displays the permissions that are allowed on the opened
source file.

Source Attributes

Shows the attributes of the source file.

Source Handle

Displays the handle value created when the source file was
opened.

Source Modified

Shows the modified date/time of the source file when it was
detected as being open.

Source Open Mode

Displays the permissions that were used to open the source
file.

Target Handle

Display the handle value created that is being used to lock the
target file by PeerlLock.

Target Open Mode

Displays the permissions that were granted when the target file
was locked by PeerLock.

Temporary Releases

Shows the number of times the source file was closed during
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the Idle period.

Notes:

For efficiency purposes, only when you click on the screens/ tabs within the Advanced Run/View PeerLock
panel will the values get updated. A Cache folder within the PeerSync installation folder maintains the necessary
event files that will be loaded into the advanced display screens/ tabs.

Command Line Arguments

PeerSync's Command Line Mode offers users the ability to configure a truly "hands-off"
installation, where operation and distribution occurs from within an easily manageable,
administrative environment. This mode allows Profiles to be executed from logon scripts,
system batch (BAT) or command (CMD) files, detailed shortcuts, and shell commands --
while also providing full access to the Profiler features through command line arguments.

Profiles will need to be created through the Profiler firstin order to be further modified through
the arguments described in this topic (See Profiler Overview and related Help Topics).

Command Line Arguments are entered into a Profile shortcut, created during build through
the "Add to Desktop" button found on Profiler's Startup/Service screen.

Notes:

1. For the command line arguments described in this topic, note that attention is paid to punctuation, to the order in
which arguments are entered, and that appropriate spaces are used to separate these arguments. Follow the
format outlined in the examples provided.

2. Profile .SNC file names are the only command line variables associated with operation of the Profiler. All other
arguments described in this topic are used to configure operation of the PeerSync and its execution of Profiles.

Profiler Command Line Arguments

As noted above, Profile (SNC) file names are the only variables associated with operation
of Profiler. To change an .SNC file name through the command line:

1. Rightclick the Profile shortcut you created during build (see StartUp/Service, "Add to
Desktop" button).

2. Selectthe "Properties" item from the pop-up menu.

3. Selectthe "Shortcut" tab. As shown in the following sample, the "Target" field will contain

a command line for the Profile, where "Profile One" represents a sample Profile name:
"C:\ Program Files\ PeerSync\ PeerSync.exe" " C:\ Program Files\ PeerSync\ Profile One.SNC" /
USEPROFILEARG

4. Manually change the Profile Name to reflect that of the new .SNC file

5. Click the "OK" button

PeerSync Command Line Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e./A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).
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- Topics
Configuration Arguments
FTP Arguments
Performance Arguments
Reporting and Display Arguments
Automation Arguments
Synchronization Arguments
Real-time Arguments
Managed Files Arguments
Bi-directional Arguments

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page may require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will

display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.conm/ support/ support.aspx.

1. Configuration Arguments

Configuration Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e./A /M).

[0:Profile
Set SNC File to Load (Profile = File): Ifthe /0 argumentis used in a shortcut or from
the command line, PeerSync will load the Job information specified in the file.

Examples:

/0:"C:\ My SNC\ MyBackups. Full path to file

snc" Will use install directory

/0:MyBackups.snc Will use install directory (Must be first argument)

MyBackups.snc

[1:source

Set Source Path (source = Folder): Ifthe /1 argumentis used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target
pathfora Job.

Example:
/1:c:\'source /2:c:\target c:\'source to c:\target

[2:target

Set Target Path (target = Folder): Ifthe /1 argumentis used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target
path fora Job.
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Example:
/1:c:\'source /2:c:\target c:\source to c:\target

[C:cfile

Load Alternate Configuration File (cfile = File): If the /C argument is enabled,
PeerSync will use the values specified in cfile for synchronization information instead of
using the default configuration file: PSDef.cfg which is located in the install directory.

Example:

/C:C: Use altemate configuration file
\ PeerSync\ configs\ altconfig.

cfg

[USEPROFILEARG

Use Arguments from Profile: |If the /USEPROFILEARG argument is used in
conjunction with a /0:Profile, PeerSync will use the arguments specified in Profile, for
synchronization. By default, when you create a shortcut on the desktop or in the startup
folder from the StartUp Options screen this argumentis used.

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced_Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will

display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.conm/ support/ support.aspx.

2. FTP Arguments

FTP Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).

/ETPPASSIVE
Force FTP passive mode on: The /[FTPPASSIVE argument forces on the passive
mode option forall Jobs using FTP in a Profile.

/GH :mm-dd-yy

Set FTP Short Date Format: The /GH argument sets the Short Date Format used in
FTP transmission. This feature is necessary if an FTP Server uses a non-standard date
format.

Example: /GH:dd-yy-mm

1GJ:x
Set FTP Failed Upload Retry Count: The /GJ argument sets the number of times
PeerSync will atemptto upload a file afterit has failed.
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Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the FTP add-on module.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will

display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.con/ support/ support.aspx.

3. Performance Arguments

Performance Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e./A /M).

IGE :x

Set Shared Process Delay: The /GE argumentis used to set the shared process
delay to allow more/less CPU utilization. This value ranges from 0 -10 where 0 (less CPU)
will use the mostdelay and 10 (more CPU).will use the leastamountofdelay.

[GK:x

Copy Thread Utilization: Ifthe /GK argument is enabled, PeerSync will allow up to x
threads to watch the queue that manages changes allowing for increased Copy Thread
utilization.

/GP:x
Set Email Threads: Ifthe /GP argumentis enabled, PeerSync will allow up to x threads
to be used for email tasks.

/LK:x

Set Multitasking Delay: The /LK argument is used to adjust the delay during
multitasking. This value may be setbetween 1 and 10 where 10 is the highest amount of
delay and 1is the leastamountof delay. The defaultvalue is 4.

/LN:x

Set Processor Affinity: Ifthe /LN argumentis enabled, PeerSync will allow you to limit
which CPUs to use in a multi-processor environment, where each CPU is represented by 2
to the x value:

/LN:1 =Use CPU 1 /LN:16 =Use CPU 5

/LN:2 =Use CPU 2 /LN:32=Use CPU 6

/LN:4 =Use CPU 3 /LN:64 =Use CPU 7

/LN:8 =Use CPU 4 /LN:128 =Use CPU 8

Examples:

/LN:1 Use CPU 1

/LN:3 Use CPU 1,CPU 2 (/LN:1 +/LN:2 =/LN:3)
/LN:4 Use CPU 3

/LN:5 Use CPU 1,CPU 3 (/LN:1 +/LN:4 =/LN:5)
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/LN:15 Use CPU 1,CPU 2,CPU 3, (/LN:1 +/LN:2+/LN:4 +/LN:8 =/
CPU 4 LN:15)

Note: By default all CPUs will be used.

/MCT :x

Set Copy Threads: Ifthe /MCT argumentis enabled, PeerSync will allow up to x file
copy threads to be spawned for file copy tasks. These copy threads will be shared by one
or more Jobs during the synchronization process.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

IMET :x
Set Job Threads: Ifthe /MFT argument is enabled, PeerSync will allow up to x Job
threads to be spawned for managing Job tasks.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/OPTIMIZE

Optimize Performance: Ifthe /OPTIMIZE argumentis enabled, PeerSync will disable
status screen windows used for outputting status information. This will minimize memory
allocation for the User Interface.

/PERFORMANCE :x
Set Application Priority: Ifthe/PERFORMANCE argumentis enabled, PeerSync will
setthe application's priority based on the following value of x

0: Lowest Priority
1: Below Average Priority
2:High Priority.

Notes:

1. This item is selectable from the Profiler via the Options/ Commands Screen.

2. If the / PERFORMANCE argument is not used, PeerSync will use a default priority.

3. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want
to use the Set Processor Affinity argument in this scenario.

/YK:n

Set Real-time Copy Thread Pool: Used to set the percentage of Copy Threads to
reserve for Real-Time events, where n can be set between the values of 1 and 99. The
defaultvalue is 10.

[YX:n

Set File Read/Write Buffer Delay: Used to seta delay in n milliseconds between
each file read/write cycle to allow the limiting of CPU usage and system resources during
file transfers. The higher the delay value, the less CPU used but the slower the
performance or speed of PeerSync.

/QR

Exclude Common Job Exceptions in Event Processing: Checks the global
exclusions before file hits such as before eventprocessing and before adding the eventto
the visual list.
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Notes:
1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page may require the Enhanced Package or Multi Threading Option. Please visit
http:// www.peersoftware.com or contact Sales for additional information.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.conmy support/ support.aspx.

4. Reporting and Display Arguments

Reporting and Display Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e./A /M).

[AP

Run Pre-Sync Report: If the /AP argument is used a Pre-Sync Report will be
generated and files/folders will not be synchronized. If you add an O to the /AP then the
previous Pre-Sync report will be Over written, if you exclude the O then the file will be
appended to an existing Pre-Sync report. If you add an S to the /AP then the Pre-Sync
reportwill be Shown atthe end ofthe run (i.e../AP, /APO, /APOS or/APS).

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/GL[S

Display status in Profiler: Ifthe /GL argumentis used, PeerSync will open the Profiler,
if it is not already open, and send status messages to be displayed on the Run/View
Current Profile_Activity screen using mail slot messaging to communicate with the Profiler.
By adding an S you can suppress the initial connection of PeerSync to the Profiler upon
activation of PeerSync.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/GM:x
Enable MSMQ messaging: Ifthe /GM argumentis used, PeerSync will use x as the
location to manage messages in the queue.

Example: /GM:DIRECT=TCP:209.51.171.142\ PRIVATE$\ MYQUEUE

/ GO[F:y][C:group]

Enable PSObserver Broadcasts: Ifthe /GO argumentis used, PeerSync will use mail
slots to broadcast activity across the LAN to the PeerSync LAN Observer Utility for the
centralized viewing of all PeerSync activity on the network. You can launch the PeerSync
LAN Observer Utility, ifitis installed/available from the View Menu.

y: ldentifies the number of seconds between each broadcast. The defaultis 3 seconds.
group: ldentifies a group for the current Profile. The defaultis the Profile Name.

Example: / GOF:5C:MyProfiles Enabled and broadcasted every 5 seconds with a group name of
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/GQ:[file][maxsize]

Create and Append Summaries into One Report: Ifthe /GQ argument is used,
PeerSync will append summaries into one log file.

IGR
Report Non Standard Events: Ifthe /GR argumentis used, PeerSync will report non -
add,update, and delete actions.

/GS:x
Enable Summary Statistics Collection: Ifthe /GS argument is used, PeerSync will
use x as the file location to save summary statistics.

H

Hide Splash Screen: Available through all registered versions of PeerSync, this
argument will suppress and hide the splash screen from the Taskbar for both the PeerSync
and Profiler applications.

IH-

Only Hide the about screen: Available through all registered versions of PeerSync,
this argument will suppress and hide the About screen for both the PeerSync and Profiler
applications.

[H+

Skip setting of main form visible: Available through all registered versions of
PeerSync, this argument will no setthe main form visible and always hide the application
from the Taskbar for both the PeerSync and Profiler applications.

/LQ:[file][maxsize]
Enable FTP Logging: Ifthe /LQ argumentis used, PeerSync willlog FTP activity to the
user defined file,orto PS_FTP.LOG by default.

/LSE
Log Service Events to the Event Viewer: Ifthe /LSE argument is used, PeerSync
will log events to the Event Viewer. The following options are available for this argument:

/LSEE Log messages as errors

/LSEEW Log messages as warnings

/ILSEEM Only log messages and log them as errors
/LSEEWM Only log messages and log them as warnings
M

Show Tray Icon: Ifthe /M argumentis used, PeerSync will display an icon in the system
tray for PeerSync.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/PROGRESS

Display status in PeerSync: This feature will show the PeerSync Status Display dialog
box during synchronization so the user can see activity, status and other information while
PeerSync is running.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/SNMP
Enable SNMP Error Reporting: Ifthe /SNMP argument is used, PeerSync will use
SNMP reporting to reportany errors that occur during the synchronization process.
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/TD

Display status in PeerSync upon completion: This feature will have PeerSync show
the PeerSync Status Display dialog box at the end of synchronization (only in non-
persistent modes) so the user can see activity, status and other information upon
completion.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

YL

Log Messages Only to a Log File by Filter and/or by Profile: Ifthe /YL argument
is used, PeerSync will log messages only to a log file based on the Filter and/or Profile.
The following options are available for this argument:

/YL Log messages for Both
IYLF Log messages by Filter Only
/IYLP Log messages by Profile Only

When logging by Filter (/YL or /YLF), the Filter message log file will reside in the same
directory as the primary log file, with the same file name as the primary log file but with a "
flt.log" file extension.

When logging by Profile (/YL or /YLP), the log file will reside in the same directory as the
Profile, with the same file name as the Profile butwith a "snc.log" file extension.

[QP

Don't Display Job Stats: Ifthe /QP argumentis used, PeerSync will notdisplay any Job
statistics in the Status Display window. Disabling this option reduces the amount of
overhead work PeerSync is doing.

QY7

XML File Creation Interval: By default PeerSync stores Profile and Job related
statistics into an easily readable XML files on aninterval of every 60 seconds (if
applicable) as well as during the completion ofa Job scan. This interval can be adjusted
using the /QY 7:n command line argument where n represents the interval in seconds of
how often you want PeerSync to update the Profile related XML statistics.

1QY7:(T-)(C-)(A-))(n)

(Interval to write out statistics (60 is the default))
(Suppress .totfile creation)
C- (Suppress .curfile creation)
(Suppress all XML file creation and new logic for tracking file extensions)

[YB:x

Disable Tray Icon Menu Items: Ifthe /YB argumentis enabled, PeerSync will allow
you to limitwhich Tray Icon menu items to be disabled, where each menuitem is
represented by 2 to the x value.
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VALUES Disable Menu Item

Yiew Log File v fYB: Wiewe Log File
Yiew Message Log File L B2 Yiew Message Log file
View Admin Falder Y| fvB:A “iew Admin Falder
Open Source Folder » | frBa Open Source Folder
Opern Target Folder * f“B16 Cpen Target Folder
Shaw Status Display fre:32 Show Status Display
v ConnectfLaunch Peersync Profiler FB:64 Connect/Launch PeerSync Profiler
Re-Load Profile fB:128 Fie-Load Frofile
Abaut PeerSync fYB:2hb About PeerSync
Exit PeerSync fB:512 Exit FeerSync

Note: To disable multiple menuitems simply add the /Y B values together for the items
you wish to disable.

EXAMPLES

/YB:512 Disables the Exit PeerSync menu option

/YB:24 Disables the Open Source Folderand Open Target Folder
options
8+16=24

/YB:767 Disables All Menu Options except About PeerSync
1+2+4+8+16+32+64+128+512=767

/QP

Disable Job Stats: Ifthe /QP argumentis enabled, the Job Stats option will be
unchecked, resulting in no Job statistics being shown in the PeerSync Advanced Display
panel.

[Q8BJ+

Enable Job Scans Tab:Ifthe /Q8BJ+ argumentis set,a Job Scans tab will be
created in the Advanced Run/View PeerSync panel showing Base/Root, Enhanced/
Expanded, and RT/Sub-folder scans with statistics and progress for all the Jobs or the
selected Job.

1QQ

Enable the File Copy Progress Tab:Ifthe /QQ argumentis setthe File Copy
Progress tab will be created in the Advanced Run/View PeerSync panel to show the
progress of a file transfer. This feature requires the Multi-T hreading Option.

/Q8BH+

Enable the Historical Data Tab: Ifthe /Q8BH+ argumentis set, the Historical Data tab
will be shown in the Advanced Run/View PeerSync panel. This tab contains a subset of
data from the PeerSync Jobs Stats panel (Xfer Rate, Bytes and Event Averages) and is
broken down into total, hourly, daily, and weekly statistics for all the Jobs or only the
selected Job.
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/ <<
Disable the Show Advanced Display link atthe bottom right corner of the Run/View
PeerSync screen.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any). For more information
on the latest features and how to implement specific scenarios please goto our support page at: http:// www.
peersoftware.com/ support/ support.aspx

5. Automation Arguments

Automation Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e./A /M).

1A

Scan at Start: Ifthe /A argumentis appended to the command line, the Profile can be
run through its associated shortcut. As non-persistent processes, Automatic Operations are
run a single time upon manual initiation by the user.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/D(H):x

Delay Start of Profiler: Ifthis argumentis used, PeerSync will delay the load/start of
PeerSync by x seconds. With this option enabled synchronization can be canceled via a
dialog box if done within the designated interval. For example, /D5 would provide you with
a 5second delay during which the operation can be canceled. Ifthe /D argumentincludes
anH,i.e./DH60, then the delay timer dialog will be hidden. This argumentis useful for
allowing PeerSync to begin after other applications have been loaded if you are running
PeerSync at Windows startup.

/R[OyCz

Real-time Monitoring Argument: The /R argumentactivates Real-Time Mode.
The Oy and Cz arguments are optional and specify the following retry values during Real-
Time Mode:

y = The retry countifthe file is open or network is unavailable
z = The retry count maximum

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/S

Run Scheduled Operation: The /S argument enables or disables Scheduled
Operation Mode for the entire Profile. This feature must be selected in order for all
Scheduled Operations setforindividual Jobs to be recognized. Scheduled Mode does not

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved


http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/support/support.aspx
http://www.peersoftware.com/support/support.aspx

PeerSync Help 136

apply a global schedule to the entire Profile: rather, it enables those schedules set for all
individual Jobs on to run at their specified intervals.

All Scheduled Operations set for individual Jobs will be ignored if this mode is not
selected. Ifnone of the Jobs within a Profile are setfor Scheduled Operation and this mode
is selected, all active Jobs within the Profile will be assigned a default synchronization
schedule of five minutes.

/Sx

Synchronization Timer Argument: The /Sx option is used to run PeerSync
automatically at regular intervals. This argument sets PeerSync to synchronize the
selected Profile every x minutes. Through this feature PeerSync remains persistentand will
notterminate upon completion.

Examples: /S10 Synchronization will be performed every 10 minutes

/SxKz

Synchronization Timer Argument with Keyboard Activity: The /SxKz option is
used to run PeerSync automatically at regular intervals only when it senses keyboard
activity. This argument sets PeerSync to synchronize the selected Profile every x minutes
upon Keyboard activity and will always run every z cycles with/without keyboard activity.
The z is optional and will be ignored if set to 0. Through this feature PeerSync remains
persistentand will notterminate upon completion.

Note: This itemis selectable from the Profiler via the Options Commands Screen.

/TIME

Daily Timer: This argumentwill allow for scheduling of PeerSync for specific times of the
day down to the minute for selected days ofthe week and selected Jobs within a Profile. If
youuse a /TIMEF argumentall selections atthe Job level from the Automation screen will
be used. You can also specify Global Daily Timer selections for the entire Profile from the
Options/Commands Screen or by using the following format:

1. Select the time of day (by default all Jobs will be run all days)

/TIME:HH:MM
Where HH is replaced with the value of 00-23 in military time and MM is replaced with 00-59 in minutes

Examples:

EveryDayat /TIME:00:00
12:00 am: / TIME:01:00
EveryDayat /TIME:08:00
1:00 am: /TIME:12:00
EveryDayat /TIME:20:00
8:00 am:

Every Day at

12:00 pm:

Every Day at

8:00 pm:

2. (Optional) - To select the days of week to run append the following:

D:SMTWTFS where the days are substituted with 1 (On) and 0 (Off)

Sunday: D:1000000
Monday: D:0100000
Tuesday: D:0010000
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Wednesday:  D:0001000

Thursday: D:0000100

Friday: D:0000010

Saturday: D:0000001

Examples:

M,W&Fat /TIME:08:00D:0101010
8:00 am: /TIME:17:15D:1000001
Sat&Sunat /T|ME:03:30D:0111110
5:15 pm:

Mon - Fri at 3:30

am:

3. (Optional) - To select the Jobs to run append F:f1;f2;f3
Where f1-fn are the Job numbers.

Examples:

Job 1 Everyday/ T|ME:06:00F: 1

at 6:00 am: / TIME:20:25F:1;2;3;4;5

Jobs 1-5Every/ TIME:03:30D:0111110F:1;3;5
day at 8:25 pm:

Jobs 1,3 &5

Mon - Fri at 3:30

am:

Note: Will accept multiple command lines.

Example:
Job 1 Every day at 8:00 am, Jobs 1 -5 Every day at 8:25 pmand Jobs 1, 3 &5 Mon - Fri at 3:30 am
/TIME:08:00F:1 / TIME:20:25F:1;2;3;4;5 / TIME:03:30D:0111110F:1;3;5

Sample:

Complete command line to run PeerSync with Test.snc, all Jobs, at 3:00 am Mon -Fri, (M)inimized on the tray.
"C:\ Program Files\ PeerSync\ PeerSync.exe" "C:\ Program Files\ PeerSync\test.snc" /
TIME:3:00D:0111110 /M

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/UDD

Use Device Driver method: This argumentuses ofthe Windows NT device driver for
real-time detection. When using this argument PeerSync can detect changes made to
remote Source folders but only when the changes are made by the machine where
PeerSync is installed.

/=

Applications to Ignore: [fusing the Device Driver method for Real-Time detection you
can select applications to ignore by appending application names (semicolon delimited)
to the /<argument.

Example: / <Explorer.exe;Word. Willignore any Real-Time changes made by Explorer.exe and Word.exe.
exe

Note: When using this option and monitoring a remote Source folder, the Transfer NT security descriptions
(ACLs) is ignored in Real-Time.

IX
Disable Initial Synchronization During Startup: The /X command line argument
disables initial synchronization during /A /M /R operations at PeerSync startup.
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Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will

display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support page at:
http:// www.peersoftware.com/ support/ support.aspx.

6. Synchronization Arguments

Synchronization Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e./A /M).

/GC:x
Set File Comparison Value: If the /GC argument is used, PeerSync will add x
seconds to the TargetFile date and time stamp to use during comparison.

/GD:n.z:n.z
SetJob Comparison Delta: Ifthe /GD argumentis used, PeerSync will add or subtract

z seconds from the TargetFile date and time stamp during a comparison for Job number
n.

Example: /GD:1,+30:2,-60:

IGE
Use Alternate Copy File Methods: The following copy file methods may be invoked:

/GFC Use CopyFile API method

/GFS  Use File Stream method

/GFE  Use CopyFileEX method

/GFA  Transfer Alternate Data Streams - The same functionality can be used ata Job
level by using the SETVAR INCLUDEALTFILESTREAMS switch in the Pre/Post
paths.

/GI(S)(D)

Ignore File Size and/or Date Comparison: Ifthe /Gl or /GIS argument is used,
PeerSync will ignore file size during folder scans (if date matches then skip file). If the /GID
argument is used, PeerSync will ignore file date comparison during folder scan (if size
matches then skip file).f the /GISD argument is used, PeerSync will ignore file date and
size comparison during folder scan (always replace Targetfile evenifthey are identical).

IGT.

Get Remote PC Time: Ifthe /GT argument is used, PeerSync will attempt to get the
time from the Target PC as well as the local PC and automatically compensate for time
differences.

Note: /GT is only applicable in an NT/2K Environment
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I1GX
Use Delete Path for Revisions: Ifthe /GX argument is used, PeerSync will use the
deletions path for all PSBAK revision files.

/1
Ignore Target Space During File Copy: The /I argument sets PeerSync to ignore
Targetspace available during file copy.

1d
Move Files: Ifthe /J argumentis used, PeerSync will move files - deleting them from the
Source after they have been successfully transferred.

TKA:x
Active Connection Interval: If the /KA argument is used, PeerSync will atempt to
connectevery x minutes to Target machine(s).

/LH:x

Set Deletion Move To Folder Cleanup Interval: If the /LH argument is used,
PeerSync will check the Move To Folder (the folder where deleted files are move to),
every x minutes to see if fles needed to be deleted on the cycle specified by the Delete

unmatched Target Files olderthan xdays option.

/LITR|T |A
Target In-Use Replacement: If the /LI argument is used, PeerSync will perform the
following operation if TargetFile is unavailable:

R Force rename of open TargetFile
T Force terminate of open TargetFile application
A Force terminate of all open Targetapplications

/LM:xOyCz
Set Failed Connection Timer: If the /LM argument is used, PeerSync will use the
following variables to determine retry frequency:

X Approximate time, in minutes, for retry of failed connection (ime may vary as much
as a few minutes).

y Frequency to retry files

z Maximum Retry Count

Example: /LM5025C100 Checks failed connections every 5 minutes, retries files every 25

seconds, to a maximum retry count of 100.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/LMD
Disable Failed Connection Timer: I[fthe /LMD argumentis used, PeerSync will not
check for failed connections:

Example: /LMD Does not check for failed connections.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/LR :file
Run application at start of PeerSync: If the /LR argument is used, PeerSync will
execute an application or shell script specified by file atthe initialization of PeerSync.
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Example: /LR:C:\WINNT\notepad.exe

/LW
Enable Last Access Compare: The /LW argument allows you to use the last access
date/time instead of the modified date/time for comparisons to determine file updates.

/NODELFLDR
Do not delete folders: If the /INODELFLDR argument is used, PeerSync will not
delete folders during synchronization.

10
Set Target File Overwrite: The /O argumentsets Target File overwrite on all Jobs.

QB
Use Full Access File Copy: Ifthe /QB argumentis used, PeerSync will only copy files
itcan gain full access to during synchronization.

/QFn

Shadow Time Range: This argument will use an n second time range for file time
stamps during comparison. If the Source and corresponding Target File time stamps fall in
the range then the file time stamps will be seen as equal.

n = Time in seconds

Note: /QF:1 is equivalent to a value between 1 to 3 seconds depending on the file systems being used.

[QF[+][++][+++]
Precision Comparison: Use this argumentto remove minutes, seconds, or milliseconds
from files during comparison.

/QF+ Removes/ignores the milliseconds from both the source and targetfile time
stamps during comparison

/QF++ Removes/ignores the milliseconds and seconds from both the source and target
file ime stamps during comparison

/QF++ Removes/ignores the milliseconds, seconds, and minutes from both the source

+ and targetfile ime stamps during comparison

QG

Always use the local machine time for the Last Run Time: If this argument is
used, PeerSync will always uses the local machine time for the Last Run Time, instead of
using the minimum time of the Source and Target machines involved in the
synchronization.

/QH:n
Force Flush File Buffers: Forces the file data that has been written across the network
to be fully committed to disk before continuing. The Interval n is the number of buffers worth
of data to write before forcing a disk write of the data, if n is not used the default is 100
cycles.

Note: This is expected to naturally occur without this argument, but on some systems across slower networks it
is necessary to force the commit of data to cormectly gauge process of writing the file.

/QHD

Direct Disk Write: Forces the file data that has been written across the network to be
fully committed to disk before continuing. This will occur for each buffer worth of data that is
transferred.
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Note: You may use this argument or the / GFC option to resolve Windows "Delayed Write Failed..." messages.

/Ql:ext
Ignore Matching/Locked File Extensions: This argument will ignore an add/update
of a file, ifa matching file with the same base name and the specified extension e xt exists.

Example: /Ql:dwl

Note: One instance of this example is if a file called MyFile.dwg is updated it will be excluded from
synchronization while MyFile.dwl exists.

/QJ:str

Ignore Matching/Locked File Postfix Replacement: This argument will ignore an
add/update of a file, if a matching file with the same base name with the specified postfix
replacementstr exists.

Example: /QJ:~$

Note: One instance of this example is if a file called MyDocument.doc is updated, it will be excluded from
synchronization while ~$Document.doc exists.

IT
Terminate All Instances of PeerSync: The /T argument terminates all running
instances of PeerSync, including itself.

/VRBn
Verify User-Name: If the /V argumentis used, PeerSync will verify logged on User-
Name defined in the local user file list, specified by the following options:

R Require userto be in the userfile list

B Bypass the requestto add to listdialog
n Maximum number of user allowed

/W :x

Set Queue Directory Change Count: Ifthe /W argumentis used, PeerSync will set
queue directory change count, events to wait for action x.

IWPFIX

Disable application associated with active file synchronization: When a file is
being synchronized, this option searches all active windows on the desktop for a caption
that contains the path/flename of the active file. PeerSync then disables the active
application in one of two ways. The command lines "/"WPFIX or /WPFIX2" disables the
entire applicationand" /WPFIX1" disables the save toolbar and file menu save item. (This
option also verifies that the word "WordPerfect' is in the caption before disabling). Both
options will append "(Synchronizing)" to the existing caption and when the file is
synchronized, the caption will be restored.

/WPMOD
WordPerfect Fixes for synchronization: The /WPFIX and /WPMOD arguments are
used to help in the synchronization of WordPerfectfiles.

DLL file to improve interaction with WordPerfect v8 and higher. Working with the Corel
corporation, we developed a 3rd party utility thatdisabled the save function in WordPerfect
when a document is "unmodified." This reduces the possible "File Access Denied" error
that WordPerfect produces when PeerSync is synchronizing the active document. To run
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this option, you must rerun the PeerSync installation program again. The file "PSWPMod.
DLL" file will be installed in the windows System32 folder.

For WordPerfect 8, add "/ WPMOD&8" on the PeerSync command line, which will modify the registry as follows:
Key: HKEY_LOCAL_MACHINE\ SOFTWARE\ COREL\ WordPerfect\ 8\ Third Party

String: DLL16

Value: C:\WinNT\ System32\ PSWPMod.DLL

For WordPerfect n, add "/ WPMODnR" on the PeerSync command line, which will modify the registry as follows:
Key: HKEY_LOCAL_MACHINE\ SOFTWARE\ COREL\ WordPerfect\ n\ Third Party

String: DLL16

Value: C:\ WIinNT\ System32\ PSWPMod.DLL

Note: The DLL16 string may vary based on the installation of other 3rd party add-ons to your WordPerfect
installation. The value could be DLL15, DLL14, etc.

/YC:x
Folder Queue Watch Interval: Change the defaulttimerinterval for checking the folder
gueue to x seconds (the defaultis .5 seconds).

Example: /YC:3

/YD

Allow Replication During Dynamically Created Jobs: This argument will allow
dynamically created Jobs (i.e. Job scans triggered by Folder Additions) to use the
replicate option.

IYE:extl:ext2;extn

Partial Locked File Extensions List: This argument is used for file types that are
partial locked when open by other applications (i.e. Outlook PST files). If the /YF argument
is used, and Volume_Shadow_Copy_Service (VSS) is enabled PeerSync will always
process files with the specified extensions as though they are open and locked files. If VSS
is notenabled, then PeerSync will pre-scan the files to ensure complete access before file
copy. PST files are included in this list by default and can be changed via this command
line.

Example: /YF:.pst;.dba;

IYN
Use Network Password Dialog: Ifthe /YN argumentis used, PeerSync will display a
network password dialog if you do not have rightto access the Source or Target Folder.

YR
Delete Empty Source Folders After Move: This argument will delete all empty
Source Folders after a synchronization scan when using the Move Files - Delete Source

File after successful copy to Targetoption.

YV

Do Not Validate Connections Before Profile is Loaded: This argument will not try
to validate Source and Target Folder connections during the load of a Profile. It will
assume thatthe connections will be available upon startof each Job. This option is useful if
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you are running a Pre Process that will establish a connection and/or create a Source or
Target Folder. This argument should be used when using the /LJP (Always Run Post
Process) argument or when needing to dynamically create the source and ortarget paths.

1Z:ext1:ext2;extn

Ignore Open File Extensions: |If the /Z argument is used, PeerSync will ignore files
with the specified extensions that are currently opened where the full name of the file is
displayed in the caption of another window. This argument may be ignored if Multiple Job
ormultiple copy threads are enabled.

Example: /Z:.wpd;.txt;

/LJU:x

Exclude Folders that have a Reparse Point: By default PeerSync will exclude
folders thathave a Reparse Point object, which are common in Windows Vista. Use this
argumentto alter this behaviour:

/LJU:0 Don'texclude folders thathave a Reparse Pointobject

/LJU:1 Exclude folders thathave a Reparse Pointobjectrecursively pointing back to itself
(Default)

/LJU:2 Exclude all folders thathave a Reparse Pointobject

/[LJP

Always Run Post Process: Ifthe /LJP argument is used, PeerSync allows for the
ability to process Post commands even if the Job fails. This argument is useful for non
persistent Profiles that need to execute or start other processes regardless whether or not
its Job was able to run. This argument should be used in conjunction with the /YV
command which allows for the Profile to be loaded before the source and target folder(s)
are validated.

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will

display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support page at:
http:/ / www.peersoftware.com/ support/ support.aspx.

7. Real-Time Arguments

Real-Time Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e./A /M).

IGA:x
Set Empty File Delay: Ifthe /GA argumentis used, PeerSync will delay x milliseconds
before synchronizing empty (zero size) files thatare detected in Real-Time.
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/GB:x
Set Shadow Detection: |If the /GB argument is used, PeerSync will delay x
milliseconds to synchronize subsequent updates of the same file during Real-Time.

/LA

Real-time Attribute Change: |If the /LA argument is used, PeerSync will monitor
aftribute changes to files in Real-Time and use these changes as ftriggers for file
synchronization.

/LE
Use Update Sensitivity: If the /LF argument is used, PeerSync will use the update
section of PSChangeNotify to detectfile changes during real-time.

Note: This feature is generally too sensitive, and will create multiple detections.

/LG

Folder Change Detection: Ifthe /LG argumentis used, PeerSync will detect folder
changes, and in Enhanced Real-Time will force the security description to be validated.
Any change to the folder will trigger a scan of the folder including its sub folders, so that
more CPU will be required. This option is notrecommended for non-enhanced Real-Time.

/LG1

Folder ACL Detection: Ifthe /LG1 argumentis used PeerSync will detectfolder
changes, and in Enhanced Real-Time will force only the ACLs and attributes to be
validated. Any change to the folder (i.e. file/folder adds or deletes) will force a comparison
of security descriptors and attributes. This argumentis more efficientthen the /LG option
above because itwill not perform a scan of the folder. Use this argumentif you wish to
detectand replicate ACLs in real-time for empty folders or folders that contain files for which
inheritances has been disabled. Without the /LG1 argument PeerSync would need to
perform a scanin order to replicate the permissions for such folders.

/LL
Disable Real-time Security Change: Ifthe /LL argumentis used, PeerSync will not
triggerupdates in Real-Time when a file's security has changed.

/LPC:x

Set Maximum Number of Events to Process within each Enhanced Real-Time
Queue Check: Ifthe /LPC argumentis used, PeerSync will set the maximum number of
events to process within each Enhanced Real-Time queue check to x events. The default
is 25 events and the minimum is 5 events.

/LPC:x+

Set Maximum Number of Events to Process within each Enhanced Real-Time
Queue Check: Adding the + argument PeerSync will process the events currently in the
listatthe time of queue checking setby LPQ.

Example: To queue events for 30 minutes (1800 seconds) and process them on that interval use the following
arguments: / LPQS1800 / LPC+

/LPD :x

Set Delay between Enhanced Real-Time Deletions: If the /LPD argument is
used, PeerSync will delay the deletion offiles x milliseconds during Enhanced Real-Time.

/LPE:x
Set Delay between Enhanced Real-Time Event Processing: |If the /LPE
argumentis used, PeerSync will delay the processing of each event x milliseconds.
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/LPM:x

Set Enhanced Real-Time Event Upper Limit: |If the /LPM argument is used,
PeerSync will set the maximum number of items x to allow in the Enhanced Real-Time
eventqueue before reverting to non-enhanced Real-Time. If this value is setto 0 then the
option is disabled (the default is 20000 events). If and when the Upper Limit is reached
PeerSync will clear all Enhanced Real-Time events that have not been processed and
scan the directories for changes.

/ILPW:x:y

Set Enhanced Real-Time Event Queue Delay: If the /LPW argument is used,
PeerSync will set the number of items x in the enhanced real-time event queue to wait for
before processing, as well as, the maximum time to wait for to y milliseconds.

/LPQ:x

Set Delay between Enhanced Real-Time Queue Checking: Ifthe /LPQ argument
is used, PeerSyncwill delay x milliseconds before checking the Enhanced Real-Time
queue for new events.

/LP X:x

Set Process Delay for Enhanced Real-time Changes: The /LPX argument allows
you to set the delay time for Enhanced Real-Time changes to be processed to x
milliseconds. This value will be applied directly for adds and updates and will be
multiplied by 3 for deletions. The defaultis 1000 milliseconds for adds/updates and 3000
milliseconds for deletions

/YK:n

Set Real-time Copy Thread Pool: Used to set the percentage of copy threads to
reserve for Real-Time events, where n can be set between the values of 1 and 99. The
defaultvalue is 10 percent.

[QR

Real-Time Global Exclusions: Use this argumentwhen you wantto exclude real-time
events earlierin the process and throw the events away. This argument will notlog/report
the exclusions. Improves performance when a high amount of events need to be excluded.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support page at:
http:// www.peersoftware.comv support/ support.aspx.

8. Managed Files Arguments

Managed Files Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
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each additional argument (i.e./A /M).

/1QD

Always Use Partial Locked File Extensions List for VSS: Ifthe /QD argumentis
used, any file thatis in the Partial Locked File Extension List (default: .pst files) will always
be synchronized using VSS without scanning the file for partial locks.

Note: Please refer to the /YF argument for more detail on the Partial Locked File Extensions List.

IGY :x
VSS Interval: The /GY argumentis used to set the interval to try open and locked files
via E The Defaultis every 2 hours and the minimum value is every 30 minutes.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/YY:n
Set VSS Try Count: This argumentis used to set the amount of times n to try and lock
down a drive for full access via VSS during each cycle. The defaultis 5 times.

Note: If this argument and the Set VSS Base Timeout (/ YZ:n) argument are not used then VSS will
wait 120 seconds five times.

/IXYZ:n

SetVSS Base Timeout: This argumentis used to set how long to wait for VSS to lock
the drive the firsttime in n seconds. Each subsequent try will have a timeout based on this
value multiplied by the Set VSS Try Count (i.e. 30, 60, 90, 120, 150). The defaulttimeoutis
30 seconds.

Note: If this argument and the Set VSS Try Count (/ YY:n) argument are not used then VSS will wait
120 seconds five times.

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. All features described on this page require the VSS add-on module.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will

display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.conm/ support/ support.aspx.

9. Bi-directional Arguments

Bi-Directional Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).

1GV.
Always Create Superset during Bi-directional Synchronization: If the /GV
argument is used, PeerSync will not use the TLR value, and therefore always create a
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supersetofdata during a bi-directional synchronization.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

IGW

Enable Temp Files: Ifthe /GW argumentis used, PeerSync will enable the use of
temporary files during file/folder renames and deletes. This is useful during 'Real-time Bi-
Directional Synchronization' in order to prevent oscillation.

/LB
Bi-directional Folder Deletion: If the /LB argument is used, PeerSync will delete
folders thathave been deleted from Targetor Source during bi-directional scans.

ILC
Use Last Access File Time: Ifthe /LC argument is used, PeerSync will always use
lastaccess file time for bi-directional synchronization.

ILD[M]A|TI|R]
Set Trigger Folder File Name: |If the /LD argument is used, PeerSync will set
enhanced bi-directional synchronization trigger folder filename extension to:

M Use machine name as extension

A Use LastAccessTime for TLR comparison
T Use ""FLDR" extensionin place of TLR

R Reset/Delete all trigger folder-files

ILE

Use Enhanced bi-directional synchronization mode: The /LE argument is
equivalent to /LDMAT mode. This will alter the way the bi-directional synchronization
option functions by using enhanced features to track all file and folder adds, updates,
deletions, renames and moves between scan cycles. In this mode PeerSync will use a
hidden system trigger file within each sub-folder to store information about the last scan
cycle for that sub-folder. Using this trigger file PeerSync can determine if a Folder was
added, deleted, renamed or moved since the lastscan.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/1YO-

Retain Last Access Time for Two Machine bi-directional synchronization: The
/YO- argument will store the original Last Access time of the Source File before
synchronization and then it will setthe Source and Target files' Last Access Times with the
stored time after a file add or update. This will allow bi-directional scans between two
machines to properly track file adds then subsequentfile deletes within the next scan cycle.

Notes:

1. When using standard or enhanced bi-directional synchronization we recommend adding / YO- as well as
/QYD:0 to your list of command line arguments to ensure deleted files from one side are not re-added by
the other side.

2. The /' YO- argument should NOT be used if there are more than two machines involved in a bi-directional
synchronization due to the need of the Last Access Time to be used by the third, fourth etc. machine
during comparison with either of the other two machines.

/QYD:n
Set Safety Value for Last Run Time: By default PeerSync uses /QYD:5 during
standard or enhanced bi-directional synchronization. With this option enabled deletion
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events are programmatically delayed by approximately 10 seconds to account for any
time differences between machines. This can be problematic when performing standard or
enhanced bi-directional synchronization where a deleted file from one side can be re-
added by the other. In this scenario we recommend using /QYD:0 which represents a
safety value of 0 seconds for deletions.

n=0 safety value =0 seconds

n=1 safety value =approximately 2 seconds
n=2 safety value =approximately 4 seconds
n=5 safety value =approximately 10 seconds

Note: When using standard or enhanced bi-directional synchronization we recommend adding /QYD:0 as
well as / YO- to your list of command line_arguments to ensure deleted files from one side are not re-added
by the other side.

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will

display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.com/ support/ support.aspx.

Other Components

1. PeerSync Status Display

Status Display Screen

This screenis used to view Current Profile Activity within the PeerSync application. The
Status Display window can only be viewed when PeerSync is running as an Application
and notas a Service. Enable the "Display status in PeerSync" option available in the
Options/Commands > Display Options... dialog to have the Status Display show
automatically at the start/launch of PeerSync or right-click on the Tray Icon and select"

Show Status Display".

Profile Displays the name of the Profile actively being processed.
This label may not match the name of the Profile currently
being configured through Profiler.

Job This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Mode Displays the Operation Mode (Real-time Mode, Scheduled
Operation, etc.) applied to synchronization of the Active Profile.

Source Displays a file path for the Source Folder presently being
synchronized.
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Target

Displays a file path for the TargetFolder presently being
synchronized from the Source indicated above.

Folders

This indicator provides a count of all unsynchronized folders
contained within the Source, and will decrease as each folder
is synchronized. An additional "thermometer" indicator will also
track the progress of folder synchronization.

Files

This indicator displays the total number of files contained within
the Source while also providing a count of synchronized files. In
addition, a "thermometer" indicator will show file
synchronization progress by increasing according to the size
ofthe currentfolder, with 100% representing the cumulative size
offiles contained within the Source Job set.

File

Indicates the name of the file currently being synchronized.

Large File or

Compression Status

This caption will be displayed to the right of the file name thatis
currently synchronized for large files and during compression.
The caption will show the size of the file that has been copied
to the Targetand/or compression status.

Skip File

This button will appear once the active Profile has been
launched. This feature allows you to skip synchronization of the
file currently displayed in the indicator described below. Skip
Files enables you to avoid delays caused by large files on
slow network or dial-up connections.

Size

Indicates the size (in bytes) of the file currently being
synchronized. A related "thermometer" indicator tracks the
progress of synchronization for thatfile.

Checked

This indicator displays the total number of files contained in the
selected Source Folders.

Excluded

Indicates the number of files that were excluded from
synchronization (See Exceptions).

Messages

Indicates the number of error messages generated during
Profile processing.

Updated

Indicates the number of Target Files that were updated during
synchronization of Profile Jobs.

Added

Indicates the number of new files added to TargetFolders
during synchronization of Profile Jobs.

Deleted

Indicates the number offiles deleted (or moved) during
synchronization of Profile Jobs.

Target Space

Indicates the Target Folder space remaining during
synchronization of Profile Jobs.

Elapsed Time

Indicates the amount of time that has elapsed during the current
Profile activity.

Hide

Will hide this display, which can be re-accessed via the Tray

lcon Men.
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Quit

Allows you to close/exitthe current session of PeerSync.

Other Screen Features

Processed Lists

The Updated, Added, Deletions and Excluded screens will
display statistical information in the above format. Each screen
will have statistical information (File Name, Size, Modified
Date/Time, Path, Duration, etc.) about the changes thathave
occurred during the current PeerSync session.

Item Count

Display ofthe amount of changes thathave occurred for the
currentscreen.

Maximum List Size

Allows you to selectthe maximum amount of changes thatyou
wish to store for the current screen. ltis recommended to keep
this value low because each entry requires memory to be used
by PeerSync.

Status Display Popup Menu

Activated by right clicking on the PeerSync Status Display. The Status Display window can
only be viewed when PeerSync is running as an Application and not as a Service. Enable
the "Display status in PeerSync" option available in the Options/Commands > Display
Options... dialog to have the Status Display show automatically at the start/launch of
PeerSync orright-click on the Tray Icon and select"Show Status Display".

View Log File

Allows you to access, launch and view Log files in the default
text editor for the current Profile.

View Admin Folder

Allows you to access, launch and view Admin log file Folders
in Explorer for the current Profile.

Open Source Folder

Allows you to access, launch and view Source Folders in
Explorer for the current Profile.

View Target Folder

Allows you to access, launch and view TargetFolders in
Explorer for the current Profile.

Print Allows you to print the current screen information.
Save As Allows you to save the current screen information to file.
Clear List Allows you to clear/resetthe current screen information.

Re-Load Profile

Allows you to re-load the current Profile ifany changes have
occurred.

About PeerSync

Will display an aboutscreen, thatcontains information about
the current PeerSync you are running.

Quit

Allows you to close/exit the current session of PeerSync.
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2. PeerSync Remote Control

PeerSync Remote Control Screen Features

This feature allows you to connect to and monitor any PeerSync currently running on your
LAN. Including PeerSync running as an application or a service on the local machine and/
or any instances of PeerSync running on any machine that is accessible from the local
machine.

Profile Selection The field located to the left of the Add Button. This field is used
to add a Profile to the Profile Selection List. The formatfora
Profile selection is: MACHINENAME:PROFILENAME (i.e.
DELLSERVER:Profile.snc).

Profile Selection List | The listlocated below the Profile Selection, which contains
Profile Selections thatcan be connected to and monitored by
selecting the item and using the Connectbutton.

Add This button will add the current Profile Selection to the Profile
Selection List.

Connect This button will connectto the current Profile Selection and
display its activity on the screen.

Disconnect This button will disconnect the current Profile Selection and
stop the display of activity.

Refresh This button will refresh the current Profile Selection activity.

Pause/Resume This button will pause/resume the current Profile thatis
selected.

Query This button will search forand add all Profiles thatcan be found

to the Profile Selection List.

Clear List This button will clear out all entries from the Profile Selection
List.

Remote Connection Displays the computer, user and lastresponse for the current

Information connection.

Close This button will close this dialog.

Note: The features described on this page require the Enhanced Package.

3. Quick-Sync

This feature is a quick and easy way to synchronize folder(s) on the fly to backup location(s)
with the option to modify your Job settings ata latertime.

Simply rightclick on any folder you wish to sync and select "Quick-Sync Folder...". This will
launch the Wizard, which will ask you to select a Target Folder to sync to...and your ready to
run the Quick-Sync. You also have the options to editand/or add the currentsync Job to your
Quick-Sync Profile or any other selected Profile. Then the next time you select a folder if it
matches any Source or Target selection in the Quick-Sync Profile the Jobs will be listed to
pick from oryou have the option to add a new Job.
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Index
-0 -

%Desktop% 53
%Faworites% 53
%Fonts% 53
%Personal% 53
%Programs% 53
%Recent% 53
%SendTo% 53
%Start Menu% 53
%Startup% 53
%Templates% 53

/-

/< (Applications to Ignore) 135

/0 (Set SNC File to Load) 127

/1 (Set Source Path) 127

/2 (Set Target Path) 127

/A (Scan at Start) 135

/AP (Run Pre-Sync Report) 131

/C (Load Alternate Configuration File) 127

/D (Delay Scan at Start) 135

/FTPPASSIVE (Force FTP passive mode on) 128
/GA (Set Empty File Delay) 143

/GB (Set Shadow Detection) 143

/GC (Set File Comparison Value) 138

/GD (Set Job Comparison Delta) 138

/GE (Set Shared Process Delay) 129

/IGF (Use Alternate Copy File Methods) 138

/GH (Set FTP Short Date Format) 128

/Gl (Ignore File Size and/or Date Comparison) 138
/GJ (Set FTP Failed Upload Retry Count) 128
/GK (Copy Thread Utilization) 129

/GL (Display status in Profiler) 131

/GLS (Display status in Profiler - Supress Initial
Connection) 131

/GM (Enable MSMQ messaging) 131
/GO (Enable PSObsener Broadcasts) 131
/GP (Set Email Threads) 129

/GQ (Create and Append Summaries into One Report)
131

/GR (Report Non Standard Events) 131

/GS (Enable Summary Statistics Collection) 131
/GT (Get Remote PC Time) 138

/GV (Always Create Superset during Bi-directional
Sync) 146

/GW (Enable Temp Files) 146

/GX (Use Delete Path for Revisions) 138

/GY (VSS Interval 145

/H (Hide Splash Screen) 131

/H- (Only Hide the about screen) 131

/1 (Ignore Target Space During File Copy) 138
/J (Mowe Files) 138

/KA (Active Connection Internval) 138

/LA (Real-time Attribute Change) 143

/LB (Bi-directional Folder Deletion) 146

/LC (Use Last Access File Time) 146

/LD (Set Trigger Folder File Name) 146

/LE (Use Enhanced bi-directional synchronization
mode) 146

/LF (Use Update Sensitivity) 143

/LG (Folder Change Detection) 143

/LG1 (Folder ACL Detection) 143

/LH (Set Deletion Move To Folder Cleanup Intenal)
138, 139

/LI (Target In-Use Replacement) 138

/LIP (Always Run Post Process) 138

/LJU (Exclude Folders that have a Reparse Point)

138

/LK (Set MultiTasking Delay) 129

/LL (Disable Real-time Security Change) 143

/LM (Set Failed Connection Timer) 138

/LMD (Disable Failed Connection Timer) 138

/LN (Set Processor Affinity) 129

/LPC (Set Maximum Number of Events to Process)

143

/LPD (Set Delay between Enhanced Real-Time

Deletions) 143

/LPE (Set Delay between Enhanced Real-Time Event

Processing) 143

/LPM (Set Enhanced Real-Time Event Upper Limit)

143

/LPQ (Set Delay between Enhanced Real-Time Queue

Checking) 143

/LPW (Set Enhanced Real-Time Event Queue Delay)
143

/LPX (Set Process Delay for Enhanced Real-time

Changes) 143

/LQ (Enable FTP Logging) 131

/LR (Run application at start of PeerSync) 138
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/LSE (Log Senice Events to the Event Viewer) 131,

132

/LW (Enable Last Access Compare) 138

/M (Show Tray Icon) 131

IMCT (Set Copy Threads) 129

/IMFT (Set Job Threads) 129

/NODELFLDR (No not delete folders) 138

/O (Set Target File Overwrite) 138

/OPTIMIZE (Optimize Performance) 129
/PERFORMANCE (Set Application Priority) 129
/PROGRESS (Display status in PeerSync) 131
/Q8BH+ (Enable the Historical Data Tab) 134
/Q8BJ+ (Enable Job Scans Tab) 134

/QB (Use Full Access File Copy) 138

/QD (Always Use Partial Locked File Extensions List
For VSS) 145

/QF (Shadow Time Range) 138

/QG (Always use the local machine time for the Last
Run Time) 138

/QH (Force Flush File Buffers) 138
/QHD (Direct Disk Write) 138
/QI (Ignore Matching/Locked File Extensions) 138

/QJ (Ignore Matching/Locked File Postfix
Replacement) 138

/QP (Disable Job Stats) 134

/QP (Don't Display Job Stats) 131

/QQ (Enable the File Copy Progress Tab) 134
/QQ<< (/QQ<< (Disable the Show Advanced Display
link) 135

/QR (Exclude Common Job Exceptions in Event
Processing) 130

/QY7 (XML File Creation Interval) 131

/QYD (Set Safety Value for Last Run Time)
146, 147

/R (Real time Monitoring Argument) 135

/IS 6

/S (Run Scheduled Operation) 135

/SNMP (Enable SNMP Error Reporting) 131
/Sx (Synchronization Timer Argument) 135
/SxKz (Synchronization Timer Argument with
Keyboard Activity) 135

/T (Terminate All Instances of PeerSync 138

/TD (Display status in PeerSync upon completion)
131

/TIME (Daily Timer) 135

/UDD (Use Device Driver method) 135
/USEPROFILEARG 127

/VRB (Verify User-Name) 138

/W (Set Queue Directory Change Count) 138

104,

/WPFIX (Disable application associated with sync)
138

/WPMOD (WordPerfect Fixes for synchronization)
138

/X (Disable Initial Synchronization During Startup)
135

/YC (Folder Queue Watch Intenval) 138

/YD (Allow Replication During Dynamically Created
Jobs) 138

/YF (Partial Locked File Extensions List) 138, 142
/YK (Set Real-time Copy Thread Pool) 143

/YK:n (Set Real-time Copy Thread Pool) 129

/YL (Log Messages Only to a Log File by Filter and/or
by Profile) 131

/YN (Use Network Password Dialog) 138

/YO (Retain Last Access Time for Two Machine
bi-directional synchronization) 104

/YO- (Retain Last Access Time) 146, 147
/YR (Delete Empty Source Folders After Mowe) 138

/YV (Do Not Validate Connections Before Profile is
Loaded) 138

/YX:n (Set File Read/Write Buffer Delay) 129
IYY (Set VSS Try Count) 145

IYZ (Set VSS Base Timeout) 145

/Z (Ignore Open File Extensions) 138

1 -

127.0.0.1

_A -

About PeerSync 148

Accessing Open Files 64, 105, 107
ACL Options (Global) 104

Activate real-time monitoring 57

Active Connection Interval 138

Active Job 148

Active Profile List 148

Add Jobs with Wizard 14

Add - synchronize new files to target 64
Add Jobs 14

Add Quick-Sync Folder option to Explorer menu
112

Add Shares with the selected Prefix 100
Add Shares with the selected Suffix 100
Add Shares: Do Not Update or Delete 100
Add to Windows registry 112

32, 44
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Add to Windows StartUp 112

Add/Delete/Modify Jobs: Tool Buttons

Added Files Reporting Feature 88

Added Indicator 148

Additional Configuration Entries 6

Additional Event Options 78, 80

Additional Features 80

Additional Features List 80

Additional Features Screen: 80
Additional Options 80, 81
Enable file recovery 80, 81

Perform binary comparison on all files (using
CRC32) 81

14, 26

Replace in-use files upon reboot 74, 81
Validation Options 81

Additional File Includes 69

Additional Folder Selection Features 53, 80

Additional Options 80
Additional/Alternate Target Paths 52
Admin Backup 101
Admin Report Cycle Options 91
Admin Reporting 90
Admin Reporting Features 91
Admin Reporting Screen: 90
Admin Reporting Ovenview 90
Report file name 91
Report File Path 91
Use error information only 91
Use standard report file content 91
Use Summary Information Only 91
Administrative report file storage manipulation and
organization 53
Advanced Backup 101
Advanced Options 100, 101
Advanced View 29
Affinity 129
After each scan 95
After each scan (log all non-scan events on the cycle
specified) 92
After each scan/cycle even if no events occurred
92, 95
After synchronization subtract/add x minute(s) from
target 82

Allow for remote real-time configuration - NetApp
fPolicy 36

Allow Replication During Dynamically Created Jobs
138

Alternate Configuration File 127
Alternate Data Stream (ADS) Backup 101

Alternate Target Path Selection Dialog 52
Alternate/Additional Target Paths 52

Always create a super-set during bi-directional
synchronization 104

Always Create Superset during Bi-directional Sync
146

Always owverwrite 64
Always Run Post Process 138

Always Use Partial Locked File Extensions List For
VSS 145

Always use the local machine time for the Last Run
Time 138

Append Default File/Folder Exclusions from PeerLock
109

Application Priority 129

Applications to Ignore 135

Argument Selection 106

Argument Selection from the Interface 107
Arguments 106

ASCIl 41, 49

At the start of this Profile 92

At the stop of this Profile 92

Attach log file to messages 93

Attribute Exceptions 87

Automatically detect and use recommended NetApp
configuration 37

Automatically use recommended settings based on
Detection Method - Source Folder 36

Automation 57
Automation Command Line Arguments: 135
Applications to Ignore 135
Daily Timer 135
Delay Scan at Start 135
Device Driver method 135

Disable Initial Synchronization During Startup
135

Interval 135
Keyboard Activity 135
Real time Monitoring Argument 135
Run Scheduled Operation 135
Scan at Start 135
Synchronization Timer Argument 135
Synchronization Timer Argument with Keyboard
Activity 135
Timer Argument 135
Use Device Driver method 135
Automation Features 57
Automation Screen: 57
Activate real-time monitoring 57
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Automation Screen: 57
Automation Screen Owveniew 57
Daily Timer Options 57

Run at specific times and selected days 57

Run on an interval every x minute(s) 57
Use enhanced real-time monitoring 57

_B -

Back Button 14

Back-Up 3

Bandwidth throttling 72

Basic View 29

Bi-directional Command Line Arguments: 146

Always Create Superset during Bi-directional
Sync 146

Bi-directional Folder Deletion 146
Enable Temp Files 146

Retain Last Access Time 146

Set Safety Value for Last Run Time 146
Set Trigger Folder File Name 146

Use Enhanced bi-directional synchronization
mode 146

Use Last Access File Time 146
Bi-directional Folder Deletion 146
bi-directional synchronization 64
bi-directional synchronziation 78
Binary Comparison 81
Bi-Sync Options Button 106
blackout 61
Blackout Settings 61
Block Size Selection 74
Buffer Size - File Read/Write 72
Buffer Size Upper Limit 72
Buttons 14
ByteReplicator 74

Block Size Selection 74

Excluded File Types 74

Exclusions 74

Minimum File Size 74

Port 74

Time Out 74

_C-

Carbon Copies - Email Reporting 93
Change Password 98
Changing Profile Job List Window 26

Check for ACL changes during scans 104
Checked Indicator 148

Choose external applications/scripts to be run before
and after the processing of a given Job 99

Clear List 148

Clear Log File 88

collect real-time events 61

Command Line Argument Selection 106

Command Line Argument Selection from the Interface
107

Command Line Arguments 107, 126
Compare Time Change 82
Compress target 97
Compressed File Extension 97
Compression 96
Compression - TCP Souce 39
Compression - TCP Target 48
Compression Features 97
Compression Owveniew 96
Compression Screen: 96, 98

Change Encryption Password 98

Compress target 97

Compressed File Extension 97

Compression Speed 98

Expand source 97

Extraction 96

Oweniew 96

Password - Encryption 98

Use file compression 97

Use folder compression 97
Compression Speed 98
Compression Status 148
Computer Name Variable 53
Configuration Command Line Arguments: 127

Alternate Configuration File 127

Load Alternate Configuration File 127

Set SNC File to Load 127

Set Source Path 127

SNC File 127

Use Arguments from Profile 127
Configuration Entries 6
Configure FTP Source Folder 43
Configure FTP Target Folder 52
Configure Normal Source Folder 42
Configure Normal Target Folder 51
Configure TCP Source Folder 43
Configure TCP Target Folder 51
Connect As 38
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Connect to and monitor any PeerSync currently
running on your LAN 151

Connection Manager 36

Connection Manger for Failed Connections - Source
Folder 36

Conwert to GMT for comparison purposes 82
Copy Jobs 14

Copy Thread Utilization 129

Copy Threads 103, 129

Copyright 3

CRC32 81

Create a report for every event 91

Create a report on an interval 91

Create areport once aday 91

Create a report once a week 91

Create administrative Email messages 92
Create administrative report files 91

Create and Append Summaries into One Report
131

Create Auto FTP Job Name 52

Create Email messages 92

Create Normal Souce Auto Job Name 42
Create Normal Target Auto Job Name 51
Create Pre Sync Report 26

Create Shortcut on Desktop 112

Create SNC extension association for Profiler 112
Create Souce FTP Auto Job Name 43
Create Source Folder 32

Create Target Folder 44

Create Target TCP Auto Job Name 51
Create TCP Source Auto Job Name 43
Current Arguments 106

Current Arguments Button 106

Current Attributes 87

Current Command Line Argument Selection 101,
106

Customize Selection Tree 29
Customized View 29

D -

Daily Timer 135

Daily Timer Options 57

Date variables for Folder Paths 53
Date/Time Variable 53

Dates Exceptions 87

Day variables for Folder Paths 53
Days of the week scheduling 57

Default inclusion 83
Default Read/Write Buffer Size 72
Delay between Enhanced Real-Time Deletions 143

Delay between Enhanced Real-Time Event Processing
143

Delay between Enhanced Real-Time Queue Checking
143

Delay Scan at Start 135

Delayed Write Failed 138

Delete Empty Source Folders After Move 138
Delete fPolicy on Close - NetApp Settings 37
Delete Jobs 14

Delete log file after successful send 93

Delete Unmatched Target Files 66

Delete unmatched target files older than x days 66
Deleted file storage manipulation and organization
53

Deleted Indicator 148

Deletion Folder 66

Deletion Options 65, 66

Deletion Options Button 66

Destination IP 90

Detection Method for Real-Time Monitoring 36
Detection Method Options 36

Device Driver method 135

Disable all Startup Options 112

Disable application associated with sync 138
Disable Failed Connection Timer 138

Disable Initial Synchronization During Startup 135
Disable Install Reboot 6

Disable Jobs that are Not Configured from this Profiler
110

Disable Real-time Security Change 143

Disabled - Connection Manager 36

Display status in PeerSync 131

Display status in PeerSync upon completion 131
Dissimilar time zone synchronization 82
Distribution 3

Do Not Validate Connections Before Profile is Loaded
138

Drag and Drop Source Folder Selection 32

Drag and Drop Target Folder Selection 44

Drive Mapping 56

During comparison subtract/add x minute(s) from

target 82

Dynamic Network Drive Mapping and Un-mapping
56

Dynamic archives 53
Dynamic synchronization based on date 53
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Dynamic synchronization based on logged on user or Enhanced Real-Time Event Queue Delay 143

machine name 53 Enhanced Real-Time Event Upper Limit 143
Dynamic synchronization based on personal folders or  Enhanced Scan Processing 58
other variables read in from the registry 53 Error Reporting 131
Evaluating a new version of PeerSync 10
- E - Evaluation Menu 24
Event Options 65
Easy way to synchronize folders on the fy 151 Exception Screen Features 83
Edit Job Groups Dialog 28 Exceptions 83
Edit Menu 17 Exceptions Screen:
Edit Normal Source Variable File 42 Exceptions Screen Overview 83
Edit Normal Target Variable File 51 Exclude Files by Character/String/Extension 85
Elapsed Time Indicator 148 Exclude Files from Sync by Size 87
Email Report Cycle Options 94 Exclude Files in Sync by Attribute 87
Email reporting 92 Excluding Folders from Sync 86
Email Reporting Features 92 Include File Types (using wild cards) 83
Email Reporting Oveniew 92 Include Files in Sync by Attribute 87
Email Reporting Screen: 92 Include Files in Sync by Date 87
Attach log file to messages 93 Exclude all open files until closed 69
Create administrative Email messages 92 Exclude File Sizes 87
Delete log file after successful send 93 Exclude Files 85
Report file name - Email Reporting 93 Exclude Files Button 85
Use error information only 93 Exclude Folders 86
Use standard report file content 93 Exclude Folders Button 86
Use summary information only 93 Exclude Folders drop down list 86
Email Threads 129 Exclude Folders that have a Reparse Point 138
Embedded Open File Manager 64 Exclude open files 69
Enable file recovery 80, 81 Exclude open files (allow read access to source file
Enable FTP Logging 131 during transfer) 69
Enable intelligent network load balancing 72 Exc_:lude open files (deny all access to source file
Enable intelligent network load balancing (when during transfer) 69
applicable) 72 Exclude root folders 86
Enable Last Access Compare 138 Exclude specific folders only 86
Enable Passive Mode - FTP Source 40 Exclude Users - NetApp fPolicy 36
Enable Passive Mode - FTP Target 49 Excluded Indicator 148
Enable PSObsener Broadcasts 131 Exclusion drop down list 85
Enable SNMP Error Reporting 131 Exclusive Remedy 3
Enable Summary Statistics Collection 131 Executable Path (PeerLock) 115
Enable Temp Files 146 Executable Path (PeerSync) 112
Enabled for Source and Target Connections - Expand source 97
Connection Manager 36 Explore Source Folder 32
Enabled for Source Connections Only - Connection Explore Target Folder 44
Manager 36
Enabled for Target Connections Only - Connection _ F -
Manager 36

Encryption - TCP Souce 39
Encryption - TCP Target 48
Enhanced real-time 57

Failed connection 102
Failed Registration 8
Features 80
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File Date Reporting Feature 88
File Dates 87
File Deletion Options 66
File Exclusions 74
File Folder Path Variables 53
File Indicator 148
File Menu 16
File Options 64
File Options Features 64
File Options Screen: 64
Add - synchronize new files to target 64
Awiding Permanent Deletion 66
Delete Unmatched Target Files 66
Delete Unmatched: Options 66
Deletion Warning Message 66
Mode Selection 64
Replicate - Delete unmatched files/folders 64
Update - synchronize existing files in target 64
Use Windows Recycle Bin 66
File Path Variables 53
File Path Variables: Folder Selection 53
File Read/Write Buffer Size 72
File Recovery 80, 81
File Size Reporting Feature 88
File Sizes 87
File Time Change Options 80
File Time Reporting Feature 88
File types to transfer as ASCIl - FTP Source 40
File types to transfer as ASCIl - FTP Target 49
File Versions 76
Files Indicator 148
Folder ACL Detection 143
Folder Change Detection 143
Folder Creation Reporting Feature 88
Folder Names Reporting Feature 88
Folder Queue Watch Interval 138
Folder Restoration feature in real-time 57
Folder Selection Features 32
Folder Selection Screen: 32
File Path Variables 53
Folder Selection Screen Owveniew 32
Source Folder Selection 32
Target Folder Selection 44
Folders Indicator 148
For each individual error message as it occurs 92
for each message/error as it occurs 95
Force Flush File Buffers 138
Force FTP passive mode on 128

Force Source Folder Root as Target FTP Folder Root
52
Force Source Folder Root as Target TCP Folder Root
51
fPolicy Name - NetApp Settings 37
FTP Command Line Arguments: 128
Force FTP passive mode on 128
Set Failed Upload Retry Count 128
Set Short Date Format 128
FTP Logging 131
FTP Source 34
FTP Source Configuration 40
FTP Source Mode Selection 40
FTP Source PopUp 43
FTP Source Settings Tab 40
FTP Target 45
FTP Target Configuration Tab 49
FTP Target Mode Selection 48
FTP Target PopUp 52
FTP Target Settings Tab 49

-G -

General 3

Get Remote PC Time 138

Global ACL Options 104

Global Advanced File Xfer Options 100, 101
Global bi-directional Options 101, 104
Global Display Options - Profiler Options 107
Global Managed Files Options 101

Global Migrate Shares Options 100, 101
Global Options 110

Global Recowvery/Offline Options 101

Global Settings (PeerLock): 110

Disable Jobs that are Not Configured from this
Profiler 110

Global Options 110
Link this Profiler to PeerLock 110
Sawve Changes in PeerLock 110
Show PeerLock 110
Global Settings (PeerSync):
105, 106, 107
Global VSS Options 101
Greater Than File Size Exclusion 87

“H -

H+ (Skip setting of main form \isible) 131

101, 102, 103, 104,
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Help Button 14

Help Menu 21

Hide 148

Hide Splash Screen 131

Host is using GMT - FTP Source 40
Host is using GMT - FTP Target 49
Host Name 47

Host Name - FTP Source 40

Host Name - FTP Target 49

Host Name - TCP Source 38

Host Server Name - NetApp Settings 37
Hour variables for Folder Paths 53

Ignore File Size and/or Date Comparison 138
Ignore Matching/Locked File Extensions 138
Ignore Matching/Locked File Postfix Replacement
138

Ignore Open File Extensions 138
Ignore Target Space During File Copy
Improve Load Balancing 72
Include all open files 69

Include attribute change as synchronization criteria
80

Include Files 83
Include Files Button 83
Include open files 69

Include open files (allow read & write access to source
file during transfer) 69

Include open files (allow read access to source file
during transfer) 69

Include open files (if possible) 69

Include partially open files 69

Include Sub foldersFolder Selection Screen:
Include Source Sub-Folders 32

Include this Job in PeerLock 109

Inclusion drop down list 83

Information Required to Register software 8

initiate scan on trigger file change 63

Initiate Synchronization on Source or Target
File/Folder Change 57

Install Options 6

Install Senice (PeerLock)
Install Senice (PeerSync)
INSTALL.LOG 6
Installation (Silent Install) 6
Installation Configuration Options 6

138

115
112

Installing PeerSync 6

Intelligent Network Load Balancing 72
Intermediate View 29

Interval 135
Intervals Button
ltem Count 148

_ ] -

job data import 56

Job Indicator 148

Job Menu 20

Job Settings (PeerSync): 31, 32, 57, 61, 62, 64, 69,

71, 72, 74, 76, 78, 80, 83, 88, 90, 92, 96, 99

Job Settings PeerLock: 109
Append Default File/Folder Exclusions from
PeerLock 109

Include this Job in PeerLock
Job Threads 103, 129
Jobs 12,151

“K -

Keep backup files of overwritten Target Files 76
Keep files in Alternate Folder 76

Keep files in Deletion Folder 76

Keep files in Target Folder 76

Keep multiple versions of files 76

Keyboard Activity 135

_L -

Large File or Compression Status
Last Run On 53

Last Run On - Reset 26

Last Run On Feature 26

Last Save 53

Last Scan 53

Launch (PeerLock) 122, 123
Launch (PeerSync) 116, 118
Launch Current Profile 14

Left side Panel - Selection Tree 29
Less Than File Size Exclusion 87
License 3

License File 6

Limit CPU usage during file transfers
Limit number of processors to use

102

109

148

129
129
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Limit system resources during file transfers 129
Limitations of Liability 3

Limited Warranty 3

Link this Profiler to PeerLock 110
List of Exclude Files (using sub strings)
List of Exclude Folders 86

List of Include File Types (using wild cards) 83
List of Job Selections - Daily Timer 57

Load Alternate Configuration File 127

Load Balancing 72

Log File - Clear 26

Log File - View 26

Log file storage/manipulation/organization 53
Log Files: Administrative 90

Log Messages by Filter 131

Log Messages by Profile 131

Log Messages Only to a Log File by Filter 131

26, 85

Log Messages Only to a Log File by Filter and/or by

Profile 131

Log Messages Only to a Log File by Profile 131
Log Senice Events to the Event Viewer 131
loopback 32, 44

-M -

Managed Files 71
Managed Files Arguments: 145

Always Use Partial Locked File Extensions List

For VSS 145

Set VSS Base Timeout 145

Set VSS Try Count 145

VSS Interval 145
Match Shares: Add, Update and Delete 100
Maximize Speed 72
Maximum compression 98
maximum duration of scans 62
Maximum List Size 148
Maximum Log File Size 89
Maximum Number of Events to Process 143
Maximum speed - compression option 98
Menu (PeerSync):

Edit 17

Evaluation 24

File 16

Help 21

Job 20

Options 18

PeerSync Tray Icon PopUp Menu 25

160

Run 19
View 17
View Popup Menu 25
Messages Indicator 148
Messages Reporting Feature 88
Migrate Shares 100
Minute variables for Folder Paths 53
Miscellaneous 78
Mode Indicator 148
Mode Selection 64
Monitor ACL changes during real-time 104
Monitor PeerSync activity across the LAN 151
Monitor Remote Instances of PeerSync 151
Month variables for Folder Paths 53
Mowe Files 79, 138
Mowe Job Down 14
Mowe Job Up 14

MS Windows Explorer Add On - Quick-Sync 151

MSMQ messaging 131
Multiple Copy Threads 103
Multiple Job Threads 103

-N -

Naming and Renaming Jobs 26
NetApp fPolicy 36

NetApp Settings 37

Network Drive Mapping 56

Network License 3

Network Load Balancing 72

Network Logon Settings - Connect As 38
Network Logon Settings - Password 38
New Profile 14

Next Button 14

No not delete folders 138

Non Persistent Processes 26

Normal 36

Normal Source 32

Normal Source Mode Selection 35
Normal Source PopUp 42

Normal Target 44

Normal Target Mode Selection 47
Normal Target PopUp 51

Number of backup files to keep 76
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_ 0O -

Only Hide the about screen 131

Only include connections that are set for real-time

monitoring 36
Only use Advanced Settings 91, 94
Open File Manger Options 64
Open File Options 64
Open Files 69, 107
Open Profile 14
Open Source Folder 32, 148
Open Target Folder 44
Open/Locked Files 69
Optimize Performance 129
Optimize speed 72
Options 31
Options Menu 18
Options/Commands 107, 148
Options/Commands Features 107
Options/Commands Owveniew 107
Options/Commands Screen: 107
Current Arguments 106
Current Arguments Button 106
Oweniew 107
Set Access Password 107
Show tray icon 107
Other Global Options/Command 101
Oweniew 12, 151
Owerwrite Existing Log File 88
Owerwrite existing Pre-Sync report file 106

_P-

Parameter Selection from Profiler 106
Partial Locked File Extensions List 138
Password 38

Password - Encryption 98

Password - FTP Source 40
Password - FTP Target 49

Password - Registration 8

Password - TCP Souce 39

Password - TCP Target 48

Password for Tray Icon 107

Path (PeerLock) 115

Path (PeerSync) 112

Path to Host 47

Path to Host - FTP Source 40
Path to Host - FTP Target 49
Path to Host - TCP Source 38
Path to Host - TCP Target 47
pause scan during specific times 61
Pause Senice (PeerLock) 122, 123
Pause Senice (PeerSync) 116, 118
PeerLock Selection Tree Category 29
PeerLock Senice: 122, 123

Launch PeerLock 122, 123

Pause Senice 122, 123

Resume Senice 122, 123

Run as a senice 122, 123

Start Senice/Application 122, 123

Stop Senvice/Application 122, 123
PeerSync Command Line Arguments 126
PeerSync Installation 6
PeerSync Remote Control 151
PeerSync Selection Tree Category 29
PeerSync Senice: 116, 118

Launch PeerSync 116, 118

Pause Senice 116, 118

Resume Senice 116, 118

Run as a senice 116, 118

Start Senice/Application 116, 118

Stop Senvice/Application 116, 118
PeerSync Status Display 148
PeerSync Status Display Popup Menu 148
PeerSync Temp Folder 6
PeerSync90.lic file 6

Perform binary comparison on all files (using CRC32)
81

Performance 72

Performance - Threads 103

Performance Command Line Options: 129
Affinity 129
Application Priority 129
Copy Thread Utilization 129
Copy Threads 129
Email Threads 129
Job Threads 129
Limit CPU usage during file transfers 129
Limit number of processors to use 129
Limit system resources during file transfers 129
Optimize Performance 129
Priority 129
Processor Affinity 129
Set Application Priority 129
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Performance Command Line Options: 129
Set Copy Threads 129
Set Email Threads 129
Set File Read/Write Buffer Delay 129
Set Multitasking Delay 129
Set Processor Affinity 129
Set Real-time Copy Thread Pool 129
Set Shared Process Delay 129

Set the percentage of copy threads to reserve for
real-time events 129

Shared Process Delay 129
Thread Utilization 129
Threads 129

Performance Features 72

Performance Options All Jobs 107

Performance Package 103, 107

Performance Priority Selection 103

Performance Screen: 72
Enable intelligent network load balancing (when
applicable) 72
File Read/Write Buffer Size 72
Set maximum number of copy threads tox 72
Throttle bandwidth - Use x percent of available
bandwidth 72

Pop Up Menu: Profile Job List 26, 29

Pop Up Menu: Selection Tree 29

Port - Email Reporting 93

Port - FTP Source 40

Port - FTP Target 49

Port - TCP Souce 39

Port - TCP Target 48

Port Configuration 74

Post Installation Configuration Options 6

Post process application 99

Pre Installation Configuration Options 6

Pre process application 99

Pre/Post Features 99

Pre/Post Owverview 99

Pre/Post Process 99

Pre/Post Process Owveniew 99

Pre/Post Process Screen: 99
Select Application/Script to Run After 99
Select Application/Script to Run Before 99
Use maximum wait time of x seconds 99

Wait for application to end before continuing 99

Preserve Paths 66
Pre-Sync Report Options 106
pricing information 8

Print 148
Priority 129
Priority Selection 103

Process Delay for Enhanced Real-time Changes
143

Process Migrate Shares after each scan 101

Process Migrate Shares every x minute(s) 101

Processed Lists 148

Processor Affinity 129

Product Definitions 12, 151

Product Support 12, 151

Product Updates 8

Profile Description: 16
Default Description 16
Hiding Profile Description Toolbar 16
Moving Profile Description Toolbar 16

Profile Indicator 148

Profile Job List Pop Up Menu 26

Profile Job List: 26
Add/Delete/Modify Jobs 26
Changing Size of Window 26
Naming and Renaming Jobs 26
Selecting Jobs and Multiple Jobs 26

Profile Options: Customize 29

Profile Options: Show All 29

Profile Selection 151

Profile Selection List 151

Profiler 12, 151

Profiler Command Line Arguments 126

Profiles 12, 151

ps90.exe 6

PSDef.CFG 6

PSError.log 88, 89

PSObsener Broadcasts 131

Quantity Discounts 8
Quick-Sync 151
Quick-Sync Folder 151

Quick-Sync Profile 151
Quit 148

‘R -

Real time File Folder Change Detection 57
Real Time Mode 12, 151
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Real time Monitoring Argument 135

Real Time Options 59

Real-time Attribute Change 143

Real-Time Command Line Arguments: 143
Disable Real-time Security Change 143
Folder ACL Detection 143
Folder Change Detection 143
Real-time Attribute Change 143

Set Delay between Enhanced Real-Time Deletions
143

Set Delay between Enhanced Real-Time Event

Processing 143

Set Delay between Enhanced Real-Time Queue
Checking 143

Set Empty File Delay 143

Set Enhanced Real-Time Event Queue Delay
143

Set Enhanced Real-Time Event Upper Limit 143

Set Maximum Number of Events to Process
143

Set Process Delay for Enhanced Real-time
Changes 143

Set Real-time Copy Thread Pool 143
Set Shadow Detection 143
Use Update Sensitivity 143
Real-time Copy Thread Pool 143
Real-Time Event Detection Options 57
Real-time Monitoring 57
Real-time Options Button 57
Reboot Options Button 81
receive an e-mail at start of profile 95
receive an e-mail at stop of profile 95
Recowery Intervals Button 102
Register by FAX 8
Register by mail 8
Register by phone 8
Register online 8
Registering Evaluation Copy of PeerSync 9
Registering Unregistered Copy of PeerSync 9
Registration and Passwords: 8
Entering User ID/Password (Evaluation Copy) 8
Register By Mail 8
Registry variables to use in Folder Paths 53
Related Global Settings 69
Relative Paths 66
Re-load Profile 148
Remote Connection Information 151
Remote Connection Licenses 151
Remote Control 151

Remowe Senice (PeerLock) 115

Remowe Senice (PeerSync) 112

Rename Job 14

Replace In use Files Options 81

Replace in use files upon reboot 80, 81

Replace Shares: Add and Overwrite 100

Replicate - Delete unmatched files/folders 66

Replication 12, 151

Report file name 91, 93

Report file path 91

Report Non Standard Events 131

Reporting 88

Reporting Command Line Arguments: 131
Create and Append Summaries into One Report

131

Display status in PeerSync 131

Display status in PeerSync upon completion
131

Enable FTP Logging 131

Enable PSObsener Broadcasts 131

Enable SNMP Error Reporting 131

Enable Summary Statistics Collection 131
Error Reporting 131

FTP Logging 131

Hide Splash Screen 131

Log Messages by Filter 131

Log Messages by Profile 131

Log Messages Only to a Log File by Filter 131

Log Messages Only to a Log File by Filter and/or
by Profile 131

Log Messages Only to a Log File by Profile 131
Log Senice Ewents to the Event Viewer 131
MSMQ messaging 131

Only Hide the about screen 131
PSObsener Broadcasts 131

Report Non Standard Events 131

Run Pre-Sync Report 131

Show Tray Icon 131

Skip setting of main form visible 131

SNMP Error Reporting 131

Summary Report 131

Summary Statistics Collection 131

Suppress connection of PeerSync to the Profiler
131

Tray Ilcon 131
Reporting Features 88
Reporting Screen: 88

Clear Log File 88

Include Options 88
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Reporting Screen: 88
Maximum Log File Size 89
Oweniew 88
Overwrite Existing Log File 88
Use Log File 88
View Log File 88
Reporting Standard report file content
Reporting Summary Information Only
Reset Last Run On Value 26
Resume Senice (PeerLock) 122, 123
Resume Senice (PeerSync) 116, 118
Retain Last Access Time 146
Retry failed connections every x minutes 102
Retry open files every x seconds 102
retry open inaccessible files 102
Retry Options Button 81
Revisioning 76
Revisions 76
Root Path - TCP Source 38, 39
Root Path - TCP Target 47
Root Path Prefix - NetApp Settings 37

Run a Pre-Sync Report (do not sync files/folders)
106

run a scan on reconnect 102

Run application at start of PeerSync 138

Run as a senice (PeerLock) 122, 123

Run as a senice (PeerSync) 116, 118

Run at specific times and selected days 57

Run External applications/scripts before and after the
processing of a given Job 99

Run Menu 19

Run Pre-Sync Report 131

Run RegEdit 112

Run Scheduled Operation 135

Run selected Jobs at a specific time of day 57

Run VSS ewery x minutes 105

Run/View 29

Run/View (PeerLock):
Launch PeerLock
Pause Senice
Resume Senice 122, 123
Run as a senice 122, 123
Start Senice/Application 122, 123
Stop Senice/Application 122, 123

Run/View (PeerSync): 116, 118
Launch PeerSync 116, 118
Pause Senice 116, 118
Resume Senice 116, 118

91, 93
91, 93

122, 123
122, 123
122, 123

Run as a senice 116, 118
Start Senice/Application 116, 118
Stop Senvice/Application 116, 118

Run/View Current Profile Activity Screen: 148
Added Indicator 148
Checked Indicator 148
Deleted Indicator 148
Elapsed Time Indicator 148
Excluded Indicator 148
File Indicator 148
Files Indicator 148
Folders Indicator 148
Job Indicator 148
Messages Indicator 148
Mode 148
Profile Indicator 148
Size Indicator 148
Skip Files Button 148
Source Indicator 148
Target Indicator 148
Target Space Indicator 148
Updated Indicator 148

Running Jobs vs. Running Profiles (Run a Quick Sync)
26

_S -

Sample Exclusions 85

Sawe As 148

Sawe Changes in PeerLock 110
Sawe Profile 14

Saving Profiles 14

Scan at Start 135

Scan limitations 62

Scan real-time Jobs on reconnect if "Scan Job once at
start" is enabled 36

Scanning Options 57

Scheduled Mode 12, 151

Scheduling Options 57

Select a folder for deleted files to be placed 66
Select Application/Script to Run After 99
Select Application/Script to Run Before 99
Select days of the week to run Jobs 57
Select Source Folder 32

Select Source Folder Button 32

Select Target Folder 44

Select Target Folder Button 44

Selected File Dates 87
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Selecting Jobs 26

Selecting Multiple Jobs 26

Selecting Source Folders 32

Selecting Target Folders 44

Selection Tree 29

Selection Tree: Customize Options 29
Send an email for every event 94

Send an email on an interval 94

Send an email once aday 94

Send an email once a week 94

Senice (PeerLock) 122, 123

Senice (PeerSync) 116, 118

Senvice Details (PeerLock) 115

Senvice Details (PeerSync) 112

Set Access Password 107

Set Alternate/Additional Normal Targets 51
Set Application Priority 129

Set Copy Threads 129

Set Deletion Move To Folder Cleanup Interval 138
Set Email Threads 129

Set Empty File Delay 143

Set Failed Connection Timer 138

Set File Comparison Value 138

Set File Read/Write Buffer Delay 129

Set FTP Failed Upload Retry Count 128
Set FTP Short Date Format 128

Set Job Comparison Delta 138

Set maximum number of copy threads tox 72
Set maximum number of retries to x 102
Set Multitasking Delay 129

Set Processor Affinity 129

Set Queue Directory Change Count 138
Set Real-time Copy Thread Pool 129

Set Safety Value for Last Run Time 146
Set Shadow Detection 143

Set Shared Process Delay 129

Set SNC Fileto Load 127

Set Source Path 127

Set Target File Overwrite 138

Set the maximum log file size to x bytes 89

Set the percentage of copy threads to reserve for
real-time events 129

Set Today's Date Button 87

Set Trigger Folder File Name 146
Set VSS Base Timeout 145

Set VSS Try Count 145

Settings 31

Shadow Time Range 138

Shared Process Delay 129
Show Advanced/Normal Display 118
Show Advanced/Normal Display PeerLock 123
Show All Profile Options 29
Show PeerLock 110
Show Pre-Sync report file at end of run 106
Show Tray Icon 107, 131
Show/hide Selection Tree 14
Show/hide the Selection Tree 29
Silent Installation 6
Simple Network Management Protocol reporting 89
Size Indicator 148
Skip File Button 148
Skip setting of main form visible 131
SMTP Host - Email Reporting 93
SNC File 127
SNMP Error Reporting 131
SNMP Options Button 89
SNMP reporting 89
Source and Target Selections 32
Source File/Folder Alterations 78, 79
Source Folder Connection Manager 36
Source Folder Detection - NetApp fPolicy 36
Source Folder Detection - Normal 36
Source Folder Detection Method 36
Source Folder Field 32
Source Folder NetApp Settings 37
Source Folder Network Logon Settings 38
Source Folder Popup Menu 42
Source Folder Selection 32
Using FTP Mode 32
Using Normal Mode 32
Using TCP Mode 32
Source Indicator 148
Source to Target Combination Settings 31
Source-target backup/synchronization scenario 31
Specific time scheduling 57
Standard synchronization 64
Start Senice/Application (PeerLock)
Start Senice/Application (PeerSync)
Startup/Senice 29
Startup/Senice (PeerLock): 115
Executable Path (PeerLock) 115
Install Senice (PeerLock) 115
Path (PeerLock) 115
Remowe Senice (PeerLock) 115
Senice Details (PeerLock) 115
Startup/Senice (PeerSync): 112

122, 123
116, 118
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Startup/Senice (PeerSync): 112
Add to Windows registry 112
Add to Windows StartUp 112
Create Shortcut on Desktop 112
Create SNC extension 112
Disable all Startup Options 112
Executable Path 112
Install Senice 112
Quick-Sync Folder Option 112
Remowe Senice 112
Run RegEdit 112
Senice Details 112
Status Display 148
Status Screen 148
Stop Senvice/Application (PeerLock) 122, 123
Stop Senvice/Application (PeerSync) 116, 118
store events while connection is down 102

store missed events and process on reconnect 102

Summary Report 131
Summary Reporting Feature 88
Summary Statistics Collection 131

Suppress connection of PeerSync to the Profiler
131

Suppress Reboot during Install 6

suspend file transfer 61

Swap Source and Target Folders 53

Sync Selected Jobs 26

Synchronization 12, 151

Synchronization Command Line Arguments: 138
Active Connection Interval 138
Allow Replication During Dynamically Created
Jobs 138
Always Run Post Process 138

Always use the local machine time for the Last
Run Time 138

Delete Empty Source Folders After Move 138
Disable application associated with sync 138
Disable Failed Connection Timer 138

Do Not Validate Connections Before Profile is
Loaded 138

Enable Last Access Compare 138

Exclude Folders that have a Reparse Point 138

Folder Queue Watch Interval 138

Force Flush File Buffers 138

Get Remote PC Time 138

Ignore File Size and/or Date Comparison 138
Ignore Matching/Locked File Extensions 138

Ignore Matching/Locked File Postfix Replacement

138

Ignore Open File Extensions 138

Ignore Target Space During File Copy 138
Mowe Files 138

No not delete folders 138

Partial Locked File Extensions List 138
Run application at start of PeerSync 138

Set Deletion Move To Folder Cleanup Interval
138

Set Failed Connection Timer 138

Set File Comparison Value 138

Set Job Comparison Delta 138

Set Queue Directory Change Count 138

Set Target File Overwrite 138

Shadow Time Range 138

Target In-Use Replacement 138

Terminate All Instances of PeerSync 138

Use Alternate Copy File Methods 138

Use Delete Path for Revisions 138

Use Full Access File Copy 138

Use Network Password Dialog 138

Verify User-Name 138

WordPerfect Fixes for synchronization 138
Synchronization of files between dissimilar time zones

82
Synchronization Timer Argument 135
Synchronization Timer Argument with Keyboard
Activity 135
Synchronize ALL files via Managed Files 71
Synchronize open/locked files via Managed Files 71
Synchronize Selected Jobs Option 26

ST -

Target File Time Change Option 82
Target File/Folder Alterations 78
Target Folder Field 44

Target Folder Popup Menu 51
Target Folder Selection 44

Target Indicator 148

Target In-Use Replacement 138
Target Space Indicator 148

TCP Source 33

TCP Source Configuration Tab 38
TCP Source Mode Selection 38
TCP Source PopUp 43

TCP Source Port Configuration Tab 39
TCP Target 45

TCP Target Configuration Tab 47
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TCP Target Mode Selection 47

TCP Target PopUp 51

TCP Target Port Configuration Tab 48
TCP Wan Connector Option 33, 38, 45, 47
Temp Files 78

Temp Folder Selection 6

Term and Trial Period 3

Terminate Active Profile 14

Terminate All Instances of PeerSync 138
Thread Utilization 129

Threads 103, 129

Throttle bandwidth 72

Throttle bandwidth - Use x percent of available
bandwidth 72

Time Change After Sync 82
Time Delta Selection 82
Time Out - FTP Source 40
Time Out - FTP Target 49
Time Out - TCP Source 39
Time Out - TCP Target 48
Time variables for Folder Paths 53
Time Zone Option 82
Timer Argument 135
Tool Buttons 14
Tool Buttons: 14
Add Job 14
Back 14
Copy Job 14
Delete Job 14
Help 14
Hiding/Moving Toolbar 14
Launch Current Profile 14
Mowe Job Down 14
Mowe Job Up 14
New Profile 14
Next 14
Open Profile 14
Oweniew 14
Rename Job 14
Sawe Profile 14
Settings Screens Drop-Down List 14
Show Selection Tree 14
Terminate Active Profile 14
Toolbars: Profile Description 16
Transfer Time Reporting Feature 88
Trap Prefix 90
Tray Icon 107, 131
Tray Icon Popup Menu 25

Tree 29
trigger file 63
Turn file archive attribute off after synchronization 79

_U -

Uninstall 6

Uninstall previous versions of PeerSync 10
Update - synchronize existing files in target 64
Updated Files Reporting Feature 88
Updated Indicator 148

Updates: Product 8

Upgrade 10

Upgrade Information 10

Upgrade PSListener 10

Use Alternate Copy File Methods 138

Use Arguments from Profile 127

Use Block Byte Lewel Synchronization 74
Use block/byte level synchronization 74
Use daily timer scheduling 57

Use Delete Path for Revisions 138

Use Device Driver method 135

Use Enhanced bi-directional synchronization mode
146

Use enhanced bi-directional synchronization mode
options 104

Use enhanced real-time monitoring 57
Use error information only 91, 93

Use file compression 97

Use folder compression 97

Use Full Access File Copy 138

Use intermediate file during copy: 78
Use Last Access File Time 146

Use Log File 88

Use maximum wait time of x seconds 99
Use Network Password Dialog 138
Use Proxy - Firewall - FTP Source 40
Use Proxy - Firewall - FTP Target 49
Use SNMP reporting 89

Use standard report file content 91, 93
Use summary information only 91, 93
Use Update Sensitivity 143

Use Variables for folder paths stored in registry 53
Use VSS 64

User ID - Email Reporting 93

User Name - FTP Source 40

User Name - FTP Target 49

User Name - TCP Souce 39
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User Name - TCP Target 48

User Name and Password 9

User Name variable 53

Using # in Excluding Folders 86

Using Variable Paths 53

Using Wild Cards for files to Include 83

_V -

Validate target file (using CRC32) 81
Validation Options 80, 81

variable data import 55

Variables 53

Variables: File Path 53

Verify User-Name 138

version of files 76

View Admin Folder 148

View Alternate Target Path Selection 52
View Log File 26, 88, 148

View Menu 17

View PeerSync activity across the LAN 151
View Popup Menu 25

View Target Folder 148

Volume Shadow Copy Senice (VSS) 71, 105, 145

VSS 64, 71, 105, 145
VSS Interval 105, 145

W -

Wait for application to end before continuing 99
Web Farms 107

What email address to send from 93

Who to send emails to 93

Window: Changing Height of Profile Job List 26
Windows Explorer Add On - Quick-Sync 151
Windows Platforms 12

Windows Variables for Folder Paths 53
WordPerfect Fixes for synchronization 138
Working With Jobs 12, 151

Working with Profiles 12, 151

_Y -

Year variables for Folder Paths 53
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